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Vorbemerkungen des Übersetzers 
 
Diese Übersetzung entstand aus der zu MixW V2.12 mitgelieferten englischen Hilfe. Diese Hilfe wurde 
gegenüber früher neu zusammengestellt und in fünf Blöcke aufgeteilt.  Die fünf Hauptkapitel dieser 
Übersetzung entsprechen diesen fünf Blöcken.  
Wo es sich machen ließ, wurden die verwendbaren Teile aus der Hilfe für MixW V2.07 in die neue 
Hilfe eingebaut. 
Der Text wurde unter WORD-2000 editiert und alle Links des Originals wieder eingebaut, so daß Sie 
zwischen Inhaltsverzeichnis und Text beliebig hin- und herschalten können. Die Text-Ausgabe erfolgt 
als DOC-File (WORD-2000) und als PDF-File (Adobe). 
Der Text wurde weitgehend ungekürzt unter Verwendung aller Bilder übersetzt. Mitunter wurden 
zusätzliche Bilder aus dem eigenen Programm oder aus der MixW-Hilfe V2.07 zum besseren 
Verständnis eingebaut.  
Ich bitte Tippfehler zu entschuldigen und hoffe, daß ich den englischen Text nicht zu sehr verfälscht 
habe. 
Die Hilfe geht weit über eine Programmbeschreibung hinaus. Sie erläutert ausführlich die Eigenheiten 
der Sendearten, spart aber mitunter an Tips zu Eigenheiten des Programms. Hier habe ich mit 
‚Anmerkung oder Hinweis DM3ML’meine eigenen Erfahrungen eingefügt. 
Ich funke selbst in (fast) allen Modi mit MixW und bin gern bereit, technische Fragen zum aktuellen 
Programm zu beantworten. Ich bitte aber Wünsche und Beschwerden zum Programm an den 
Programmierer selbst über den YAHOO-Reflektor zu schicken. 
Und ich habe noch einen Wunsch : Wenn ich einem Funkfreund eine mitunter garnicht so einfach zu 
findende Antwort auf seine Email- oder Packetanfrage geschickt habe, würde ich gern hören, ob sie 
angekommen ist und vielleicht sogar geholfen hat. 
  
Ich wünsche allen Nutzer viel Spaß und Gut Funk mit MixW ! 
 
Eike, DM3ML 
 
Dresden, 22.7.2004 
 
Email: dm3ml (at) darc.de 
Packet : dm3ml@db0tud 
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1. Übersicht (Main) 

1.1 Willkommen (Welcome) 
 
Die Demo-Version läuft 15 Tage, für die Registrierung sehen Sie bitte unter Registrierung nach. 
 
MixW steht für eine Mischung aus verschiedenen Sendearten. MixW unterstützt CW, BPSK31, 
QPSK31, BPSK63 & 125, MFSK, RTTY, FSK31, Packet (HF, VHF und TCP/IP über AX.25), Pactor 
RX/TX (TX mit einem passenden TNC), Amtor (Sitor) TX/RX (kein TNC benötigt), Hellschreiber, FAX 
(nur RX ), SSTV, THROB, und MT63. Nick fügt laufend neue Sendearten und Eigenschaften zu MixW 
hinzu und bemüht sich, das umfassendste Soundkartenprogramm anzubieten. Zusätzlich zur 
Soundkarte kann ein Multimode-TNC für Pactor und für die OMs angeschlossen werden, die eine 
Hardwarebasis für die Digimode bevorzugen. Weitere externe Sendearten können von MixW aus 
durch den Aufruf anderer Software-Pakete angesprochen werden. 
 
MixW realisiert Sprachausgaben für SSB, FM und AM.  Es enthält ein exzellentes Logprogramm, eine 
Skedverwaltung und vollprogrammierbare Macros z.B. zum Auto-CQ bei programmierbaren 
Ereignissen. MixW verfügt über einen ausgereiften Contestmodul für Digimode-Conteste und kann 
seine Logs im neu eingeführten Cabrillo-Format  ausgeben. Logs können  im CSV- und ADIF-Format 
importiert und exportiert werden.  Der QSL-Karten- oder Labeldruck wird unterstützt. Ein DXCluster 
kann über Packet oder das Internet angesprochen werden. 
MixW benötigt keinen TNC. Es wird ein Computer unter Windows 9x, ME, NT,  2000 oder XP mit einer 
passenden Soundkarte benötigt.  
Falls Sie bereits mit anderen Soundkarten-Digimode-Programmen vertraut sind oder MixW auf der 
Basis einer früheren Ausgabe aufgebessert haben, gehen Sie zu Schnellstart (Quickstart), um sich mit 
den neuen Möglichkeiten vertraut zu machen und schnell in “die Luft” zu gehen. 
Sind Sie neu in der Soundkartentechnik und wollen Sie Ihren Transceiver mit der Soundkarte 
verbinden und den Transceiver von Empfang auf Senden schalten, gehen Sie zur Konfiguration und 
Einstellung (Configuration and Set Up), um die Verbindung von Lautsprecher/Kopfhörerausgang und 
Mikrofoneingang mit der Soundkarte und die Nutzung der Transveiver-VOX oder einer einfachen PTT-
Schaltung zu erfahren. 
Die aktuellen und neuesten Informationen zum MixW-Programm finden Sie auf diesen Webseiten : 
Soundkartenanschluss verstehen (Understanding Soundcard Interfacing) von Ernie Mills, WM2U: 
http://www.qsl.net/wm2u/interface.html 
für eine Übersicht zum Problem. Wenn Sie ein Selbstbau-Fan sind, finden Sie hier eine Menge an 
Lösungen. Sehen Sie auch im Internet und in Amateufunkzeitungen zu den neuesten Informationen 
nach. 
 _________________________________________________________  
Hinweis: Die Autoren von MixW, Nick and Dennis, haben ein speziell für MixW geeigentes Interface 
entwickelt. Dieses Interface heisst RigExpert und Sie finden es auf der Internetseite von Nick : 
http://www.mixw.net 
_________________________________________________________  
 
Die neuesten Informationen und Programme zu MixW finden Sie unter  
http://www.mixw.net 
und 
http://www.nvbb.net/~jaffejim/mixwpage.htm  
 
Die neuesten Hilfen finden Sie unter  
http://www.qsl.net/k6ix 
und 
http://radioministries.org/k4set/MixW2_help.html 
 
Zu ergänzender Hilfe un Diskussion von MixW schreiben Sie sich bitte beim MixW-Reflektor unter  
http://www.yahoogroups.com/group/mixw/ 
ein. 
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_________________________________________________________  
 
Die MixW-Hilfe von Scott E Thile, K4SET, und Scott Hill, K6IX 
bedankt sich für die Zuarbeiten von : 
 
Denis Nechitailov, UU9JDR  
Howard (Skip) Teller, KH6TY 
Richard B. Griffen, NB6Z 
Jim Jaffe, WA2VOS 
Finn Helmuth Pedersen, OZ6LI 
Bob Parker, K4PPN 
 
_________________________________________________________  
 
Informieren Sie sich im Kapitel Hilfe benutzen (Using Help) über die MixW-Hilfe. 
Haben Sie Vorschläge und Wünsche zur Hilfe, wenden Sie sich bitte an : 
Scott Hill, K6IX (scotthill@bithauler.com) 
 

1.2 Schnellstart (Quickstart) 
 
Hier finden Sie einen kurzen Überblick über die Konfiguration und die Arbeit mit MixW für erfahrene 
Nutzer.  
Falls Ihre Station für Soundkarten-Digimodeprogramme bereits vorbereitet und konfiguriert ist, sind 
Sie schon ein erfahrener Nutzer von Soundkartenprogrammen und brauchen nur noch einige 
Informationen zur Nutzung von MixW2 im Äther. 
 

1.2.1 Programm installieren (Install the software) 
 
Das Programm aus dem Internet ist eine gepackte selbstextrahierende Installationsdatei. Sie können 
ein Verzeichnis Ihrer Wahl für MixW wählen oder das voreingesteltte Verzeichnis  
C:\Programme\MixW\ nehmen. 
 
Mit der Installation werden alle benötigten  Dateien für MixW2 auf Ihrem System installiert. Die 
wichtigsten Dateien sind : 
 
MixW2.exe  Hauptprogramm 
bands.ini  Band- und Frequenzinformationen (editierbar) 
contest.mc  Macros für einen Contest (Beispiel) 
CmnData.dll  Programminformation 
cty.dat   DXCC-Länderliste mit geografischen Daten für Antennerichtung 
pfx.dat   Prefix-Daten 
 
Diese Dateien werden autoamtisch von MixW2 erzeugt :  
 
MixW2.log voreingestelltes Log (regelmässig sichern !) 
MixW2.ini  enthält Ihre Konfiguration (regelmässig sichern!) 
MixMacros.ini  voreingestellte Macros, wird bei der ersten Änderung erzeugt 
 
Sie werden beim Umgang mit MixW weitere Dateien erzeugen, vor allem die auf die Sendearten 
bezogenen Macro-dateien. Diese haben die Erweiterung *.mc oder *.ini. Sichern Sie diese Dateien 
zusammen mit dem Log. 
  
Sind Sie bei MixW registriert, kopieren Sie die Registrierdatei MixWReg1.dll in das MixW-Verzeichnis 
(und sichern Sie sie getrennt). 
 
Hinweis : Wenn Sie von MixW 1.xx oder DigiPan kommen, kopieren Sie die Registrierdatei von 
MixW1 (wenn Sie ein haben) in das MixW-Verzeichnis, tragen Sie Ihr Rufzeichen unter den 
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persönlichen Daten mit Großbuchstaben ein und starten Sie MixW2 neu, damit die Registrierung 
wirksam wird. 
Exportieren Sie Ihr MixW1- oder DigiPan-Log in eine ADIF-Datei und lesen Sie diese ADIF-Datei unter 
MixW2 wieder mit File > Import ein.  

1.2.2 Persönliche Daten einstellen (Configure your Personal Data) 
 
Konfigurieren Sie Ihre persönlichen Daten (Personal Data) mit  Configure > Personal Data.  
Diese Dialogbox erscheint : 
 

 
 

Geben Sie alle Stationsdaten ein und wählen Sie die CW-Identifikation (Rufzeichen in 
Großbuchstaben !)  
 

1.2.3 Transceiver-PTT einstellen (Configure your Transceiver PTT 
settings) 

 
Falls Sie den Transceiver mit der VOX zu RX/TX steuern und keine CAT-Funktion nutzen, können Sie 
diese Einstellung übergehen. 
Falls Sie den Transceiver über eine PTT-Schaltung steuern und/oder eine CAT-Steuerung verwenden, 
müssen Sie die Einstellungen vornehmen. Gehen Sie zu Configure > TRCVR CAT/PTT : 
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Nutzen Sie keine CAT-Steuerung verwenden, setzen sie TRCVR auf None , ignorieren Sie den Rest 
der Box und klicken Sie auf Details, um die PTT und die anderen Signale des COM-Ports 
einzustellen. 
Falls Sie die CAT-Steuerung verwenden, tragen Sie Ihren Transceiver-Typ ein und folgen Sie dem 
sich öffnenden Menü. 
 
Hinweis : Sollte Ihr Transceiver nicht in der Liste enthalten sein, wählen Sie ein verwandtes Modell > 
z.B. arbeiten alle Kenwood-Modelle mit der Einstellung TS-850. 
 
Legen Sie die Einstellungen für die COM-Schnittstelle (Baudrate, Format) fest . und wählen Sie die 
Werte für das PTT-Signal und die CW-Tastung :  
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Wenn Sie den COM-Port nur für die PTT verwenden wollen, wählen Sie nur die Port-Nummer und die 
Verwendung der Signale RTS und DTR. Wenn Sie den COM-Port gleichzeitig für die CAT-Steuerung 
Ihres Transceivers verwenden wollen, tragen Sie Baudrate und Datenformat zusätzlich ein. 
Falls Sie einen COM-Port für die CAT-Steuerung und einen weiteren für die PTT-Steuerung 
verwenden wollen, dann wählen Sie Configure > Secondary PTT/RTTY port > Port settings 
secondary Port : 
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1.2.4 Kommandos für den Anfang (Commands for basic operation) 
 
Sendeart wählen (Mode selection) 
 
Klicken Sie im Menü auf Mode | <Ihre Wahl> auf die gewünschte Sendeart : 
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Beachten Sie, daß sich der Statusbalken entsprechend der Sendeart ändert und die zugehörigen 
Zustände anzeigt. Manche Anzeigen gehören nur zu einer Sendeart. IMD z.B. zu PSK und Connected 
oder Disconnected nur zu Packet-Radio : 
 

 
 

 

 
 

Sie können auch durch einen Klick auf die Sendeart im Statusbalken das Sendearten-Menü aufrufen.  
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Umschalten zwischen RX und TX: Es gibt bei MixW mehrere Möglichkeiten zum Umschalten 
zwischen TX und RX. Die Taste  Pause/Break schaltet zwischen RX und TX hin und her. Sie können 
auch mit einem Klick auf das Feld RX/TX im Statusbalken oder unter Verwendung der TX- und RX-
Tasten im  Macro-Balken (abhängig von Ihrer Macroeinstellung > Macros erzeugen (Configuring 
Macros)) die RX/TX-Steuerung auslösen. 
 
 
Panik-Taste 
 
Wenn Sie zweimal auf die Taste ESC drücken, wird das Senden unmittelbau abgebrochen. Der im 
Sendefenster stehende Text wird NICHT gesendet. 
 
Fenster positionieren und anordnen 
 
Wenn Sie auf einen leeren Bereich des Steuerbalkens, des Logfensters, der Abstimmanzeige, der 
Weltkarte oder anderer verschiebbarer Fenster mit der linken Maustaste klicken und die Taste 
gedrückt halten, können Sie das jeweilige Fenster in eine gewünschte Position ziehen. Wenn Sie das 
Fenster anklicken, sehen Sie seinen Rahmen und wenn Sie das Fenster ziehen, zeigt Ihnen der 
Rahmen die aktuelle Position an. Die aktuelle Position der jeweiligen Fenster wird in die Datei 
MixW2.ini nach dem Programmende angespeichert und bei Neustart wieder hergestellt. 
 
Wenn Sie den Mauszeiger auf eine Trennlinien zwischen den Fenstern setzen, änder sich der Cursor 
in ein schmales Paar aus parallelen Linien mit zwei Pfeilen. Wenn Sie die linke Maustaste drücken 
und gedrückt halten, können Sie Trennlinie verschieben. Sie sollten unten Spektrum/Wasserfall, in der 
Mitte das Sendevorschreibfenster und oben unter dem Log das Empfangsfenster sehen. Fehlt eines 
dieser Fenster, verschieben Sie die Trennlinien, bis die Fenster zu sehen sind. 
 
Eine mögliche Lösung sehen Sie in diesem Bild :  
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Weitere RX-Fenster öffnen 
 
Wollen Sie mehrere empfangene Signale verfolgen, klicken Sie mit der rechten Maustaste auf ein 
Signal im Wasserfall und wählen Sie New RX window. Wollen Sie auch auf dieser Frequenz senden, 
klicken Sie in das zweite Empfangsfenster und wählen Sie Swap. Der Inhalt des zweiten Fensters 
wird ins Haupt-RX-Fenster getauscht und Sie können auf der Frequenz des zweiten Fenster senden. 
 _________________________________________________________ 
 
Mit dieser Grundeinstellung können Sie schon in die Luft gehen. Mit MixW haben Sie aber 
ausgedehnte Möglichkeiten mit Macros Ihren Betriebsablauf zu automatisieren, Programme zu 
nutzen, Daten in Contesten auszutauschen und QSOs interessant zu gestalten. Separate Macros 
können konfiguriert, optimiert und für jede Sendeart automatisch geladen werden.Sehen Sie 
unterMacro-Kommandos (Macro Commands)) nach, wie Sie Ihre Macros konfigurieren können. 
MixW hat ausgedehnte Log-Möglichkeiten und Werkzeuge zum QSL-Kartendruck.  Siehe Logbuch 
und QSLs (Logging and QSLing). Ein Contest-Log mit ausgefeilten Macros für eine maximale Effizienz 
und Freude am Betrieb ist enthalten. Siehe Contestbetrieb (Contest Operation) 
 
Die DEMO-Version von MixW kann 15 Tage genutzt werden. Informieren Sie sich über die 
Registrierung (Registration). 
 
 

1.3 Registrierung (Registration) 
 
Die Demo-Version von MixW läuft 15 Tage, bevor eine Registrierung nötig wird. Weitere 
Einschränkungen bestehen nicht.  
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Die Registriergebühr für MixW beträgt $50,00 (US-Dollar) 
 
Um MixW zu registrieren und online zu bezahlen gehen Sie zu : 
 http://www.mixw.net  
_________________________________________________________ 
 
US Stations senden $50.00 per Scheck, Überweisung oder in bar an : 
 
Jim Jaffe, WA2VOS (Füllen Sie die Schecks zahlbar an Jim Jaffe aus) 
141-08 71 Road 
Flushing, NY 11367-1945. 
 
Jim schickt Ihnen per EMAIL eine spezielle Registrierungsdatei. 
Das Registrierfomular kann unter  
http://www.nvbb.net/~jaffejim/mixwpage.htm 
geholt werden. 
Eine CD kann mit einem zusätzlichen Betrag von  $15.00 plus $1.00 Postgebühr für U.S.-Stationen 
bestellt werden. 
Überseeische Stationen können eine CD für $15.00 US plus $3.00 Postgebühr zusätzlich ordern. 
 
Überseeische Stationen können $50.00 in US-Währung entweder in Bar oder per International Money 
Order an die obige Adresse schicken. Ausländische Schecks und Credit-Karten werden nicht 
akzeptiert. 
 
Tipp für deutsche OMs : lesen Sie http://www.mixw.de 

1.4 Hilfe benutzen (Using Help)  
 
Die MixW-Hilfe bietet Ihnen leistungsfähig Methoden zum Finden von Informationen an. Klicken Sue 
unter MixW auf Help > Help Topics  und sehen Sie sich die dafür bereitgestellten Werkzeuge an :  
 
ERSTENS :  Achten Sie darauf, dass das Inhaltsverzeichnis (Table of Contents) auf der linken Seite 
sichtbar bleibt, wenn Sie rechts das zugehörige Kapitel lesen. Der Name des angewählten Stichworts 
ist hellgetastet und Sie können ihn im Text finden. 
 
ZWEITENS :  Mit der Suchfunktion können Sie im Text jedes gesuchte Wort finden. Es wird 
hellgetastet, so bald es auftritt, Sie können so ein Wort innerhalb der Texte finden. 
 
DRITTENS :  Mit den Auf- und Abtasten können Sie links den Text der Hilfe durchrollen lasssen. 
  
VIERTENS : Die MixW-Hilfe ist in 5 Module aufgeteilt, die Sie individuell downloaden können. Sie 
können sich die Module heraussuchen, die Sie benötigen oder die aktualsiert worden sind. Nur der 
Modul  zur Übersicht (MixWMain.chm) wird mit dem Programm zusammen verteilt. 
 
Anmerkung DM3ML : Die Module entsprechen  den Kapiteln 1 bis 5 dieser Hilfe. 
 

Modul-Name Datei-Name Kommentar 

Overview of MixW 
(Überblick) MixWMain.chm Modul muss im MixW-Verzeichnis stehen 

Configuration and Set Up 
(Konfiguration und 
Einstellung) 

MixWConfig.chm Wichtigste Eigenschaften von MixW 

Operation 
(Funkbetrieb) MixWOps.chm Beschreibung der Menü und des Funkbetriebs 
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Digital Modes 
(Digitale Sendearten) MixWModes.chm Theorie und Praxis der Sendearten von MixW 

 

Appendices 
(Verschiedenes) MixWApndx.chm Detailierte und weniger genutzte 

Informationen 

 
Wollen Sie die MixW-Hilfe getrennt auf einem anderen Computer nutzen, kopieren Sie die Module in 
ein Verzeichnis und erzeugen Sie ein Icon, das auf die Datei MixWMain.chm zeigt. 
 
 
Hinweis : Ein roter Stern im Inhaltsverzeichnis markiert einen neuen Abschnitt oder einen Abschnitt 
mit größeren Änderungen. 
  
Wollen Sie die MixW-Hilfe-Moduln holen, klicken Sie auf : 
http://www.qsl.net/k6ix 
 
oder 
 
http://radioministries.org/k4set/MixW2_help.html 
 
Wollen Sie auf dem Laufenden zur Hilfe bleiben, gehen Sie zum MixW-Hilfe-Reflektor 
 
http://groups.yahoo.com/group/MixWHelp/ 
 

2. Konfiguration und Einstellung 
(Configuration and Set Up) 

 

2.1 Konfiguration (Configuration) 
 
Persönliche Daten 
 
Konfigurieren Sie Ihre persönlichen Daten (Personal Data) mit  Configure > Personal Data.  
Dieses Fenster erscheint : 
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Geben Sie alle Stationsdaten ein. Tragen Sie das Rufzeichen in Großbuchstaben ein. 
 
Hinweis 1 : Sie müssen wenigstens Ihr Rufzeichen eintragen. 
 
Hinweis 2 : Westliche Länge und südliche Breite werden wird negativ eingetragen.  
 
Hinweis DM3ML : Nur mit diesem Fenster können Sie auf ein anderes Logbuch umschalten oder ein 
gewünschtes Logbuch anwählen. 
 
Für das Macro <CWID> können Sie eine Voreinstellung in das Feld CWID eintragen. Es wird, falls 
freigegeben, in CW beim Umschalten auf Empfang auch in den Digimodes gesendet. 
Klicken Sie zum Abschluss auf OK. 
  
MACROs  
 
MixW hat sehr umfangreiche Möglichkeiten, den Tastensatz von 4x12 Tasten mit aus Text und 
Macros kombinierten Texten zu belegen. Informieren Sie sich unter Macros erzeugen (Configuring 
Macros) 
 
Fonts (Schriftarten)  
 
Gehen Sie zu Configure > Font for TX/RX Windows  oder > Font for Macro buttons und wählen 
Sie die Schriftart und –größe für die beiden Fenster oder die Macrotasten. 
 
Text Colors  (Textfarben) 
Gehen Sie zu Configure > Text Colors und wählen Sie die Farben für die einzelnen Texttypen. Sie 
können die Farben getrennt für verschiedene Fälle wählen :  
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Mit diesem Werkzeug können Sie im Text Rufzeichen an sich, schon gearbeitetete Stationen, neue 
Stationen , Stationen aus neuen Ländern oder in einer neuen Sendeart, Multis, Prefixe oder schon 
gearbeitete Stationen im Contest hervorheben, die Fenster mit unterschiedlichen Hintergrundfarben 
belegen usw. Hier hat MixW große Möglichkeiten,  eine eigene Bedienoberfläche zu gestalten. 
 
Transceiver CAT/PTT – Einstellungen :  
Wenn Sie die PTT- oder die CAT-Steuerung nutzen wollen, konfigurieren Sie die serielle Schnittstellen 
mit  Configure > TRCVR CAT/PTT  : 
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Mit dieser Box werden die CAT-Eigenschaften und unter Details die PTT-Signale der gleichen 
Schnittstelle gewählt. Wollen Sie Ihren Transceiver nicht über CAT steuern, wählen Sie unter TRCVR 
die Zeile "None", ignorieren Sie den Rest der Box und klicken Sie auf "Details" um die PTT zu 
konfigurieren. 
Wollen Sie die CAT-Funktion nutzen, geben Sie den Hersteller und Transceivertyp ein. Ist Ihr 
Transceiver nicht in der Liste enthalten, wählen Sie ein verwandtes Gerät des gleichen Herstellers. 
Für alle Kenwood-Geräte kann der Typ TS-850 eingetragen werden.  
Wenn Sie einen Haken in das Feld Display zero beat frequency machen, wird die am Transceiver 
eingestellte Frequenz angezeigt, wenn nicht, die Frequenz , auf der das aktuelle QSO läuft 
(Transceiverfrequenz + NF-Frequenz bei USB) 
 
Gehen Sie als nächstes zu “Details" und tragen Sie das Datenformat der Schnittstelle und die PTT-
Einstellung ein :  
 
 
 

 
 

Wählen Sie die Schnittstelle, die Sie verwenden wollen. Nehmen Sie die Schnittstelle nur, um die PTT 
zu tasten, übergehen Sie das Datenformat und geben Sie unter RTS und DTR nur das zu 
verwendende Signal an. 
Falls Sie eine Schnittstelle für CAT und eine andere für PTT verwenden wollen, konfigurieren Sie die 
PTT-Schnittstelle unter Configure > Secondary PTT/RTTY port > Port settings : 
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Wenn Sie die PTT mit einem Kommando über das CAT-Interface schalten und keine separate PTT- 
oder CW-Schaltung angeschlossen haben, können Sie eine Haken in das Feld Hardware flow 
control machen und am COM-Port die Werte für die Baudrate und Datenformat so einstellen, dass es 
mit der Einstellung des Transceivers übereinstimmt. RTS und DTR werden nicht verwendet. 
Hinweis : Der Transceiver muss die  hardware flow control unterstützen, wenn ein Haken im Feld 
gesetzt wurde. Schalten Sie, wenn es Probleme gibt, die hardware flow control ab und setzten Sie 
DTR und RTS auf always on (immer auf H). Sie müssen darauf achten, dass sie PTT via CAT im 
ersten Menü angehakt haben. 
Mit den RTS und DTR-Signalen können Sie sowohl die PTT schalten als auch CW tasten. RTS und 
DTR können weiterhin auf always on (immer EIN) oder always off  (immer AUS) gesetzt werden. 
 
Tip von DM3ML : Wenn Sie ein CAT-Interface verwenden, das von der Schnittstelle gespeist wird, 
müssen Sie RTS und/oder DTR auf always on setzen. 
RTS liegt an Pin 4 des DB-25-Steckers oder Pin 7 des DB-9-Steckers,  DTR liegt an Pin 20 beim DB-
25, oder Pin 4 beim DB-9.  
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Konfiguration für LSB- oder USB-Betrieb :  
 
MixW muß mit View >  Spectrum  >| RF, USB oder RF  > LSB oder Auto oder Sound so eingestellt 
werden, daß jeweils diie richtige Seitenbandlage empfangen und gesendet wird. Die Einstellung muss 
korrekt sein, damit im Log und im Wasserfall bzw. Spektrum, die richtige Arbeitsfrequenz angezeigt 
wird und MixW u.U. eine Inversion korrekt berücksichtigt. 
 
Inversion: Beachten : Bei dieser Einstellung unterscheidet sich MixW von den meisten anderen 
Soundkarten-Digimodeprogrammen. Bitte lesen Sie den folgenden Text aufmerksam durch, um 
Irrtümer zu vermeiden.  
Eine Inversion der Signallage kann bei QPSK31, MFSK16, RTTY, AMTOR, Hellschreiber, THROB 
und FAX angewählt werden.  "Inverted" heißt, daß die Lage der Mark- und Space-Töne gegenüber 
der normalen Lage vertauscht wird. Sie benötigen diese Funktion, wenn Sie eine Station mitschreiben 
oder arbeiten wollen, die invertiert arbeitet.  
Zur Erklärung : In allen Modes hat unabhängig vom Seitenband der MARK-Ton (=Strom) die höhere 
Frequenz. Der SPACE-Ton (=kein Strom) liegt um die SHIFT (meist 170 Hz) tiefer. Bei traditionellen 
Hardware-TNCs wird RTTY immer in der LSB-Lage gemacht, um die richtige MARK-Lage zu 
erzeugen. Wird MixW analog dazu auf  "RF, LSB" eingestellt, ist der MARK-Ton der jeweils höhere 
Ton. Wird MixW auf  "RF, USB" gesetzt hat der MARK-Ton die tiefere Frequenz, das Signal wird 
invertiert.   
Wenn Sie die CAT-Funktionen von MixW verwenden, weiß MixW welche Seitenbandlage sie am 
Transceiver eingestellt haben. Sie können auf View | Spectrum | Auto schalten und die richtige 
Seitenbandlage wird automatisch eingestellt. Sie können – falls benötigt -  mit Mode | Inverted  in die 
invertierte Lage umschalten. 
Wenn Sie die CAT unter MixW richtig aktiviert haben, werden die Transceiverfrequenz, die NF-
Frequenz des Soundkartensignals und die Seitenbandlage USB/LSB mit der Einstellung  View > 
Spectrum > Auto richtig kombiniert. 
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Ihre  aktuelle MixW-Arbeitsfrequenz wird im Spektrum, im Log und in der CAT-Anzeige automatisch 
relativ (plus oder minus) zur am Transceiver eingestellten Frequenz in Abhängigkeit von der 
USB/LSB-Wahl angezeigt. Falls Sie kein CAT verwenden, können Sie die HF-, USB- und LSB-
Parameter manuell in das Menü eintragen. Wenn Sie die am Transceiver eingestellte Frequenz und 
die gewählte Seitenbandlage eingeben (mit ALT-F), bekommen sie die aktuellen Werte im Wasserfall 
oder Spektrum angezeigt. 
  
Die Anwahl von View > Spectrum > Sound zeigt allein den Audioffset unabhängig von der HF-
Arbeitsfrequenz. 
 
Beachten : Die Audio(NF)-Frequenz können Sie auch anzeigen, wenn Sie mit CAT arbeiten und RF 
USB, RF LSB, und Auto gewählt haben. Gehen Sie mit dem Mauszeiger in die Frequenzskala des 
Spektrums und drücken Sie die linke Maustaste. Die Anzeige wechselt von der HF-Skala zu einer NF-
Skala. 
 
Rotor-Auswahl und - Steuerung  
 
Dieser Abschnitt bezieht sich auf rechnersteuerbare Rotoren. Klicken Sie auf Configure > Rotor | und 
wählen Sie Ihren Rotortyp aus : 
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Wählen Sie dann Configure > Rotor >| Settings 
 

 
 

Das Fenster hat das gleiche Aussehen wie das CAT-Fenster, bezieht sich aber auf den Rotor. Stellen 
Sie die im Rotor-Handbuch angegebenen Werte für das Datenformat und die Baudrate ein. Haben Sie 
auf OK geklickt, öffnet sich ein Fenster für die Azimuth-Einstellung. Tragen Sie hier ein Gradzahl ein. 
Später können Sie die Richtung zur im Log stehenden Station <call> über den kurzen Weg (SP) mit 
Configure > Rotor > Turn to...   oder langen Weg (LP) mit TurnLP auswählen.  Die Gradzahl 
berechnet MixW aus der Datei cty.dat. 
 
 
Konfiguration der Soundkarte 
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Öffnen Sie das Menü zum Soundkartendialog mit Configure >  Sound devive settings. Falls Sie 
mehrere Soundkarten im System haben, wählen Sie eine Karte für MixW und die TX- und RX-
Funktionen aus. Sie können zusätzlich die Abtastrate (sample rate),  die Aufzeichnungszeit (sound 
history), die Geschwindigkeit des Spektrums (spectrum speed) und ein u.U. ein DSP-Filter wählen (in 
gewissen Betriebssituationen möglich). 
 

 
 

Abtastrate (Sample rate):  Kann zwischen  7000 and 12000  eingestellt werden. MixW arbeitet am 
besten mit der voreingestellten Rate von 11025. Mit anderen Raten können Differenzen zwischen 
Soundkarten ausgeglichen werden. Der Wert wird normalerweise nicht verändert. 
 
Kalibrieren (Calibrate) : Im Kapitel SSTV wird beschrieben, wie Sie die Soundkarte in der Taktrate 
genau kalibrieren können, speziell um den Schräglauf auf Null zu bringen. 
 
Aufzeichnungszeit (Sound history): Sie können für die voreingestellte Zeit ein bereits eingelaufenes 
Signal aus dem Wasserfall wiedergeben, wenn Sie bei gedrückter Shifttaste auf das Signal klicken. 
Die Ausgabe erfolgt beschleunigt. 
 
Geschwindigkeit des Spektrums (Spectrum Speed) : Mit dieser Einstellung stellen Sie die 
Laufgeschwindigkeit des Wasserfalls oder Spektrums ein. Mit einer schnelleren Darstellung können 
Sie einfacher abstimmen, benötigen aber einen schnelleren Rechner und Soundkarte. 
 
Frequenzmarken im Wasserfall :  
Mit Configure > Markers können Sie an fünf Positionen im Wasserfall eine rote Linie an 
ausgewählten Stellen einfügen : 
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Callbook 
 
MixW kann automatisch die im Log eingetragenen Rufzeichen im Callbook nachsehen. Wählen Sie  
Configure > Callbook. Geben Sie im Menü für das Logbuch den Typ und den Pfad an. haben Sie 
z.B. das QRZ-Callbuch in das Laufwerk C: kopiert. geben Sie als Pfad C:\callbk\. ein. Liegt im 
Laufwerk D: diie QRZ-CDROM, geben Sie D:\callbk\  ein. Markieren Sie dann  Options > Auto 
search . Wenn Sie jetzt ein Rufzeichen eingeben, erscheinen die Angaben zu dieser Station in der 
Statuszeile :  
 

 
 

Hinweis : Die Daten, die angezeigt werden, wenn der Mauszeiger über das Rufzeichen gesetzt wird, 
kommen nicht vom Callbook. 
 
 

2.2 Grundeinstellung (Basic Set Up) 
 
Interface zwischen Ihrem Transceiver und Ihrem PC :  
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Für das Interface zwischen Transceiver und PC unter MixW gibt es mehrere Möglichkeiten. Eine 
Zweiwegverbindung muß zwischen der Soundkarte des Computers und dem Transceiver hergestellt 
werden und der Transceiver muß zwischen RX and TX umgeschaltet werden. Sie können den 
Transceiver mit MixW auf vier Wegen zwischen TX and RX umschalten : 

 
1. Steuern Sie den PTT-Schalter mit der Spannung an den DTR oder RTS - Pins eines COM-

Ports. Der gleiche COM-Port kann auch für die serielle Kommunikation (CAT) genutzt werden. 
2. Verwenden Sie CAT-Kommandos zum Transceiver über die serielle CAT-Schnittstelle ohne 

Verwendung der PTT-Schaltung. 
3. Verwenden Sie die VOX-Schaltung, um den Transceiver auf Senden zu schalten, wenn der 

Computer den Audio-Ausgang aktiviert. Der Transceiver schaltet den TCVR zurück auf 
Empfang, wenn der PC die NF-Ausgabe beendet. (Anmerkung DM3ML : Geht nur bei der 
Einspeisung am Mikrofoneingang) 

4. Schalten Sie von Hand auf Senden und zurück auf Empfang 
 
 
Wichtiger Hinweis :  Das Mikrofon muß am Transceiver abgezogen sein, um die Aussendung von 
Sprachsignalen im Digimodebereich zu verhindern. Wenn Sie die VOX verwenden, schalten auch 
Window-Sounds den Transceiver auf Senden und diese Signale werden ausgesendet !  Um diese 
illegalen Aussendungen zu verhindern, sollten Sie alle Quellen abtrennen und den Transceiver vom 
Computer trennen oder ausschalten, wenn Sie Windows hochfahren.  
 
NF-Pegel einstellen 
 
Es ist extrem wichtig, dass Sie die NF-Pegel für Empfang und (noch wichtiger) für Senden richtig 
einstellen. Sie  können die Regler für Aufzeichnung (RX) und Wiedergabe (TX) der Soundkarte direkt 
aus MixW erreichen. Wählen Sie Configure >| Input volume oder Configure >| Output Volume.  
 
RX-Pegel einstellen :  
 
Klicken Sie unter MixW auf Configure > Input Volume :  
 

 
 
 
Schieben Sie die Fenster so, daß Sie gleichzeitig das Empfangsfenster von MixW mit dem Wasserfall 
sehen können. Stellen Sie den Empfänger des Transceivers auf einen mittleren NF-Pegel ein. Sie 
erhalten z.B. dieses Bild : 
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.  
 
 
Wählen Sie je nach dem gewählten Eingang an der Soundkarte den Regler und die Freigabe für den 
Mic- oder den Line-Eingang. Stellen Sie den Transceiver in den Digimodebereich (hier PSK z.B. bei 
14070 kHz). Klicken Sie mit der Maus auf ein deutliches Signal (grünes Band). Rastet MixW nicht auf 
das Signal ein, drehen Sie vorsichtig an der Transceiverabstimmung oder klicken Sie erneut auf das 
Signal. Die AFC übernimmt die Feinabstimmung, wenn sie aktiviert ist. 
Stellen Sie den NF-Pegel am Regler für den Mic- oder Line-Eingang so ein, daß das 
Hintergrundrauschen dunkelblau und Nutzsignale (oder starke Störungen) hellgrün angezeigt werden. 
Signale in Gelb oder Orange übersteuern die Soundkarte schon. Es ist sehr wichtig, daß die 
Soundkarte nicht übersteuert wird, denn sonst werden schwache Signale fehlerhaft dekodiert und 
falsche Werte für den IMD ausgegeben. Stellen Sie lieber einen niedrigeren Pegel ein. Reicht der 
Stellbereich der Reglers (vor allem bei Verwendung des Mikrofoneingangs) nicht aus, müssen Sie 
u.U. einen Spannungsteiler in die Leitung einfügen. 
Falls Sie kein Signal im MixW-Wasserfall sehen, ist u.U. der Line- oder Mic-Eingang stummgeschaltet 
(Mute) oder nicht als Eingang ausgewählt (Select). Die genaue Einstellung hängt von Ihrem 
Soundkartentreiber ab. Überprüfen Sie auch die Verbindungen und stellen Sie sicher, daß die 
Soundkarte nicht übersteuert wird. Hier hilft ein Spannungsteiler. 
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TX-Pegel einstellen 
 
Um digitale Signale zu senden müssen Sie den Ausgang der Soundkarte (üblicherweise  über einen 
100:1 Trenntrafo oder Spannungsteiler ) mit dem Mikrofoneingang oder dem AFSK-Pin der 
Zubehörbuchse verbinden.  
Jetzt können Sie den Transceiver an eine Kunstantenne anschließen und den NF-Ausgangspegel der 
Soundkarte einstellen. 
Diese Einstellung ist noch wichtiger als die Empfangseinstellung ! Rufen Sie mit Configure > 
Output volume das Windowsfenster des Mixers. 

 

 
 

 
Stellen Sie den Mikrofonregler des Transceivers kurz über die Minimumeinstellung. Stellen Sie den 
Instrumentenwahlschalter des Transceivers auf ALC . Verwenden Sie die VOX, stellen Sie die 
Schwelle so ein, daß die TX-Umschaltung mit einem Signal vom PC ausgelöst wird. Setzen Sie die 
VOX-Verzögerung (delay) auf ‚lang’, um einen kurzzeitigen Abfall zu vermeiden. Ohne VOX können 
Sie den Sender über die PTT oder manuell einschalten. 
 
Hinweis : Vor dem Umschalten von MixW  auf Senden müssen Sie Ihre persönlichen Daten 
eingetragen haben. Gehen dazu zu Konfiguration.  Der Rest der Konfiguration kann später erledigt 
werden. MixW schaltet nicht auf Senden, wenn Ihr Rufzeichen nicht eingetragen ist ! 
 
Wählen Sie mit  Mode > BPSK31 die Sendeart BPSK31. Schalten Sie mit einem Mausklick auf RX im 
Statusbalken auf Senden. MixW sendet ein BPSK31-Leerlaufsignal. Mit einem Klick auf TX im 
Statusbalken können Sie wieder auf Empfang (RX) schalten. Senden nicht zu lange und machen Sie 
Pausen zwischen den Sendeperioden. 
Schieben Sie den linken Regler langsam nach oben bis Ihre VOX anspricht. Spricht sie in der 
Mittelstellung des Reglers noch nicht an, dann drehen Sie den Mikrofonregler auf bis sie anspricht. 
Der TX-Output steigt an. Achten Sie auf die ALC-Anzeige. Sie darf gerade noch nicht ansprechen. 
Hier werden die meisten Fehler gemacht. Bei einer Übersteuerung des Senders entstehen gestörte 
und breite Signale. Vor allem PSK31 ist hier sehr empfindlich, aber auch die anderen Digimodes 
reagieren darauf. 
 Falls die VOX noch nicht richtig anspricht, schalten Sie den Transceiver von Hand auf Senden. 
Erhöhen Sie den NF-Pegel bis die ALC anspricht und nehmen Sie ihn dann soweit zurück, daß die 
ALC nicht mehr anspricht. Stellen Sie dann die VOX so ein, daß sie sicher anspricht. 
 
Falls Sie keinen Abschwächer zwischen Soundkartenausgang und Mikrofoneingang angeordnet 
haben, sind die Pegeleinstellungen an der Soundkarte für Lautstärke und WAVE meist in der Nähe 
des Minimums und Ihr Mikrofonregler steht unter der SSB-Einstellung. Sollten sie schlecht 
handhabbar sein, fügen Sie einen Abschwächer (DM3ML : 1:10..100) in die Leitung ein. 
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Sie können die NF wahlweise über die Zubehör (ACC)-Buchse einspeisen. Hier sind höhere 
Eingangspegel möglich, da der Mic-Vorverstärker übergangen wird. Die VOX kann aber bei diesem 
Anschluß nicht verwendet werden. 
Markieren Sie Positionen der Regler und notieren Sie sich die Windowseinstellungen, wenn Sie die 
optimale Konfiguration gefunden haben. 
 
 

2.3 PTT-Schaltung (PTT Circuit) 
 

Sie können die PTT auf drei Arten schalten :  
 

• Tasten der PTT-Leitung über einen dediziert zugewiesenen COM-Port 
• Steuerung über die CAT per Kommando  
• Tastung der PTT  über eine Leitung an der CAT-Schnittstelle 

 
Siehe  Konfiguration (Configuration) zur Einstellung der MixW-Software  
 
Tastung über eine Schnittstelle 
 
Für die Tastung der PTT können Sie wahlweise das DTR- oder RTS-Signal verwenden. RTS liegt an 
Pin 4 des DB-25-Steckers oder Pin 7 des DB-9-Steckers,  DTR liegt an Pin 20 beim DB-25, oder Pin 4 
beim DB-9. Die Signale gehen von -12V auf +12 V. 
Zum Tasten des Transceivers benötigen Sie einen Schalttransistor.  Eine geeignete Schaltung zeigt 
das folgende Bild : 
 

 
 

Steuerung über CAT 
 
Wenn Sie die PTT-Kommandos der CAT-Steuerung verwenden, benötigen Sie keine zusätzliche 
Hardware. Die meisten modernen Transceiver von  Kenwood. Yaesu, Icom und TenTec lassen sich 
über die CAT steuern. 
 
Gemeinsam benutzte CAT-Schnittstelle 
 
Sie können die RTS und/oder DTR-Leitungen der CAT-Schnittstelle für die direkte PTT-Steuerung die  
und CW-Tastung Ihres Transceivers verwenden (siehe oben). Schalten Sie dann PTT via CAT 
command bei der Einstellung der Schnittstelle ab und wählen Sie, welches Signal Sie für PTT und 
welches für CW verwenden wollen. 
  

2.4 Macros erzeugen (Configuring Macros) 
 

Die komplette Liste der Macros finden Sie unter Macro-Kommandos (Macro Commands). 
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Macros können selbst mit Macros und mit Text kombiniert werden, Sie können viele Funktionen von 
MixW und auch ihren Transceiver via CAT steuern. Sie ersparen Ihnen lange Eingaben. Macros sind 
grundsätzlich in Großbuchstaben zu schreiben, der Text dazwischen kann Klein- und Großbuchstaben 
enthalten. Sendearten wie RTTY und AMTOR machen daraus generell Großbuchstaben, da in Ihrem 
Zeichenvorrat nur große Buchstaben enthalten sind. 
MixW unterstützt verschiedene und z.T. sendeartenbezogene Macros. Diese Macros können beim 
Umschalten zwischen den Sendearten automatisch als sog. “lokale Macros“ geladen werden. Sie 
können auch für verschiedene Zwecke getrennte Macrosätze anlegen, z.B. einen Satz für Conteste 
und den anderen für normale QSOs (oder getrennt in englisch, deutsch oder spanisch). 
Sehen Sie unter Contest Operation nach, wenn Sie Macros für einen Contest anlegen wollen. Die 
Macros der MixW-Version 2 sind extrem flexibel und kraftvoll, aber Sie brauchen einige Zeit, sie so zu 
konfigurieren, daß sie Ihren Anforderungen ensprechen. Macros können auf drei Wegen editiert 
werden : 
  

• Klicken Sie mit der rechten Maustaste auf eine Macrotaste 
• Wählen Sie Configure >| Default Macros  (voreingestellte Macros konfigurieren) 
• Wählen Sie Configure >| Macros for the mode... (Macros sendeartenbezogen konfigurieren) 
•  

 
 
Beachten : Macros müssen in großen Buchstaben geschrieben werden, Text kann in großen oder 
kleinen Buchstaben geschrieben werden. Die Kleinbuchstaben werden automatisch in 
Großbuchstaben umgewandelt, wenn Sendearten wie RTTY oder AMTOR nur große Buchstaben 
senden.  
 
Macros editieren 
 
Wenn Sie MixW starten, erscheint folgende Tastenreihe oben im Fenster : 
 

 
 
Die Tasten ab AutoCQ entsprechen den Tasten F1 bis F12 . Mit einer oder zwei zusätzlich gedrückten 
Tasten können Sie insgesamt vier 12er-Gruppen  an Macrotasten aufrufen :  
 

• Keine weitere Taste (Einzeltasten) (=gezeigtes Bild) 
• Strg(CTRL) 
• Shift  
• Strg(CTRL) + Shift  

 
 
Wenn Sie den Inhalt der Macros in den Tasten F1 bis F12 sehen wollen, klicken Sie mit der rechten 
Maustaste darauf. Klicken Sie z.B.  mit der rechten Maus auf eine Macrotaste im Bildschirm , z.B. die 
zur Taste F4 gehörende Taste Call : 
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Sie können den dieser Taste zugewiesenen Text nun editieren. Mit einem Klick auf die Taste A 
können Sie dem Feld einen farbigen Hintergrund zuweisen. Ihnen stehen alle Möglichkeiten zum 
Editieren des Texts im linken Feld zur Verfügung. Wollen Sie ein Macro aus der von MixW zur 
Verfügung gestellen Liste in den Text links einbauen, dann markieren Sie dieses Macro in der rechten 
Liste mit einem linken Klick und klicken Sie dann auf den Doppelpfeil << in der Mitte zwischen beiden 
Feldern. Das Macro wird im linken Feld eingefügt. 
Im Beispiel für die Taste F4 steht ein einfacher 1x1-Anruf. Wollen Sie diesen mit dem Umschalten auf 
Senden und zurück auf Empfang komplettieren, so , fügen Sie vor <CALL> das Macro zum 
Umschalten auf Senden <TX> und zum Abschluß ein K und das Macro zum Umschalten auf Empfang 
<RX> ein. Mit dem Macro <TX> <CALL> de <MYCALL> K <RX> haben Sie einen kompletten Anruf 
der Gegenstation (deren Call im Log stehen muß) realisiert. 
 
Im Editierfenster sehen Sie ein Feld mit dem Eintrag Default for all modes . Hier können Sie wählen, 
ob die Taste F4 für alle Sendearten (default) wirken soll oder spezifisch für die aktuelle Sendeart (for 
this mode) konfiguriert werden soll. 
 Sie können für die jeweiligen Sendearten und/oder für Conteste getrennte Macro-Sätze erzeugen. 
Diese Sätze müssen Sie mit einem getrennten Werkzeug editieren, das später beschrieben wird. Die 
Auswahl erfolgt über Configure >  Default macros und diese Auswahl :  
 

 
 

Wenn Sie einen noch nicht ausgefüllten Macrosatz angeben, erhalten Sie die Abfrage :  
 

 
 

Diese Datei ist leer oder existiert noch nicht. Wollen Sie weitermachen ? Die Abfrage bedeutet, 
dass die eingegebene  MixMacros.ini – Datei noch nicht existiert. Mit No und Cancel beenden Sie 
die Bearbeitung und kommen zurück zum Hauptfenster von MixW. Wählen Sie Yes (Ja) öffnet sich ein 
leeres Fenster, in dem Sie einen neuen Satz an Macros anlegen können oder sie können, wenn Sie 
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einen bereits existierenden Satz angegeben haben, diesen Satz editieren und unter einem neuen 
Namen abspeichern : 
 

 
 

Mit einem Klick auf Add new können Sie in eine leere oder teilweise gefüllte Tabelle eine neue Zeile 
einfügen oder mit einem Doppelklick eine schon ausgefüllte Zeile editieren. Mit einem Klick auf den 
Pfeil nach unten im Feld Macro können Sie eine der möglichen Tasten auswählen und mit einem Text 
belegen. Zusätzlich zu den F-Tasten können Sie auch Ereignisse wie On Start, On End u.a. mit 
einem Macro belegen. 
 

 
 
 
Zweckmässig ist es, von einem voreingestellten Macro-Satz auszugehen, ihn mit Load zu holen, zu 
editieren und mit Save unter einem neuen Namen abzuspeichern, unter dem er dann für die spätere 
Verwenundung gerufen werden kann. Sie können auf diese Weise eine unbegrenzte Menge an 
Macro-Sätzen mit jeweils 48 Tasten und weiteren Ereignisrufen anlegen, z.B. für verschiedene 
Sprachen. 
Eine weitere Möglichkeit besteht darin, für die verschiedenen Sendearten getrennte Macro-Sätze 
anzulegen, die automatisch mit der gewählten Sendeart aktiviert werden. 
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MixW 2 Macros erklärt von Denis Nechitailov, UU9JDR (ein wenig editiert von K4SET) 
 
Die voreingestellten Macros von MixW2 stehen in der Datei MixMacros.mc im MixW-Verzeichnis 
beim Erststart. Sie werden in allen Sendearten verwendet, solange bis Sie Ihre spezifischen Macros 
erstellt haben, die sie ersetzen. 
 
Sie können unter Configure > Default macros  den Macrossatz editieren und festlegen, den Sie gern 
nutzen wollen. Sie können Macros hinzufügen, streichen und editieren. Sie können auch einen 
bearbeiteten Satz unter einem anderen Namen mit der Endung *.mc abspeichern und ihn dann als 
voreingestellten Satz festlegen. Wenn Sie die Taste für ein ausgewähltes Macro rechts anklicken, 
können Sie es ohne eine große Liste aller Macros individuell bearbeiten. Jedes Macro hat eine 
wählbare Überschrift, die in der jeweiligen Taste steht. Wird ein Macro links angeklickt, wird sein Inhalt 
in das TX-Fenster ausgegeben. 
 
Es gibt zwei generelle Möglichkeiten die Macros zu verwenden. Der einfachste Weg ist, einen Satz 
Macros zu erzeugen, der bei allen Gelegenheiten verwendet wird. Dieser Satz kann wie oben 
dargestellt geändert werden, er kann auch „im Flug“ angepasst werden, indem Sie das Macro 
<MACRO:filename> einsetzen.  
Nehmen wir an, Sie haben jeweils auf der Taste F5 Ihren Namen gelegt. Die Voreinstellung in 
englisch möge lauten : 

 
Macro: F5  
Label: Name  
Text: My name is Eugene. 
 
Ihre spanische Datei heißt MixMacrosSpanish.mc  und auf  F5 key steht  
 
Macro: F5  
Label: Nombre  
Text: Mi nombre es Eugenio. 
And so on. 
 
Sie können zwischen Englisch und Spanisch umschalten, indem Sie z.B. auf die Taste  Ctrl-Shift-F1 
des englischen Satzes MixMacros.mc das Macro mit den Daten  
 
Macro: Ctrl-Shift-F1  
Label: Spanish  
Text: <MACROS:MixMacrosSpanish.mc> 
 
setzen und in den spanischen Satz unter MixMacrosSpanish.mc das Macros  

 
Macro: Ctrl-Shift-F1  
Label: English  
Text: <MACROS:MixMacros.ini> 
 

einbauen. 
 
Jeweils mit CTRL-Shift-F1 schalten Sie von englisch auf spanisch und zurück. 
 
 
Dieser eine Satz wird in der Regel nicht für alle Sendearten in allen Situationen zweckmäßig sein, 
auch wenn ein Umschalten mit dem Macro <MACROS:filename> schon etliche Probleme löst. Unter 
MixW können Sie aber ein zweites lokales System von Macros anlegen, das auch Kommandos an 
einen TNC enthalten kann. 
 
Wozu benötigen Sie lokale Macros ? Sie können ein RTTY-Macro mit RYRYRYRYRYRYRY sicher 
nicht in PSK31 gebrauchen oder eine WAV-Datei mit CQ CQ … zwar in SSB, aber nicht in THROB 
und eine Contest-Nummer nicht in einem normalen QSO. 
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MixW2 kann automatisch zwischen den Macros, die Sie für eine spezielle Sendeart erzeugt haben hin 
und her schalten. Wählen Sie Macros für diese Sendeart (Configure >  Macros for this mode..) 
und erzeugen Sie z.B. für BPSK31 die Datei BPSK31.mc. Wenn Sie nun auf BPSK31 umschalten, 
können Sie mit den speziellen BPSK-Macros arbeiten. 
 
Hinweis : Mit Configure >| Merge macros geben Sie MixW vor, wie Sie die lokalen und die 
voreingestellten Macros mischen (merge) wollen. Ist Merge macros abgeschaltet, sehen Sie nur die 
für die gewählte Sendeart/den Contest/den TNC  individuell vorbereiteten Macros. Ist Merge macros 
zugeschaltet (ein Haken davor) werden die lokalen und die voreingestellten Macros gemischt. Ein 
lokales Macro wird dann genommen, wenn es in dem lokalen Satz definiert worden ist z.B. für F5 in 
BPSK31.mc 
bei BPSK31. Ist F5 in diesem Satz nicht belegt, wird das Macro aus dem voreingestellten Satz 
(default) genommen. 
 
Das Mischen von Macros ist sehr praktisch, wenn Sie nur einige spezielle Macros an die Sendeart 
anpassen wollen. Die Taste F2 ist z.B.im voreingestellten Satz so belegt : 
 
 <TX>  
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL>  
 
Für RTTY soll der CQ-Ruf so aussehen :  
 
<TX>  
RYRYRYRYRYRYRYRYRYRYRYRYRY  
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL>  
 
Meistens werden Sie die gleichen lokalen Sätze für BPSK31, QPSK31 und FSK31 verwenden.  RTTY 
und AMTOR können sich den gleichen lokalen Satz teilen und die WAV-Dateien passen für  SSB, AM 
und FM.  
Wenn Sie Configure >| Macros for this mode anwählen, eine Datei auswählen und dann 
auf Edit klicken, sehen Sie eine komplette Liste aller angelegten Macros. Wenn Sie separate 
Macros für eine oder mehrere Sendearten angelegt haben, können Sie ein einzelnes Macro 
mit einem rechten Mausklick editieren. Sie können dabei wählen, ob Sie dieses Macros für 
die Voreinstellung (Default for all modes) oder für die spezielle Sendeart  (For this mode) 
nutzen wollen.  
 
Nehmen Sie an, daß Sie noch keinen Macrosatz für  RTTY angelegt haben, aber eine Reihe 
RYRYRYRY nur für RTTY einbauen wollen : 
 

• Schalten Sie auf RTTY  
• Gehen Sie zu Configure > Macros for this mode, klicken Sie auf das Feld ... ,und geben 

Sie im sich öffnenden Dateifenster z.B.  RTTY.mc ein, falls es die Datei RTTY.mc noch 
nicht gibt, und bestätigen Sie das Anlegen von RTTY.mc. 

• Es öffnet sich ein leerer Dialog, den Sie mit Tasten und den zugehörigen Macros füllen 
können. Sie könnten hier schon Tasten belegen, aber schließen Sie diesen Dialog 

• Geben Sie jetzt mit Configure | Merge Macros das Mischen frei. Sie sehen bei RTTY die 
voreingestellten (default) Macros 

• Klicken Sie rechts auf die Taste  F2 und wählen Sie For this mode im Edit-Fenster. 
Fügen Sie vor dem Text RYRYRYRYRYRYRYRY ein und drücken Sie OK. Nur wenn Sie 
in RTTY arbeiten, haben Sie jetzt in dem Text die RYs, in allen anderen Sendearten 
fehlen sie. 

 
Wollen Sie ein Macro löschen, gehen Sie aus RTTY wieder ins Edit-Fenster und klicken auf CLEAR 
(Löschen). Schließen Sie das Edit-Fenster mit OK und das RYRY.. ist weg. 
 
TNC Macros: Wenn Sie einen TNC verwenden, wird ein eigener Macrosatz für diesen TNC angelegt. 
Der Name dieses Macrosatzes wird unter Mode >| TNC modes settings eingetragen. Diese Macros 
können dann lokal oder gemischt (merge) mit den default-Macros genommen werden. Siehe TNC 
Configuration and operation. 
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Macros zusammen mit einem TNC verwenden : Ein TNC wird unter MixW2 unter folgenden 
Bedingungen eingesetzt :   

• Der TNC arbeitet im Terminalmodus (kein Hostmodus)  
• Der TNC wird bezüglich Sendeart, Baudrate, RX/TX-Status usw. über Macros gesteuert 
 

Sie werden meist mehrere Sätze von Macros für verschiedene Sendearten mit dem gleichen TNC 
haben. 
Zuerst müssen Sie den TNC initialisieren und in die gewünschte Sendeart schalten und zum Schluß 
wieder de-initialisieren. Für diesen Zweck gibt es zwei spezielle Macros : 
 
OnStartMode 
OnEndMode 
 
  
Sie wollen z.B. PACTOR mit einem KAM+ TNC machen. Dann können Sie Macros definieren, die so 
aussehen : 
 
Für den Start von PACTOR mit dem KAM-TNC :  
 
Macro: OnStartMode 
Label: Start  
Text: <HIDETEXT><AUDIOFQ:2200> 
<SHIFT:200> <CTRL-C>X 
PACTOR 
<SHOWTEXT> 
 
und nach dem Ende von PACTOR :  
 
Macro: OnEndMode 
Label: End  
Text: 
<HIDETEXT><CTRL-C>X 
<SHOWTEXT> 
 
Das erste Macro setzt die Mittenfrequenz  auf 2200 Hz und die Shift auf 200 Hz und schaltet den TNC 
mit CTRL-X und PACTOR  auf PACTOR-Betrieb um. 
Nachdem Sie die OnStartMode- und OnEndMode-Macros definiert haben, müssen Sie die TX- und 
RX-Macros an den KAM+ anpassen : 
 
Macro: TX 
Label: TX 
Text: <HIDETEXT><CTRL-C>T<SHOWTEXT> 
 
Macro: RX 
Label: RX 
Text: <HIDETEXT><CTRL-C>E<SHOWTEXT> 
 
Das erste Macro schaltet den KAM+ mit CTRL-T auf Senden, das zweite mit CTRL-E wieder 
Empfang. Das Macros selbst wird mit <HIDETEXT> versteckt und danach die Ausgabe mit 
<SHOWTEXT> wieder freigegeben. Sind <TX> und <RX> auf diese Weise definiert, können 
Standard-Macros wie z.B. 
 
<TX>CQ CQ CQ de ...<RX> 
 
 
Contest macros  
 
Schalten Sie mit View >| Contest mode in den Contestmodus. Eine Liste der Conteste öffnet sich. 
Wählen Sie einen Contest aus oder definieren Sie mit Edit einen neuen. Bei den Contestdaten 
werden Sie nach dem gewünschten Macro-Satz gefragt. Wenn Sie nun bei Macros noch auf Mischen 
(Configure >| merge macros) geschaltet haben, haben Sie eine Kombination von drei Macrosätzen 
zur Verfügung : die voreingestellten (default), die Sendeart-spezifischen und die für den gewählten 
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Contest. Die Contest-Macros sind nur wirksam, wenn auf View >| Contest mode geschaltet wurde. 
Für weitere Informationen gehen Sie zu Contestbetrieb (Contest Operation) 
 
Konfiguration zusätzlicher Macro-Tasten  
 
Zusätzlich zu den Taste F1 bis F12 können Sie weitere Tasten mit Macros belegen. Diese Taste 
können aber nur über die volle Edit-Liste für Default-Macros, sendeartspezifische Macros, Contest-
Macros oder TNC-Macros konfiguriert werden, Sie erscheinen nicht im Steuerbalken (control bar) und 
können nicht mit der rechten Maustaste angeklickt werden. 
Folgende 5 Tasten können zusätzlich belegt werden : 
 

 Ins 
Gray+ 
Gray- 
Gray* 
Gray/ 

 
Die Gray-Tasten befinden sich im Nummernfeld der Tastatur. Sie können Sie in der Edit-Liste im 
Menü desFelds Macro anwählen. Die Tastennamen müssen wie angegeben geschrieben werden. 
 
Die Macros OnStartMode und OnEndMode werden ausgeführt, wenn auf eine neue Sendeart 
umgeschaltet bzw. diese beendet wird. Schalten Sie zum Beispiel auf SSB, können Sie das 
automatische Notchfilter ein und nach Verlassen von SSB wieder ausschalten oder bei PSK das 
schmale CW-Filter zu- und dann wieder abschalten. 
 
Macro von Macro rufen  
 
Sie können  in einem Macro ein zweites Macro rufen. Haben Sie z.B. auf die Taste F2 das Macro : 

<TX>  
CQ CQ CQ de <MYCALL> <MYCALL> <MYCALL>  

 
und wollen den gleichen Text für das Auto-CQ verwenden, setzen Sie nur ein <F2> in das Auto-CQ-
Macro. AutoCQ sendet dann den F2-Text. Nur das eigene Macro können Sie nicht selbst rufen. 
 
Sie können aber in den Macros verwendete “Unter”-Macros” mit einem weiteren Macro definieren, z.B.  
 

Macro: POWER  
Label: beliebig, wird nicht angezeigt  
Text: 40 

 
Dieses Macro wird nicht in der Steuerleiste angezeigt, kann aber intern z.B.  bei der 
Stationsbeschreibung eingesetzt werden :  
 

Macro: F6  
Label: RIG  
Text: <CR>The power is <POWER> <POWER> watts.<CR> 

 
Um das Macro <POWER> während des Funkbetriebs zu ändern, können Sie auf eine nicht so oft 
benutzte Tastenreihe z.B.Ctrl-Shift-F2 das Macro <EDITMACRO:name> wie hier legen : 
 

Macro: Ctrl-Shift-F2  
Label: myPWR  
Text: <EDITMACRO:POWER> 

 
Nach Ctrl-Shift-F2 öffnet sich eine Dialogbox und Sie können aus 40 jetzt 20 machen. Drücken Sie 
nach der Änderung auf F6 (RIG) erscheint der Text :  
 

The power is 20 20  watts 
 
 
Ein paar Macro-Favoriten des MixW- Betatesterteams :  
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Von Richard "Griff" Griffin, NB6Z :  

 
SK 
 
<CALL> de <MYCALL> SK at <TIME><CWID><RXANDCLEAR><SAVEQSO> 
 
BTU (Tastenübergabe “Back To You”) 
 
BTU <NAME>... <CALL> DE <MYCALL> K <RXANDCLEAR> 
 
CALL 
 
<TX><CALL> <CALL> <CALL> de <MYCALL> <MYCALL> <MYCALL> K 
<RXANDCLEAR> 
 
RST 
 
Thanks for report from <QTH>; you are <RSTS> <RSTS> here in 
<MYQTH>. 

 
 
Von  Nick Fedoseev, UT2UZ 

 
Verwendung von  <LOCKTX> in CQ-Macros 
 
<LOCKTX><TX>CQ CQ CQ de <MYCALL> <MYCALL> 
<RX> 
 
Verwendung von  <UNLOCKTX> beim Suchen und Anrufen : 
 
<UNLOCKTX><TX><CALL> <CALL> de <MYCALL> <MYCALL> <MYCALL> pse k <RX> 
 
Beim Anruf von DX wird meist nur das eigene Rufzeichen einige Male gesendet. Das Macro 
 
<MYCALL> <TX><RXE> 
 
wird z.B. vier Mal hintereinander gedrückt und sendet viermal das eigene Rufzeichen, ehe es 
auf Empfang schaltet : 
 
UT2UZ UT2UZ UT2UZ UT2UZ  
 

 
Von Dick Thompson, WB0DUL 
 

Dick möchte gern seine Temperatur richtig als 60ºF oder 16ºC senden. Er baut in den Text mit 
der Temperaturangabe ein Gradzeichen ein, indem er im Macro die ALT-Taste gedrückt hält 
und ‘0186’ auf der Zifferntastatur eingibt.  

 
 

3. Funkbetrieb (Operation) 
 

3.1 Überblick (General Operation) 
 
Lesen Sie diese Instruktionen zuerst, um mit MixW vertraut zu werden, und gehen Sie dann zu den 
Digitale Sendearten (Digital Modes) für spezifische Eigenheiten. 
 
Wahl der Sendeart  
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Wählen Sie die gewünschte Sendeart mit einem Klick auf Mode : 
 
 

 
 
 

Der Statusbalken am unteren Bildrand ändert sich und zeigt der gewählten Sendeart zugeordnete 
Felder. Bei PSK31 wird der IMD (Intermodulationsabstand) angezeigt, bei Packet der Zustand 
Connected oder Disconnected, beides sind nur für die jeweilige Sendeart relevante Angaben : 
 

 
 

 
 

Sie können das Sendearten-Menü auch durch einen Klick auf die Sendeart im Statusbalken aufrufen : 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 39 von 155 Übersetzung von Eike,DM3ML 

 
 

Anpassung der Sendearteinstellung 
 
Jede Sendeart hat ihre eigene Dialogbox zur Auswahl von nur für diese Sendeart benötigten 
Parameter. Sie erreichen sie über Mode > Mode settings : 
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Jede Sendeart hat dabei Ihr eigenes Fenster. Einzelheiten dazu finden Sie in den Kapiteln der 
einzelnen Sendearten. Sie können z.B. unter RTTY die Shift, die Baudrate und die Inversion 
einstellen, alles Kennwerte, die für PSK31 nicht relevant sind. Andererseits können Sie unter BPSK31 
wählen : 
 

 
 
 

Die Voreinstellung der einzelnen Sendearten können Sie auch mit Macro  <MODESETTINGS> 
ansprechen, wenn Sie es auf eine der F-Tasten legen. Siehe Macros zur Sendearteneinstellung 
(Mode Settings Macros) zu Einzelheiten. 
 
Inversion 
Hinweis :  MixW arbeitet hier anders als die meisten anderen Soundkartenprogramme. Lesen Sie 
unter zu Inversion im Kapitel  Konfiguration (Configuration) nach.   
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Empfang 
Nachstehend sollen einige allgemeine Hinweise zum Empfang gegeben werden, die unabhängig von 
den unter den einzelnen Sendearten angeführten Einzelheiten gelten. 
 
Wählen Sie ein Signal durch einen Klick mit der linken Maustaste im Wasserfall oder im Spektrum 
aus. Wenn Sie die zu dem Signal passende Sendeart eingestellt haben, wird das Signal im RX-
Fenster mitgeschrieben. Sie können das Signal feinabstimmen, wenn Sie bei gedrückter Strg (Ctrl)-
Taste auf die Pfeil links- oder Pfeil-rechts-Tasten drücken. 
 
Suchlauf (Seek)  
Sie können die Stationen auch mit den Macros  <SEEKLEFT> und <SEEKRIGHT> einstellen, wenn 
Sie diese auf eine F-Taste legen. Mit <SEEKRIGHT> springt der Cursor auf die nächste Station rechts 
vom aktuellen Cursor, mit <SEEKLEFT> wird die nächste Station links vom Cursor angewählt. Es 
kann vorkommen, daß der Cursor auf einem Träger, einer Störung oder einer Störlinie der Soundkarte 
stehen bleibt. Drücken Sie dann erneut auf die Suchtaste. Wichtig ist, daß Sie jeweils mit Configure | 
Spectrum | RF, USB or RF, LSB die richtige Seitenbandlage eingestellt haben, damit das Suchen in 
der richtigen Richtung erfolgt. Bei MixW sind die Tasten F11 und F12 mit  << und >> als Suchtasten 
vorprogrammiert. 
Wurde Options | Arrows für die Suche freigegeben, sind die Tasten Pfeil-rechts und Pfeil-links für die 
Suche nutzbar und die Tasten F11 und F12 können mit anderen Macros belegt werden. Sie sind dann 
für Edit-Funktionen im TX- oder RX-Fenster aber nicht mehr verwendbar. 
Wurde  Option | Continuous Seek angewählt, läuft die Suche kontinuierlich, bis ein Signal gefunden 
wurde. Die Suche wird mit einem Druck auf die Suchtaste wieder gestoppt. 
 
Bookmarks (Buchzeichen) 
Mit einem Platzhalter – Bookmark (Buchzeichen) genannt – können Sie ausgewählte Signale im 
Spektrum oder Wasserfall markieren. Klicken Sie mit der rechten Maustaste auf das Signal und dann 
auf Toggle Bookmark im sich öffnenden Menü. Unter dem Diamant-Cursor erscheint ein Feld mit 
einem Buchstaben. Sie können das Buchzeichen auf gleiche Weise wieder entfernen. Haben Sie das 
Rufzeichen der Station bereits ins Log übernommen, wird das Signal mit dem Rufzeichen der Station 
markiert. Diese Übernahme erfolgt, wenn Sie im empfangenen Text auf das Rufzeichen der Station 
klicken. Wenn Sie auf ein Buchzeichen klicken, kehren Sie zur Frequenz dieser Station zurück oder 
Sie sehen das volle Rufzeichen im Buchzeichen, wenn Sie wieder auf diese Frequenz abstimmen. 
Wenn Sie zu einer markierten Frequenz zurückkehren wollen, klicken Sie mit der linken Maustaste 
darauf, um den Diamant-Cursor auf diese Stelle zu bringen oder klicken Sie mit der rechten Maustaste 
darauf, um den Dreieck-Cursor aus einem der zusätzlichen Empfangsfenster dorthin zu bringen- 
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Falls Sie das Bookmark-Macro einer Taste zugeordnet haben, können Sie mit dieser Taste ein 
Buchzeichen setzen oder ein bereits gesetztes wieder entfernen. MixW kürzt Bookmark mit Mark in 
der Taste ab. 
  
Clear (Löschen) 
Sie können Text im RX-Fenster mit einem Rechtsklick in das Fenster und der Wahl von Clear im sich 
öffnenden Fenster löschen. Sie können den Text auch mit dem Macro <CLEARWINDOW>  löschen.  
Es ist in der Voreinstellung auf die Taste F8 gelegt. Stellen Sie den Mauszeiger ins RX-Fenster und 
drücken Sie auf F8, wenn Sie das Fenster leeren wollen. 
 
Mehrfenster-Betrieb bei Empfang 
 
Sie können unter MixW mehrere RX-Fenster öffnen und Stationen parallel mitschreiben. Drücken Sie 
die Strg (CTRL)-Taste und klicken Sie mit der rechten Maustaste ins RX-Fenster. Ein zweiter RX-
Schirm öffnet sich (RX1 genannt). Doppelklicken Sie ein Signal mit der rechten Maustaste an und es 
wird im RX1-Fenster mitgeschrieben. Denn gleichen Effekt können Sie erreichen, wenn Sie mit der 
rechten Maustaste auf ein Signal im Wasserfall oder Spektrum klicken und im sich öffnenden Menü 
New Receive Window wählen. Sie können mehrere Empfangsfenster öffnen. 
 

 
 
 
Im Wasserfall sehen Sie für die zusätzlichen Empfangsfenster kleine dreieckige Cursoren. Die zum 
Fenster  gehörende steht in grün unter dem Cursor. Sie können das jeweilige RX-Fenster zum 
Hauptfenster machen, wenn Sie rechts in das Fenster klicken und Swap aus dem Menü wählen. 
  
Sie kehren vom Mehrkanalempfang zum Ein-Kanal-Empfang zurück, wenn Sie das oder die 
Hilfsfenster schließen.  
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Fenster positionieren und in der Größe anpassen (Positioning and Sizing Windows) 
 
Hinweis : Bevor Sie diese Änderungen machen, sollte Sie die Datei MixW2.ini sichern, um u.U. zum 
Zustand vor den Änderungen zurückkehren zu können. 
 
Klicken Sie auf den leeren Platz (DM3ML:am besten links oben) im Steuerbalken, dem Logfenster, der 
Abstimmanzeige oder der Weltkarte und ziehen Sie bei gedrückter Taste das Fenster auf den 
gewünschten Platz. Hilfe bietet der mitlaufende Fensterrahmen. Die aktuelle Position eines Fenster 
wird beim Schließen von MixW abgespeichert und beim Neustart ausgewertet. 
 
Setzen Sie den Mauszeiger auf eine Trennlinie zwischen den Fenster, ändert er sich in parallele 
Linien mit einem Pfeil. Sie können mit gedrückter linker Maustaste die Trennlinien ziehen und die 
Fenster damit vergrößern oder verkleinern (oder einen verschwundenen Wasserfall wieder zum Leben 
bringen). 
 
Auf diesem Bild sehen Sie eine Möglichkeit für die Anordnung der verschiedenen Fenster : 
 

 
 
 
Icons im Empfangsfenster  
Im RX-Fenster erscheinen beim Empfang von der Gegenstation und beom Senden eigenen Textes 
kleine Icons. Diese Icons stehen im Unterverzeichnis ..\ MixW \ ICONS und Erscheinen dann im Text, 
wenn ein empfangenes Wort in der Datei icons.cfg gefunden wird. Sie können Ihre eigenen Icons in 
das Verzeichnis ICON bringen und dann in der Datei icons.cfg die Zuordnung mit einem Texteditor wie 
Notepad eintragen. 
Die Icon erscheinen nur in Ihrem RX-Fenster,  sie werden NICHT ausgesendet. Die Gegenstation 
sieht die Icons nur, wenn sie MixW verwendet und die Icons aus dem lokalen Verzeichnis holen kann. 
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Sie können die Icons Ihrer eigenen Station ohne Sender testen, wenn Sie Text in das 
sendevorschreibfenster eingeben, auf Senden schalten und der Text im RX-Fenster als Echo wieder 
ausgegeben wird . In diesem Beispiel erscheint für MixW der Schmetterling und bei SK das Kreuz. 
 
  
 

 
 

Anmerkung DM3ML : Stören Sie Icons, taufen Sie die Datei icons.cfg oder das Verzeichnis ICONS 
um oder löschen Sie es. 
 
Notchfilter im Spektrum oder Wasserfall 
Um das Notchfilter in der NF-Lage einzuschalten, klicken Sie rechts an die Stelle im Wasserfall oder 
Spektrum, an der das Filter gesetzt werden soll, und wählen Sie im sich öffnenden Menü  Set Notch 
Filter. Es können mehre Notchfilter mit dieser Methode gesetzt werden. Sie können mit einem 
erneuten Rechtsklick in den Wasserfall Clear Notch Filter. wählen. Damit werden ALLE gesetzten 
Notchfilter gemeinsam gelöscht. Ein selektives Löschen ist nicht möglich. 
 
 

 
 

Senden  
 
Der aktive Cursor für das Senden wird durch eine grüne Flagge auf der Frequenzskala oberhalb der 
Diamant-Cursoren gekennzeichnet. Diese Flagge wird rot, wenn die Sendefrequenz auf LOCK gestellt 
und hier festgehalten wird. 
Falls Sie eine Station anschreiben wollen müssen Sie sie zuerst abstimmen (siehe oben). Schreiben 
Sie den ausgehenden Text in das TX-Fenster. Es ist das schmalere Fenster zwischen RX-Fenster und 
Wasserfall/Spektrum. Wenn Sie die TX/RX-Taste drücken, wird der Text aus dem Sendefenster 
gesendet. Sie können weiteren Text ins das Sendefenster während des Sendens schreiben. Der 
gesendete Text erscheint im RX-Fenster. Das Senden wird beendet, wenn Sie ein zweites Mal auf die 
TX/RX-Taste drücken. Vorher wird der noch im TX-Fenster stehende Text vollständig gesendet. 
Wollen Sie die Sendung unmittelbar unterbrechen, drücken Sie auf die ESC-Taste. Der Text im TX-
Fenster wird dann nicht mehr gesendet. 
Während des Sendens bleibt der Wasserfall stehen und friert ein. Er läuft weiter, wenn Sie auf RX 
zurück schalten. Eine grüne Linie markiert die Tastenübergabe. 
 
Der Text im Sendefenster kann vor dem Aussenden oder während des Sendens korrigiert werden. Die 
Korrektur funktioniert aber nur von hinten mit der Rück (Backspace)-Taste. Einfügen ist nicht möglich. 
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Löschen Sie den Text und schreiben Sie ihn neu. Sind die Pfeiltasten mit Options | Arrows for Seek  
belegt, scheiden Sie beim Editieren ebenfalls aus. Wenn Sie Arrows for Seek  wieder abschalten, 
stehen sie Ihnen wieder zur Verfügung. Sie können auch das ganze TX-Fenster löschen, wenn Sie 
den Cursor ins Sendefenster setzen und die mit CLEARWINDOW belegte Taste F8 (Voreinstellung) 
drücken.   
 
Mehrfensterbetrieb beim Senden 
Beim Öffnen von zusätzlichen RX-Fenstern befindet sich MixW im Mehrfensterbetrieb. Eine Station 
wird durch einen linken Mausklick ins Hauptfenster geholt. Ein rechter Klick ordnet ihr ein Hilfsfenster 
zu. Die Frequenz des Hauptkanals wird beim Diamantkursor und die der Hilfskanäle beim dreieckigen 
Cursor angezeigt. 
Um Fehlfunktionen auszuschließen, kann MixW nur auf einer Frequenz senden. Sie können dazu 
einen Hilfskanal in den Hauptkanal holen (swappen). 
 
TX Lock 
Mit LOCK können Sie "Split frequency" – Betrieb machen und auf einer Frequenz empfangen und auf 
einer anderen senden. Setzen Sie den Cursor mit einem linken Klick auf die Stelle, auf der Sie senden 
wollen. Der Diamantcursor mit grüner Flagge erscheint. Klicken Sie im Statusbalken auf LOCK und 
die Flagge wird rot. Klicken Sie nun wieder links auf die zu empfangene Station, die den Pileup 
erzeugt. 
Der Diamantcursor teilt sich, das nach unten zeigende blaue Dreieck bleibt mit der roten Flagge auf 
der TX-Frequenz , das nach oben zeigende rote Dreieck steht auf der RX-Frequenz. 
Mit einiger Erfahrung und Experimenten werden Sie die Funktion LOCK  auch in anderen Fällen 
einsetzen können. 
Wollen Sie die Sendefrequenz entsperren (unlock), klicken auf die Taste Lock im Statusbalken. Die 
Sendefrequenz kehrt zur Empfangsfrequenz zurück und die Flagge wird wieder grün. 
 

3.2  Dateien-Menü (File Menu Items) 
 

Mit diesem Menü können Sie wählen : 
 

 
 
Drucken (Print) (CTRL-P) : Druckt den Inhalt des RX-Fensters. Der Cursor muss im RX-Fenster 
stehen. 
 
Druckvorausschau (Print Preview): Zeigt eine Vorschau auf die zu druckende Seite 
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Druckeneinstellung (Print Setup): Einstellung der Druckerparameter 
 
Sende Datei (Send File) : Sendet den Inhalt einer ausgewählten Datei. Diese Datei muß ein 
einfacher Text sein ! Die angewählte Datei muß vorher abgespeichert und geschlossen sein. 
  
Sende Bild (Send Picture) : Diese Funktion ist nur in der Sendeart MFSK wirksam. Mit ihr 
können vorbereitete Bilder in schwarz/weiß (B/W) oder in Farbe (Color) gesendet werden.  
 
YAPP : Sende/empfange mit YAPP komprimierte Datei 
 
Run Script:  Eine vorbereitete Kommando+Text-Folge mit der Endung *.scr wird ausgewählt und 
ausgegeben. 
 
Suche im Log (Search in log file) (ALT-R): Sucht im Log nach einer eingebenen 
Zeichenfolge in wählbaren Feldern, z.B. zeigt die Abfrage ‚UA9’ unter ‚Call’ alle UA9-
Stationen 
 
QSO details (ALT-D): Zeigt einen Dialog des aktuellen QSOs im Log zur Ergänzung von Details wie 
Manager und/oder Notizen 
 
QSO entfernen (Remove QSO) (Alt-O): Löscht das ausgewählte QSO im Log 
 
QSO wiederherstellen (Restore removed QSO) : Das letzte gelöschte QSO wird wiederhergestellt 
 
QSO speichern (Save QSO data) (Alt-A): Speichert das aktuelle QSO ab 
 
Call suchen (Lookup call) (Alt-K): Sucht nach früheren QSOs mit dem aktuellen Call im Log  
 
Import ADIF: Importiert ein externes Log im ADIF-Format 
 
Export ADIF: Exportiert die im MixW-Log markierten QSOs im ADIF-Format 
 
Merge: Mischt zwei MixW2-Logs  
 
RX Log: Öffnet oder schließt das Mitschreiben  des RX-Fensters in einer Datei  
 
Sound: Sie können die letzten 20 Sekunden eines Audiosignals am Eingang der Soundkarte als 
WAV-Datei abspeichern. Mit dieser Funktionen können Sie die Eigenschaften ausgewählter Signale 
demonstrieren, Sie abspeichern und später wieder aufrufen. 
 
Verlassen (Exit): Schließt MixW 
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3.3 Optionen-Menü (Options Menu Items) 

 

 
 
AFC   
Die automatische Frequenzsteuerung AFC von MixW sorgt dafür, daß ein Signal genau abgestimmt 
wird. Schalten Sie die AFC nur dann ab, wenn ein starkes Signal in unmittelbarer Nachbarschaft es 
unmöglich macht, das gewünschte Signal zu dekodieren. 
 
Lock  
Mit Lock halten Sie die Sendefrequenz auf der aktuellen Position fest. Sie ist dann fixiert auf den 
aktiven dreieckigen Cursor und die Flagge ist rot. Ist LOCK nicht aktiv, ist die Flagge grün und Sie 
senden auf der aktuellen Empfangsfrequenz. Schalten Sie auf LOCK, wenn Sie selbst CQ rufen, wenn 
die Gegenstation deutlich driftet oder wenn Sie eine Station im Splitbetrieb arbeiten wollen. Andere 
Programme verwenden den Schalter NET. Ist NET eingeschaltet, sind TX- und RX-Frequenz gleich, 
ist NET aus, können TX- und RX-Frequenz voneinander abweichen. 
Tip DM3ML : Wollen Sie die Sendefrequenz im Splitbereich aktivieren, setzen Sie den RX-Cursor 
dorthin, schalten kurz auf Senden und schalten dann LOCK ein. Danach können Sie mit dem 
Empfangscursor wieder auf die DX-Station zurück gehen. 
 
SNAP   
Snap zieht den RX-Cursor in einem schmalen Bereich auf die genaue Abstimmung. Schalten Sie 
Snap wieder ab, wenn eine starke Station die Abstimmung stört. 
 
Squelch   
Mit dem Squelch, einer einstellbaren Schwelle, werden nur Signale über dieser Schwelle dekodiert 
und wiedergegeben. Sie vermeiden damit die Ausgabe falscher Zeichen bei schwachen Signalen oder 
Rauschen. Mit einem rechten Klick ins Spektrum/Wasserfall-Fenster oder das Feld Sq im 
Statusbalken erreichen sie  das Fenster Squelch Threshold  (Schwelleneinstellung). 
Wenn in Ihrem RX-Fenster nichts mitgeschrieben wird, ist mitunter der Squelch eingeschaltet und die 
Schwelle zu hoch eingestellt. Zum Empfang leiser Signale ist es besser, den Squelch ganz 
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auszuschalten. Oft werden dann Zufallszeichen (=garbage) ausgegeben, aber sobald das Signal 
lauter wird, wird es mitgeschrieben.  
 
Squelch Threshold (Schwelle)   
Stellen Sie die Schwelle so hoch ein, daß schwache Signale, Rauschen oder Störungen keine 
Zufallszeichen erzeugen, aber die gewünschte Station mitgeschrieben wird. Mit dem gleichen Fenster 
können Sie auch AFC, LOCK und SNAP ein- oder ausschalten. 
 
 

 
 

RX  Schaltet MixW auf Empfang 
TX  Schaltet MixW auf Senden 
 
Empfang und Senden können mit der Pause/Untbr-Taste der Tastatur,  mit einem Klick auf RX/TX im 
Statusbalken und den Macros <TX> oder <RX> umgeschaltet werden. 
 
Kontinuierliche Suche (Continuous Seek)  
Wenn angewählt wird kontinuierlich nach Stationen gesucht. Wird eine Station gefunden, wird der 
Suchlauf angehalten. Sie können den Suchlauf auch mit einem Druck auf die Seek-Taste anhalten. 
Fällt die Station unter den Suchpegel, bleibt die Abstimmung trotzdem stehen, so daß Sie die Station 
weiter verfolgen können, wenn sie wieder hörbar wird. Um den Suchlauf fortzusetzen, drücken Sie die 
Seek-Taste. (siehe auch Options > Continous Seek und Configure > Arrows for Seek ) 
 
Arrows for Seek (Such-Pfeile) 
Wenn angewählt, können Sie die Suche mit der rechten oder linken Pfeiltaste starten. Die im Ur-MixW 
voreingestellten Tasten F11 and F12 sind dann nicht einsetzbar und können mit anderen Macros 
belegt werden. Ist Arrows for Seek angewählt, können Sie die Pfeiltasten nicht für eine Navigation in 
den Textfenstern verwenden, u.U. müssen Sie dann zu F11 und F12 zurückkehren.  
 
Scan (Suchlauf) 
 

Start Scan  
Mit Start Scan sucht MixW eine Station, stoppt dort, schreibt sie für eine wählbare Zeit (Dwell)  
mit, zeichnet die NF-Frequenz und die Zeit auf und sucht dann die nächste Station und wiederholt 
diesen Prozeß zyklisch. 
 
Stop Scan  
Stop Scan beendet die Suche. Die Suche wird auch angehalten, wenn eine Station im Wasserfall 
mit der Maus angeklickt wird. 
 
Start Scan und Stop Scan werden mit den Macros  <STARTSCAN> and <STOPSCAN> gesteuert, 
die auf F-Tasten Ihrer Wahl gelegt werden können. Siehe auch Macros konfigurieren Configuring 
Macros  
 
Scan properties (Eigenschaften) 
Hier können Sie die Eigenschaften der Abtastung einstellen. Mit Only once (nur einmal)  stoppt 
der Suchlauf beim ersten detektierbaren Signal. Mit Dwell stellen Sie die Zeit, bei der bei einer 
gefundenen verharrt wird und mit Continue on squelch wird angewiesen, dass die Suche weiter 
läuft, wenn das empfangene unter den Squelchpegel absinkt,. Mit einem Haken in den Feldern 
Time Marks oder Frequency Marks wird im empfangenen Text die Zeit- und/oder die Frequenz 
des Signals als Marke eingetragen. 
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Anmerkung DM3ML : Die folgenden Punkte fehlen im Original, wurden aber von mir  ergänzt : 
 
Scheduler : Mit dem Scheduler (Terminplaner) können Sie sich zu einem festen Termin oder 
regelmäßig an einen Termin erinnern lassen. Auf dem Bildschirm erscheint ein Feld mit dem 
programmierten Erinnerungstext (Reminder) oder ein Macro (Macro) wird gestartet. Sie können den 
Scheduler mit dem Feld Disable abschalten. 
 
AutoCQ : Hier legen Sie Text und Wiederholzeit (Delay) für das Aussenden des automatischen CQ-
Rufs fest. Zweckmäßig ist es, eine Macrotaste so zu programmieren : 
 
<ASAUTOCQ><TX> 
CQ CQ de <MYCALL> <MYCALL> <MYCALL>.... 
 
Dann wird der nach <ASAUTOCQ> eingegebene Text als Text für den CQ-Ruf genommen und auf 
automatischen CQ-Ruf geschaltet. Der Auto-CQ wird mit einer beliebigen Eingabe ins TX-Fenster 
oder mit zweimal ESC abgebrochen.  
 
Set Transceiver Freq : Der Transceiver wird auf eine in das Frequenzfenster (CAT bar) eingetragene 
Frequenz gesetzt. 
 
Memory : Es öffnet sich ein Memory-Fenster. Die aktuelle Einstellung des Transceivers wird mit 
Memory Write in die Tabelle eingetragen oder ein bereits vorhandener Eintrag wird mit Memory 
Read zum Transceiver übertragen. Die Tabelle gibt 20 Speicherplätze vor. 
 
Tune Transmitter : Der Transceiver wird auf Senden geschaltet und über die Soundkarte angesteuert 
bis zum Klick auf Stop TX oder Druck auf die ESC-Taste.  
 
Single Click : Ist Single Click angewählt (Haken davor) werden Zeichenketten aus dem RX-Fenster 
schon mit einem einfachen Klick ins Log übernommen. 
 
Clear Call on Fq change : Bei einem Frequenzwechsel wird der aktuelle Logeintrag gelöscht. 
 
Clear QSO on new call : Der aktuelle Logeintrag wird nach Anklicken eines neuen Rufzeichens 
gelöscht und das neue Call eingetragen. 
 
Auto search in logfile : Bei Eingabe eines neuen Rufzeichens wird automatisch im Log nach einem 
früheren QSO gesucht und die Angaben aus diesem QSO ins Log übernommen. 
 
Auto search in callbook : Bei Eingabe eines neuen Rufzeichens wird automatisch imCallbook nach 
dieser Station gesucht und die Angaben ins Log übernommen. 
 
Beep on QSO before : Der PC-Lautsprecher gibt ein Signal ab, wenn man die Station, di schon 
gearbeitet wurde, ins Log eingetragen wird. 
 
Freeze on mouse move : Der RX-Schirm wird eingefroren, wenn die Maus darin bewegt wird. Man 
muß ihn u.U. mit der TAB-Taste wieder „enteisen“. 
 

3.4 Anzeige-Menü (View Menu Items) 
  

Mit View wählen Sie die Fenster an, die unter MixW angezeigt werden sollen und können weitere 
Eigenschaften des Programms auswählen : 
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Steuerbalken (Control Bar)   
Wenn ausgewählt, wird der Steuerbalken angezeigt. Er kann mit gedrückter linker Maustaste an eine 
beliebige freieStelle des Bildschirms gezogen werden. Der übliche Platz ist unter dem 
Spektrumfenster. 
 
Logfenster (Log Bar) 
Enthält ein Menü, mit dem Sie die Anzeige des Logfensters selbst und seine Eigenschaften (normal, 
Contest, eigene Gestaltung (custom), Farben) festlegen können. 
 
CAT-Balken (CAT Bar)   
Der CAT-Balken zeigt – wenn die CAT-Funktion installiert ist – die aktuelle Frequenz eines 
ausgewählten Signals berechnet aus Transceiverskala und NF-Ablage und der am Transceiver 
eingstellten Sendeart bzw. Seitenbandlage (AM, FM, USB, LSB..). Siehe auch Konfiguration 
 
Abstimmanzeige (Tuning Indicator) 
Eine “Windmühle” zeigt die Phasenlage des empfangenen Signals. Ist kein Signal eingerastet, zeigt 
die Windmühle springende Linien mit verschiedenen Farben. Bei einem richtig eingestellten BPSK31-
Signal erscheinen zwei grüne Linien bei 0 und 180° als senkrechter Strich, bei einem QPSK-Signal 
sind vier Linien bei 0, 90, 180 und 270° als Kreuz zu sehen und bei einem FSK31-Signal zwei 
waagerechte Linien bei 90 und 270° . 
 
Weltkarte (World Map) 
Eine Weltkarte mit Ihrem Standort als gelber Punkt (konfiguriert unter Personal Data)  erscheint. Steht 
eine Station im Log, wird die Richtung zu ihr als weißer Strich und als Gradzahl in der Karte angezeigt. 
Ist der Rotor konfiguriert, wird auch noch die aktuelle Richtung Ihrer Antenne ausgegeben und Sie 
können die Antenne mit MixW drehen. 
 
DX Cluster 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 51 von 155 Übersetzung von Eike,DM3ML 

Das DX-Cluster-Fenster wird angezeigt. Sehen Sie unter DX-Cluster (DX Cluster)nach, wie Sie eine 
Verbindung zu einem Packet- oder Internet-DX-Cluster herstellen können. 
 
Callbuch (Callbook dialog) 
Sie können Einträge im Callbook nachsehen. 
Hinweis : Sie müssen vorher mit Configure > Callbook den Zugriff zu einem Callbook nach Typ und 
Pfad  konfiguriert habe.  
 
Statusbalken (Status Bar)   
Der  Statusbalken wird angezeigt.  
Hinweis : ein  rechter Klick in den Statusbalken öffnet ein weiteres Menü.  
 

DX Cluster 
 

Statistics 
Statistische Angaben (gearbeitetete Stationen, Länder, Multis) sind vor allem für den Contestbetrieb 
mit MixW interessant. Siehe  Contestbetrieb (Contest Operation) 
 
Schnelle Suche (Quick search) 
Mit Quick Search können Sie ein inkomplettes Rufzeichen ergänzen. 
Wählen Sie  View >| Quick search > Show dialog und dann die Suchmethode aus. Sie können 
„Wildcards“ - hier * und ? - als Platzhalter einsetzen. Geben Sie dann ein Rufzeichen in das 
Logfenster ein. In der Suchtabelle erscheinen Rufzeichen, die mit einem Teil oder den ganzen 
Rufzeichen übereinstimmen. Ein roter Haken markiert Stationen, die schon im Log stehen als DUPE 
(schon gearbeitet). 
 
NCDXF/IARU Beacons (Baken) 
Ein Fenster mit der Anzeige der aktuellen Baken öffnet sich. Wenn Sie die CAT-Steuerung installiert 
haben und auf eine Frequenz klicken, schaltet Ihr Transceiver auf CW und die ausgewählte Frequenz.  
Ihre Rechnerzeit muß sekundengenau eingestellt sein, um die Bake richtig zu treffen. 
  
Scanner 
In der sich öffnenden Tabelle können Sie Frequenzen oder Frequenzbereiche eintragen, die 
durchsucht werden sollen. Die Abtastung wird mit Macros gestartet und beendet. 
 
Contest mode 
Mit dieser Wahl kommen Sie zum Contestdialog, mit dem Sie Conteste auswähllen und editieren 
können. Siehe Contestbetrieb (Contest Operation) 
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Spectrum 
Sie können zwischen Wasserfall oder Spektrum wählen und Farben, Zoom und HF-Marken festlegen. 
Diese können durch einen Klick mit der rechten Maustaste ins Spektrum geändert werden. 
Mit einem Platzhalter – Bookmark (Buchzeichen) genannt – können Sie ausgewählte Signale im 
Spektrum oder Wasserfall markieren. Klicken Sie mit der rechten Maustaste auf das Signal und dann 
auf Toggle Bookmark im sich öffnenden Menü. Unter dem Diamant-Cursor erscheint ein Feld mit 
einem Buchstaben. Sie können das Buchzeichen auf gleiche Weise wieder entfernen. Haben Sie das 
Rufzeichen der Station bereits ins Log übernommen, wird das Signal mit dem Rufzeichen der Station 
markiert. Diese Übernahme erfolgt, wenn Sie im empfangenen Text auf das Rufzeichen der Station 
klicken. Wenn Sie auf ein Buchzeichen klicken, kehren Sie zur Frequenz dieser Station zurück oder 
Sie sehen das volle Rufzeichen im Buchzeichen, wenn Sie wieder auf diese Frequenz abstimmen. 
 
 

 
 

 
Advanced Waterfall 
Wenn Sie einen Haken vor den “fortgeschrittenen Wasserfall” machen, werden dann, wenn Sie an der 
Transceiverabstimmung drehen, alle Signale der Abstimmung nachgeführt und nicht, wie bisher über 
die Skala „geschmiert“. Sie müssen über eine installierte CAT-Steuerung und einen schnellen 
Computer verfügen, wenn dieses Nachführen funktionieren soll. 
 
Gesendeten TX-Text unterstreichen (Underline sent text)   
Wenn sie diese Einstellung wählen, wird der gesendete Text im TX-Fenster unterstrichen. Der 
gesendete Text wird parallel dazu im RX-Fenster in einer mit Configure > TX font color  wählbaren 
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Farbe ausgegeben. Wenn der Text im TX-Fenster unterstrichen wird, haben Sie beim Editieren einen 
Anhalt, welcher Text noch nicht ausgesendet worden ist. 
. 
 
Wortmodus (Word mode) 
Im Wortmodus wird ein Wort erst dann ausgesendet, wenn ein Zwischenraum oder ein Satzzeichen 
erkannt wird. Sie können ein fehlerhaft eingegebenes Wort mit der Rück(Backspace)-Taste korrigieren 
ehe es ausgesendet wird. Zweckmäßig ist diese Einstellung vor allem bei RTTY und AMTOR, die 
keinen Rückschritt (backspace) zur Korrektur auf dem Bildschirm der Gegenstation senden können. 
Hinweis : Der Wortmodus ist nur anwendbar, wenn mit unterstrichenem TX-Text  (underline sent 
text) gearbeitet wird. Zusätzlich muß man bei Macros u.U. ein zusätzliches Leerzeichen anfügen, 
damit sie im Sendepuffer richtig gesendet werden. 
 
Nur Großbuchstaben (CAPITALS ONLY) 
CAPITALS ONLY kodiert allle Kleinbuchstaben, die im Sendefenster eingegeben werden,  in 
Großbuchstaben um. Diese Einstellung ist bei RTTY und AMTOR zweckmäßig, da diese Sendearten 
nur Großbuchstaben senden. 
 
Durchgestrichene Null anzeigen (Display Slashed Zero) 
Die Null wird zur Unterscheidung gegen den Buchstaben O durchgestrichen ausgegeben. 
 
UTC  
Wird UTC angewählt, wird am rechten Ende des Statusbalkens die Zeitangabe auf UTC geschaltet. 
Ohne angewählte UTC wird hier die lokale Zeit angezeigt. Wollen Sie immer UTC ohne 
Berücksichtigung der Sommerzeit anzeigen, müssen Sie Ihren Computer unter Windows auf UTC 
(Casablanca, Monrovia) stellen. 
 
Blinkendes TX (Flashing 'TX')   
Falls freigegeben, blinkt das Fenster mit TX im Statusbalken. Ohne Freigabe wird TX stationär 
angezeigt. 
 
Strichkursor (Use Stick Cursor) 
Der Mauszeiger im Wasserfall wird zum senkrechten Strich, mit dem Sie u.U. ein Signal besser in der 
Mitte treffen können. 
Tip DM3ML : vor allem bei PSK31 und MFSK16 sehr zweckmäßig ! 
 
Haarlinien anzeigen (Show hairlines) 
Mit den Haarlinien von der Abstimmanzeige hinunter zum Wasserfall können u.U. besser abstimmen. 
 
Zeige immer das IMD an (Always show IMD)  
Die Signalqualität der Gegenstation, repräsentiert durch den Intermodulationsabstand (Inter 
Modulation Distance) wird während der Leerlaufpausen (idle) der Gegenstation bei PSK31 gemessen 
und im Statusbalken angezeigt, wenn angewählt. 
 
Voreingestelltes RST verwenden (Use Default RST) 
Wenn angewählt, werden Sie nicht nach der RST-Vorgabe gefragt, sondern die Gegenstation 
bekommt unbesehen 599 mit dem RST-Macro. Zweckmäßig in Contesten, beim normalen QSOs 
besser ausschalten. 
 
Fenster für den 2.TNC (2nd TNC window) 
Angewählt wird das Eingabefenster für den 2.TNC angezeigt. Als 2.TNC wird ein Packet-TNC z.B. für 
das DXCluster benötigt. Siehe auch TNC-Konfiguration und Betrieb (TNC Configuration and 
Operation) 
 
Telnet-Fenster(Telnet window):  
Mit diesem Fenster können Sie bei bestehender Internetverbindung eine Telnet-Sitzung aufbauen : 
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Neues RX-Fenster (New RX window) 
Ein zweites RX-Fenster mit der gleichen Frequenz wie das aktuell im Wasserfall angewählte Signal 
wird geöffnet. 
  
  

3.5 Konfigurations-Menü (Configure Menu) 
 
siehe Konfiguration (Configuration) 

3.6 Statusbalken (Using the Status Bar) 
  

Der Statusbalken befindet sich unten im MixW-Schirm. Die dargestellte Information hängt von der 
gewählten Sendeart ab. IMD z.B. gibt es nur bei PSK31, während Connected oder Disconnected nur 
für Packet relevant sind. 
 
TX/RX: Das am weitesten linke Feld zeigt mit TX oder RX an, in welchem Zustand sich MixW befindet. 
Die Sende-Empfangsschaltung kann durch Anklicken des Feldes mit der linken Maustaste gesteuert 
werden. 
 
Der Squelch (Sq) kann durch einen Klick an- oder ausgeschaltet werden. Mit einem Klick der rechten 
Maustaste in den Statusbalken kann mit Squelch Threshold im Menü die Schwelle des Squelchs 
eingestellen : 
 
 

 
 

Wenn Sie auf Squelch Threshold klicken, öffnet sich ein weiteres Fenster : 
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Zusätzlich zur Schwelle können Sie hier die AFC und die Snap-Funktion freigeben oder sperren. Die 
gleiche Funktion lösen Sie aus, wenn Sie im Statusbalken auf AFC oder Snap klicken. 
 
AFC, Lock, and Snap: Schalten Sie diese Funktionen mit einem Klick auf das Feld im Statusbalken 
EIN oder AUS: 
 
Frequenz (Frequency): Hier wird die aktuelle NF-Frequenz angezeigt. Sie ist identisch mit dem 
Offset gegenüber der am Transceiver eingestellten HF-Frequenz. 
  
IMD: Ein Klick auf IMD friert die Anzeige auf den letzten Wert ein. Mit einem weiteren Klick läuft die 
IMD-Anzeige wieder mit. Falls MixW die IMD-Anzeige nicht verändert, ist möglicherweise die 
Squelchschwelle zu hoch eingestellt. Schalten Sie den Squelch bei leisen Signalen am besten ab. Sie 
erhalten zwar eine Menge an Fehlausschriften (garbage), aber mit etwas Phantasie können Sie auch 
leise Stationen identifizieren und mitlesen. 
Der IMD-Wert gibt in dB den Pegel des ersten unerwünschten Seitenband (bei +/-46Hz von der 
Mittenfrequenz) im Verhältnis zum Hauptsignal (bei +/-15Hz) aus. Die Anzeige ist nur dann relevant, 
wenn die Gegenstation leerläuft (idle), d.h. keinen Text sendet. Zu dieser Zeit entspricht die 
Signalform dem 2-Tone-Test bei SSB-Sendern und IMD gibt die Intermodulation dritter Ordnung an.  
Um verläßliche Angaben zu erhalten, sollte die Gegenstation ein S/N von besser als 20 dB haben und 
keine starke Station in der Nähe sein. Typische gute IMD-Anzeigen liegen zwischen -25 und -30 dB. 
IMD-Werte gleich oder größer als -20 dB zeigen ein schlechtes Signal und sind typisch für einen 
breiten „Lattenzaun“, der Nachbarstationen empfindlich stören kann. 
Wollen Sie einer Station einen genauen IMD-Rapport geben, klicken Sie während diese keinen Text 
sendet (keine Sprossen in der Leiter), auf IMD im Statusbalken und diese Anzeige wird festgehalten. 
 
Mode: Die aktuelle Sendeart wird angezeigt. Mit einem Klick auf dieses Feld holen Sie das 
Betriebsartenmenü.  
 
Date: Zeigt das aktuelle Datum 
 
Time: Zeigt die aktuelle Zeit. Mit einem rechten Klick können Sie zwischen lokaler Zeit und UTC 
umschalten. 
 

3.7 Logbuch und QSLs (Logging and QSLing) 
 

3.7.1 Überblick  
 
Mit MixW's Log können Sie problemlos alle QSO abspeichern und verwalten. Im Contestmodus haben 
Sie eine Übersicht über Multis und Doppel-QSOs (DUPE), erhöhen die laufende Nummer und können 
Calls und Nummern aus den QSO-Mitschriften automatisch übernehmen  Im Normal-Modus werden 
Ihre QSOs verwaltet und die Diplomübersichten kontrolliert. 
Sie können zwischen einem normalen Log, einem Contestlog und speziellen Logansichten (Custom 
layout 1 und 2) mit View > Log bar hin- und herschalten.  
 
Der Logbalken unter dem jüngsten QSO steuert verschiedene Funktionen : 
 

 

 
 

Mit Suche (Search) können Sie im Log nach einem Rufzeichen suchen. Details öffnet eine volle Liste 
der Loginformationen, mit der Sie das ausgewählte QSO ergänzen können. Löschen (Delete) löscht 
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das ausgewählte QSO und Abspeichern (Save) speichert das neue QSO im Log ab und macht die 
Zeile wieder frei. 
 
Die Breite der Logspalten ist konfigurierbar.Setzen Sie den Cursor auf die Trennlinie in der 
Spaltenüberschrift bis er sich in einen Doppelpfeil ändert, klicken Sie auf die linke Maustaste und 
ziehen  Sie die Linie auf die gewünschte Breite. 
 

 
 
 
Die Normal- und die Contest-Ansicht zeigen eine ausgewählten Satz von Feldern. In den Ansichten he 
Custom 1 und Custom 2 Layouts sind alle möglichen Felder vorhanden. Wenn Sie in der Custom-
Ansicht alle Felder sehen wollen, müssen Sie einige Felder auf der linken Seite verstecken, dami Sie 
die Felder auf der rechten Seite sehen können. Sie verstecklen ein Feld, in dem Sie die Trennlinie 
nach rechts ziehen und die Feldgröße auf Null ziehen.  

3.7.2 Einträge ins Log (Making entries in the log)  
 
Um einen Eintrag in ein Logfeld zu machen, klicken Sie das zugehörige Feld links an.  
Ein Call kann direkt in das Log eingetragen oder mit einem Doppelklick aus dem Empfangsfenster 
übernommen werden. 
Bei einer Runde kann zweites, drittes usw. Call dem Logfenster hinzugefügt werden, indem das Call 
markiert und dann mit einem Rechtsklick Add call gewählt wird. Alle Macros, die CALL> verwenden, 
übernehmen ebenfalls zusätzlich das Rufzeichen. Das RST wird, wenn es als 3-Ziffern-Wort erkannt 
wird, beim Anklicken im empfangenen Text ins Log übernommen. 
Wenn Sie die Strg(CTRL) beim Doppelklick gedrückt halten, wird ein Wort als QTH übernommen. 
Wenn Sie die Shift-Taste drücken und nacheinander auf mehrere Worte drücken, wird ein aus 
mehreren Worten bestehendes QTH ins Log übernommen. 
Zusätzlich können Sie alle Daten im RX-Schirm markieren und mit der Maus bei gedrückter linker 
Taste in ein Feld des Logs ziehen und z.B. den Locator unter Notes ablegen. Sie können auch eine 
Zeichenkette im empfangenen Text markieren, dann mit der rechten Maustaste daraufklicken und sie 
kopieren oder in einem Fach ablegen : 
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Wenn die gewünschten Fenster des Logs gefüllt sind, drücken Sie auf Save, um die Daten 
abzuspeichern. Mit der Such-Taste (Search) können Sie nach einem beliebigen Rufzeichen suchen, 
aber auch Teile eines Rufzeichens eingeben und danach suchen. Mit Display Whole Log (Anzeige 
des geamten Logs) wird das ganze Log ausgegeben. 
 
Wenn Sie das Macro  <SAVEQSO> in die letzte Verabschiedung einbauen, wird das QSO 
automatisch gespeichert. Siehe Macro-Kommandos (Macro Commands) 
Hinweis: Wenn Sie im RX-Fenster ein neues Rufzeichen anklicken, wird es in das Logfenster unter 
„neues QSO“ übernommen und alle bisherigen Einträge dort werden gelöscht. Wollen Sie dieses 
Überschreiben verhindern, um nicht ungewünscht QSO-Daten zu verlieren, müssen Sie Options  > 
Clear QSO on new call abschalten. Sie können ein vorher gelöschtes QSO mit File  > Restore 
removed QSO wiederherstellen. 
 

3.7.3 Logdaten drucken und exportieren (Printing and Exporting your log 
file) 

 

Um ein Log oder einen Teil davon auszudrucken klicken Sie auf Suche (Search) oder   
 

 
 

Sie können mit diesem Menü wählen, was Sie von dem Log geordnet nach Band, Datum, Sendeart 
u.a. Kriterien angezeigt haben wollen.  Wenn Sie das ganze Log ansehen wollen, klicken Sie auf  
Ganzes Log (Whole Log).  
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Markieren Sie die Einträge, die Sie drucken wollen, mit der linken Maustaste. Bei größeren Bereichen 
drücken Sie gleichzeitig die SHIFT-Taste und markieren Anfang und Ende des Bereichs. Wollen Sie 
mehrere nicht zusammenhängende QSOs markieren, drücken Sie die Strg (CTRL)-Taste. Danach 
wählen Sie To Text. Sie können die Felder des Logs vorgeben, die anschließend in eine Notepad-
Datei ihrer Wahl mit der Endung *.txt ausgegeben werden. MixW schlägt Ihnen ‚export.txt’ vor, diesen 
Namen können Sie ändern. Die ausgegebene Datei können Sie mit beliebigen 
Textverarbeitungsprogrammen ansehen, editieren oder ausdrucken. 
Wollen Sie das Log oder ein Teil des Logs exportieren, klicken Sie auf die Taste to ADIF und 
importieren dieses *.adi-File in ein anderes Log- oder Contestprogramm. Möglich ist die Ausgabe in 
ein Cabrillo-Log mit to Cabrillo, das als elektronisches Log für ARRL-und andere Conteste benötigt 
wird. 
Beim ADIF-Export werden Sie nach einem Namen gefragt. Beim Export eines Cabrillo-Logs öffnet sich 
ein Fenster, in das Sie die Standardangaben für den Kopf eines Cabrillo-Logs eintragen müssen : 
(Tip DM3ML : Sind Sie nicht in den USA,  tragen Sie als ARRL-Section DX ein und lassen Club frei))  
Hinweis: Sie können Logs auch im kommagetrennten CSV-Format (entspricht etwa dBase) und als 
Text abspeichern. Sehen Sie im Dialog zu den Suchergebnissen (Search Results) nach. 

3.7.4 eQSL abschicken (Sending an eQSL card) 
 
Sie müssen bei eQSL (www.eqsl.cc) registriert sein und ein gültiges Passwort haben. Der Computer 
muss online im Internet sein, er muss aber nicht bei eQSL eingeloggt sein. Wählen Sie den Logeintrag 
im Logfenster aus, für den Sie eine eQSL schicken wollen, und klicken Sie auf die Taste QSO-Details 

 oder klicken Sie im Fenster der Suchergebnisse auf Edit. Ändern – falls nötig – den Eintrag und 
klicken Sie dann auf die Taste Send eQSL . Sie werden nach Ihrem Passwort gefragt, das 
QSO wird an eQSL geschickt und ein Statusfenster quittiert den erfolgreichen Versand. Markieren Sie 
anschliessend noch das Feld eQSL sent  bevor Sie das Edit-Fenster wieder schliessen. 
Sie können eQSLs auch verschicken, wenn Sie den Logauszug als ADIF-Datei ausgeben und 
getrennt an eQSL schicken. 
 

3.7.5 QSL erzeugen, drucken oder als Email verschicken (Using the MixW 
program to create a QSL card to print or to email) 

 
MixW stellt einen DDE-Pfad (dynamic data exchange) zu MS-Word und –Excel bereit. Mit diesen 
Daten können DDE-Felder in ein Programm zum QSL-Kartendruck eingefügt werden. Informieren Sie 
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sich in den Helpfiles des MS-Programme über die Verwendung von DDE-Feldern. Die folgende 
Tabelle zeigt die DDE-Felder, die von MixW unterstützt werden : 
 
 

Entity Server Name Topic Item Current state  

Your call MixW Info MyCall K4SET 

Your name MixW Info MyName Scott 

Your QTH MixW Info MyQth Murray, KY 

Program name MixW Info Program MixW 

MixW version MixW Info Version 2.0 beta 21 

QSO date MixW QSO Date 28-Jan-2001 

QSO time MixW QSO Time 20:57 

Frequency, MHz MixW QSO Mhz 14.1 

Mode MixW QSO Mode BPSK31 

Call MixW QSO Call W8HAT 

Name MixW QSO Name RICHARD 

QTH MixW QSO Qth STEVENSVILLE MI 

RST sent MixW QSO RstSnt 589 

RST received MixW QSO RstRcv 589 

Notes MixW QSO Notes Likes to fish 

QSO is unsaved MixW QSO Changed NO 

QSO freq. MixW QSO Khz 14070 

Zero beat freq, kHz MixW CAT Khz 14070.000 

PTT state MixW CAT PTT OFF 
 
 
Wollen Sie diese Felder in einem QSL-Druck einfügen, müssen Sie den angegebenen Feld-Code in 
das vorbereitete Dokument einfügen. Unter MS-Word 2000 fügen Sie ein DDE-Feld mit Ctrl-F9 ein, in 
das Sie dann den Feld-Code eintragen. Mit ALT-F9 sehen sie dann das Resultat. 
Aus der Tabelle können Sie z.B. Ihr Call (your call)  mit der Feldbezeichnung  
 
{DDEAuto "MixW" "Info" "MyCall"  \* MERGEFORMAT} 
 
 in der Word-Anwendung einsetzen. Mit ein wenig Phantasie erstellen Sie die Druckvorlage für Ihre 
QSL-Karte 
 
Nachfolgend wird beschrieben, wie Sie eine QSL-Karte mit MixW unter MS Word 2000 erzeugen 
können : 
 

• Schritt 1 : Öffnen Sie einen Eintrag, für den Sie eine QSL-Karte erzeugen wollen. Gehen Sie 
entweder direkt ins MixW-Log oder verwenden Sie erst die Suchfunktion und wählen dann das 
Edit QSO-Fenster. 

 
• Schritt 2 : Stellen Sie sicher, daß das QSO alle benötigten Angaben enthält. Lassen Sie das 

Fenster während der nächsten Schritte geöffnet. 
 

• Schritt 3 : Rufen Sie die QSL-Kartenvorlage unter MixW QSL card test.doc im MixW-
Verzeichnis unter WORD auf. Editieren Sie die Vorlage und speichern sie unter einem 
eigenen Namen ab. 
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• Schritt 4 : Starten Sie die Druckfunktion von MS Word und drucken Sie eine QSL auf dem 
Farbdrucker. 

 
 
In den folgenden Schritten wird beschrieben, wie Sie eine grafisch gestaltete QSL an eine Email 
anhängen können :  
 

• Schritt 1 : Wiederholen Sie die Schritte 1, 2 and 3 wie oben bei Erzeugung einer QSL mit 
WORD 

 
• Schritt 2 : Wählen Sie die ausgewählte QSL mit Edit > Select All im Werkzeugbalken (Tool 

bar) ,. 
 

• Schritt 3 : Kopieren Sie die QSL mit Edit > Copy aus dem Werkzeugbalken in die 
Zwischenablage 

 
• Schritt 4 : Öffnen Sie Ihren Grafikeditor (z.B. Paint Shop Pro) und wählen Sie Einfügen 

(Paste) zur Übernahme aus der Zwischenablage in ein Neues Bild (New Image). (Tip : Paint 
shop Pro 4.0 gibt es noch als Shareware im Internet.)  

 
• Schritt 5 : Speichern (Save) Sie die QSL-Karte als *.gif-Datei mit File > Save as > 

CompuServe GIF file in einem Verzeichnis, aus dem Sie es als Anhang für eine 
abzusendende Email holen können. 

 
Informieren Sie sich unter MixW mit anderen Programmen koppeln (Using MixW with other Programs) 
wie Sie MixW über die DDE-Funktionen mit anderen Progranmmen koppeln können. 
 

3.7.6 QSL-Druckprogramm 
 
(Ergänzung von DM3ML) 
 
MixW ist um ein leistungsfähiges Druckprogramm für QSL-Karten und Labels ergänzt worden. Es ist 
offensichtlich noch „in Entwicklung“ und in der MixW-Hilfe nicht enthalten, aber zu ersten Tests 
folgende Anmerkungen : 
 
Klicken Sie auf die Taste  im Logfeld.  Wählen Sie unter Search Log die gewünschten Einträge 
aus, hier z.B. die letzten QSOs aus dem kompletten Log (Whole Log): 
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Markieren Sie innerhalb des Logs die Zeilen, für die Sie Labels drucken wollen, hier ab 26.3.2003. 
Klicken Sie mit der rechten Maustaste in das Feld. Es erscheint dieses Menü : 
 

 
 
Klicken Sie auf Print QSL. Die ausgewählten QSOs werden im MixW-Unterverzeichnis Print queue in 
einer Druckerschlange unter der Extension *.qpq abgelegt.  
 
Starten Sie dann das Programm aus dem MixW-Verzeichnis mit dem Explorer  
oder belegen Sie eine Macro-Taste mit <EXEC:qslprint.exe>. Wählen Sie innerhalb dieses 
Programms die Druckfunktion. Sie erhalten, falls Sie die Vorlage bereits erstellt haben, diesen 
Ausdruck : 
 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 62 von 155 Übersetzung von Eike,DM3ML 

 
 
Die benötigte Vorlagen, hier ein A4-Blatt mit 3x8 Labels, können Sie mit der Taste Label (zweite Taste 
von rechts) rufen und mit den Werkzeugen von QSLprint.exe bearbeiten. Es sind alle logbezogenen 
Macros von MixW2 zusammen mit Rechtecken, Kreisen, Text (Taste T)  und Grafikelementen (Taste 
mit Haussymbol)  verwendbar. Meine Vorlage DM3ML 3x8qsl sieht so aus :  
 

 
 
Verschiebt man ein Element auf einem Label, wird die Verschiebung auf allen Labels paralell 
ausgeführt. Vor der Textgestaltung muß man dem Programm die mechanischen Abmessungen des 
Blattes mitteilen und mehrere Versuchsblätter drucken. Die Ergebnisse sind aber schnell befriedigend. 
Sie können auch das Format QSL (dritte Taste von rechts wählen) und - nachdem Sie sich vorher 
eine QSL entworfen haben – eine fertige bunte QSL drucken : 
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Mein Eindruck : So perfekt wie das Labelprogramm BV6/7 von DF3CB funktioniert der MixW-QSL-
Druck noch nicht, aber vor allem dann, wenn man gleich nach einem QSO eine QSL drucken will, 
lohnt es sich. 
 

4. Verschiedenes (Appendices) 

4.1 Contestbetrieb (Contest Operation) 
 
MixW Version 2 bietet eine umfangreiche Unterstützung für den Contestbetrieb einschließlich von 
Macros und Logführung. MixW kann für verschiedene Conteste individuell konfiguriert werden. Die 
Contesteinstellungen werden abgespeichert und sind auch in der Zukunft zu nutzen. 
 
Die Liste der schon konfigurierten Conteste ist unter View > Contest Mode zu finden. Sie können 
einen Contest editieren, löschen oder neu hinzufügen. Die Taste Select macht setzt einen Contest auf 
aktiv. Auf der Webseite von UT2UZ finden Sie spezifische DLLs für verschiedene Conteste. Sie 
werden im Verzeichnis Plugins abgelegt und übernehmen die Berechnung der Statistik und der 
Punktzahl anhand der Contestregeln und bereiten das elektronische Log vor. 
 
Der Contestmodus wird unter View > Contest Mode menu eingestellt. Im Contestmodus wird das 
Log so umgestellt, daß die empfangene und gesendete Seriennummer anstelle von Name und QTH 
angezeigt wird. Diese Umstellung müssen Sie getrennt mit  View > Log bar > Contest layout 
vornehmen. 
 
Im Contestmodus wird eine Doppelprüfung nur für den aktuellen Contest vorgenommen. 
 
MixWs Contestmodus konfigurieren  
 
Wählen Sie View > Contest Mode:  
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Dieses Fenster öffnet sich :  
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Klicken Sie den gewählten Contest an und klicken dann auf die Select – Taste. Mit Add new  fügen 
Sie einen neuen Contest hinzu, mit Edit können Sie einen schon angelegten Contest auf das aktuelle 
Datum einstellen. 
 
Im Edit-Fenster sehen Sie :  
 

 
 

Mit diesen Einträgen konfigurieren Sie einen Contest, speichern die Daten ab und können Sie wieder 
verwenden. 
 
Name – Name des Contest, erscheint im Log von MixW in der Kopfzeile 
 
Your call – Ihr Contest-Call, alle QSOs in Contest werden unter diesem Rufzeichen geloggt 
 
NRS  – ist die Serienummer oder ein fester Wert, der zusätzlich zum RST gesendet wird. Falls Autonlc 
gesetzt ist, wird die Seriennummer mit jedem QSO automatisch erhöht. 
 
Hinweis : Wenn Sie Autonlc setzen, wird das Nummernfeld grau und ein Eintrag ist nicht möglich. 
Tragen Sie dann die Seriennummer, mit der Sie starten wollen, im Log unter Exch_Sent ein. Sie wird 
dann automatisch erhöht. 
 
Start – Anfangszeit des Contests 
End – Endzeit des Contests  
 
Hinweis : Die Zeiten sollten richtig eingetragen werden, da sie für die Doppelkontrolle benötigt 
werden. 
 
Wenn AutoInc auf Ein steht, erhöht MixW automatisch die Nummer im Feld ExchSnt gegenüber dem 
QSO vorher. Findet MixW keine Nummer, z.B. beim Conteststart fängt es mit 001 an. 
 
Wenn AutoInc auf Aus steht, wird der Eintrag in  ExchSnt vom vorigen QSO kopiert. Der Eintrag in 
das Feld NR sent im Edit-Dialog wird am Beginn des Contests genommen. 
Die ExchSnt für das laufende QSO kann durch einen Eintrag in das Logfeld geändert werden. 
 
Auto Grab – mit Auto Grab werden automatisch die Seriennummer, die Zeit (z.B. beim BARTG) oder 
Provinzkenner/Zonen/Kantone aus dem RX-Fenster ins das Log übernommen, wenn sie im Contest-
Edit-Dialog angewählt wurden. 
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Wenn z.B. Auto Grab für die Seriennummer angekreuzt ist, prüft MixW im Text nach Nummernfolgen 
und übernimmt sie ins Fenster ExchRcv (exchange received) des laufenden QSOs. 
Tip DM3ML : Aufpassen, ob die richtige Nummer übernommen wurde !! Mitunter steht schon die 
Nummer vom vorigen QSO im Feld oder eine falsche Nummer wurde übernommen. 
 
Wenn MixW nach der Zeit (Time) sehen soll, werden Ziffernfolgen wie 2317 oder 23:17 oder 2317z 
oder 23:17z, in das Feld Notes übernommen. Die Übernahme erfolgt nur, wenn Sie nahe der UTC-Zeit 
des eigenen Computers liegen. 
 
Soll MixW nach sog. Domains sehen (Provinzkürzel u.ä.), sollte eine passende Datei mit der 
Erweiterung *.dom nach Plugins geladen sein. Die Datei  RUSSIAN.DOM  enthält z.B. eine Liste der 
russischen Oblasts, die automatisch erkannt und gespeichert werden : 
 
------------- start of file ------------- 
Ab = AB 
Ad = AD 
Al = AL 
..... 
(102 lines with oblast definitions) 
------------- end of file ------------- 
 
Beim Contest werden die Seriennummer und der Oblasts ins Log übernommen. Die DOM-Dateien 
haben das gleiche Format wie bei der N6TR-Software. Jede Zeile hat einen linken Teil, ein 
Gleichheitszeichen und einen rechten Teil. Der linke Teil enthält den Domain-Namen, der rechte 
enthält eine Liste von Zeichenketten, nach denen zu suchen ist : 
 
Beispiel : 
 
Ab = AB 
Cd = EF, GH 
Ij = JKL, MNO, PQ, R 
 
Eine DOM-Datei können Sie selbst aufbauen, wenn Sie die Contestregeln auswerten. 
 
Statistik  
Laden Sie die zum Contest passende DLL herunter von folgenden Seiten : 
Nick's Site http://www.mixw.net 
Scrollen Sie sich zum Contestbereich von Nick's Seite zur Liste der DLLs  durch. Sie werden meist vor 
den großen Contestens ergänzt. Sie finden u.a. die Statistik-DLLs  

• für den CQ WW Contest :  StatsCQWW.zip 
• für den TARA-RTTY-Contest : StatsTaraRttySprint1.zip 
• für den ARRL RTTY Round-Up Contest : StatsRttyRoundup1.zip 
• für den BARTG RTTY Sprint Contest : StatsBartgRttySprint1.zip 

 
 
Jim Jaffe unterhält ebenfalls eine Sammlung von Contest-DLLs, die Sie finden unter :   
http://www.nvbb.net/~jaffejim/mixwpage.htm 
 
Wenn Sie die Dateien geholt haben, entpacken Sie sie ins Verzeichnis Plugins von MixW. Aktivieren 
Sie sie dann im Contest-Dialog im Feld Domains listed in. 
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Es erscheint der Dialog: 
 

 
 

Markieren Sie das passende DLL und klicken Sie dann auf Select. Auch Contesteinstellungen können 
bei manchen Contesten per Menü übernommen werden. 
 
Klicken Sie auf View > Statistics > Show contest statistics, wenn die DDL installiert ist : 
 

 
 

Hier können Sie Ihren Contest-Fortschritt verfolgen. Mit View > Statistics > Brief log statistics 
erhalten Sie eine ausführlichere Statistik : 
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Konfiguration der Contest-Macros  
 
Macros – enthält den Dateinamen der Macros für diesen Contest 
 
Merge Macros – ist diese Möglichkeit nicht gesetzt, werden nur die Macros des für den Contest 
angelegten Macrosatzes genommen. Ist Merge gesetzt, werden die voreingestellten (default), die 
Sendeart bezogenen (this mode) und die Contest-Macros gemischt. 
  
Notes : Notizen zum Contest  
 
Zum Erzeugen der Macros gelten folgende contestbezogene Schlüsselwörter :  
 
<NRS> - sendet die laufende Nummer  
<NRR> - enthält die empfangene Nummer  
<CTIME> - Contestzeit z.B. für den BARTG-Contest wie "2317" (Stunden+Minuten) 
<ONQSOBEFORE:macro> - sendet das Macro <macro>, wenn die Station schon gearbeitet wurde 
 
Es folgen ein paar nützliche Contest-Macros : 
 
Ruft Sie eine Station an, die Sie schon gearbeitet haben, wird Sie aus dem aktuellen Log gestrichen, 
auf RX geschaltet und TX-Fenster gelöscht : 
 

Macro: F9  
Label: QSOb4  
Text: QSO before!<CLEARQSO><RXANDCLEAR> 

 
<ONQSOBEFORE:macro> kann auch zur Automatisierung genutzt werden : 
 
Ohne Automatisierung :  

Macro: F5  
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Label: Answer  
Text: <TX><CALL> de <MYCALL> 599 <NRS> <NRS> <RXANDCLEAR> 
 
Die andere Station sieht : " AB1CDE de UU9JDR 599 001 001 ". 

 
Mit Automatisierung :  

Macro: F5  
Label: Answer  
Text: <TX><CALL> de <MYCALL> <ONQSOBEFORE:F9> 599 <NRS> <NRS>  

<RXANDCLEAR> 
 
In diesem Fall wird nur  
 
AB1CDE de UU9JDR QSO before! 
 
gesendet. Der Rest wird  mit <RXANDCLEAR> vom Schirm gelöscht. 
Natürlich muß das Call der Gegenstation schon im Log stehen. 
 
Sie können Macros für einen speziellen Contest erzeugen, sollten aber erst die bestehenden Macros 
sicher abspeichern (es könnte Ihnen leid tun..). Wählen Sie dann Configure > Edit Macros for this 
mode/group. Laden Sie in diese Box mit Load eine mit MixW mitgelieferte Datei z.B. contest.mc :  
 

 
 

Wenn Sie eine Zeile ändern wollen, klicken Sie mit der linken Maustaste doppelt in die gewünschte 
Zeile. Das Edit-Fenster öffnet sich und Sie können die Zeile Ihren Wünschen anpassen. Speichern Sie 
anschließend die Datei am besten unter einem neuen contestspezifischen Namen ab. 
Siehe auch Macro-Kommandos (Macro Commands) 
 
Nachstehend als Beispiel ein Macro-Satz für den CCCC-Contest : 
 
CQ:  
<CLEAR><TX>CQ CQ CCC Test  
CQ CQ Test de <MYCALL> <MYCALL> k<CR><LF><RX> 
 
AutoCQ: (Wird der AutoCQ – Funktion zugewiesen) : 
<ASAUTOCQ><CLEAR><TX>CQ CQ CCC Test 
CQ CQ Test de <MYCALL> <MYCALL> k<CR><LF><RX> 
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QRZ:  
<CLEAR><TX>QRZ? AGN Pse de <MYCALL> k<CR><LF><RX> 
 
ANTWORT : (auf einen Anruf) 
<TX><CALL> de <MYCALL> Hello, ur <RSTS>-<NRS>-<NRS> k<CR><LF><RX> 
 
REPEAT: (Rapport wiederholen) 
<TX><CALL> Agn ur <RSTS>-<NRS>-<NRS> k<CR><LF><RX> 
 
CFM: (Bestätigt, speichert das QSO und ruft QRZ?) 
<TX><CALL> QSL 73 de <MYCALL> QRZ? k <CR><LF><SAVEQSO><RX> 
 
NOCFM: (Wiederholung anfordern) 
<TX><CALL> PSE AGN UR REPORT de <MYCALL> k <CR><LF><RX> 
 
CALL S/P: (Anruf an CQ-rufende Station mit <CALL>) 
<TX><CALL> de <MYCALL> <MYCALL> k <CR><LF><RX> 
 
CFM S/P: (QSL und Rapport, dann QSO speichern) 
<TX><CALL> de <MYCALL> TNX, QSL, ur <RSTS>-<NRS>-<NRS> 73 de <MYCALL> k 
<CR><LF><SAVEQSO><RX> 
 
Hinweis : Ersetzen Sie <RSTS> durch 599, wenn Sie nicht dauernd von MixW nach einem Rapport 
gefragt werden wollen. ( 
Tip DM3ML : Haken Sie View > Use default RST an , dann wird auch unter RSTS ein 599 gesendet. 
  
Mit diesen Macros können Sie in den meisten Contesten arbeiten oder Sie an andere Conteste 
anpassen. Speichern Sie sie getrennt ab, dann können Sie sie jederzeit wieder verwenden. 
 
Tip DM3ML : Mit dem Macro <GRABCALL> können Sie das letzte im RX-Fenster erkannte 
Rufzeichen automatisch ins Logfenster holen, ohne es getrennt anzuklicken. Ändern Sie z.B. das 
Macro CALL S/P  in 
 
<TX><GRABCALL> <CALL> de <MYCALL> ....... 
 

4.2 DX-Cluster (DX Cluster) 
 

 
MixW hat ein DX-Cluster-Fenster, mit dem Sie die Daten eines Packet- , Internet- oder Telnet-DX-
Clusters verfolgen können. Wenn Sie die DXCluster-Seite verwenden wollen, müssen  auf einem der 
drei nachstehend genannten Wegen eine Verbindung zu einem DXCluster aktiviert haben. 
 
Wählen Sie  View > DXCluster : 
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Mit  Settings können Sie die Optionen im DXCluster-Fenster einstellen :  
 

 
 

Packet-DX-Cluster :  Sie brauchen einen TNC, der so konfiguriert ist, daß er bei einem Packet-DX-
Cluster eingeloggt ist. Sie können Ihn mit  Configure > TNC settings konfigurieren. (siehe TNC-
Konfiguration und Betrieb (TNC Configuration and Operation)). Um das Einloggen des TNC zu 
vereinfachen, können Sie ein Script vorbereiten. Sie müssen in jedem Fall erst das TNC-Fenster 
öffnen, den Connect zum DXCluster herstellen und das TNC-Fenster dann verkleinern (nicht 
schließen !). 
 
Internet-DXCluster (WebCluster): Wenn Sie auf Webcluster klicken, stellt MixW eine Verbindung zu 
dem unter Settings eingestellten Webcluster her. Mit Settings        können Sie den Cluster Ihrer 
Wahl eintragen. Voreingestellt ist OH2AQ, sie können aber auch andere Cluster eintragen und mit OK 
abspeichern. Wenn Sie Auto reload  freigegeben haben, stellt MixW automatisch eine Verbindung 
zum Webcluster her.  
Wenn Sie keinen automatischen Internetzugang auf Ihrem Rechner installiert haben, entfernen Sie 

alle Haken im mit Settings  erreichbaren Webcluster-Dialog,. Sonst beschwert sich MixW 
jedesmal, dass es keine Internetverbindung herstellen kann. 
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Telnet-DXCluster : Sie können einen Telnet-DXCluster aktivieren, wenn Sie über  
View > Telnet Window oder ein externes Telnet-Programm einen DX-Cluster ansprechen. Klicken 

Sie dann im DXCluster-Fenster auf Get Web Cluster Page   um die Verbindung zu diesem 
DXCluster herzustellen. 
 
Ergänzung DM3ML : Für Packetbetrieb kann unter MixW ein zweiter TNC bedient werden, der an 
einer getrennten COM-Schnittstelle anzuschließen ist. Gehen Sie zu View > 2nd TNC window.  
 

 
 
Stellen Sie unter TNC setup die Schnittstelle und ihre Daten ein. Achten Sie darauf, daß im Feld 
Disable device (Gerät abschalten) kein Haken ist,  schalten Sie Echo ein und wählen Sie Hardware 
flow control. Im sich öffnenden TNC-Fenster müssen Sie den TNC als Terminal ansprechen. Für 
einen TNC-2 lautet die Kommandofolge : 
 
ESC i <eigenes Rufzeichen> Initialisierung 
ESC s 1    Umschalten von Monitorkanal 0 auf Kanal 1 
ESC c <dxcluster>  Connecten zum DXCluster 
 
Wenn Sie unter MixW ein ESC über die Tastatur eingeben, springt der Cursor automatisch zurück ins 
TX-Fenster. Sie müssen das ESC ersetzen durch  

• Strg+ü oder 
• ALT + 027 im Nummernblock 

 
DX-Meldungen im 2.TNC-Fenster werden auch im DXCluster-Fenster ausgegeben. Sie können nach 
Aufbau der Verbindung zum DXCluster das 2.TNC-Fenster verkleinern (Button in der Statuszeile), 
dürfen es aber nicht schließen. 
 
 
 

4.3 HF-Bandplan (HF Digital Modes Band Plan) 
 

 
Es gibt nur eine geringe Übereinstimmung darüber, welche Sendeart an welcher Stelle der digitalen 
Subbänder gemacht werden soll. Die neuen Modi sind mitunter bei den Alteingesessenen nicht 
besonders willkommen. Bitte vermeiden Sie es, mit Ihrer gerade gewählten Sendeart andere 
Sendearten zu stören. 
 
Empfohlene Frequenzen für die einzelnen Modi finden Sie unter Digitale Sendearten (Digital Modes) 
in den Kapiteln der einzelnen Sendearten. 
ABER  (DM3ML) : Dort empfohlene Anruf- oder Aktivitätsfrequenzen sind kein Grund dafü,r ein auf 
der Frequenz laufendes QSO in einer anderen Sendeart kaputt zu machen. Grundsätzlich gilt, dass 
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ALLE digitalen Sendearten in dem Bereich im Bandplan, der für Digimodes ausgewiesen ist, 
verträglich miteinander auskommen sollten. 
 
Der offizielle Bandplan aller drei IARU-Regionen ist unter  http://www.iaru-r2.org/hf_e.htm zu finden. 
 
Die ARRL führt The Considerate Operator's Frequency Guide  (Frequenzwegweiser) für die USA 
unter  http://www.arrl.org/FandES/field/regulations/conop.html 
 
Diskussionen über die aktuellen Ideen für die Frequenznutzung können Sie im YAHOO-Reflektor : 
http://groups.yahoo.com/group/DigiMode_HF_Band_Plans/ verfolgen und selbst mit gestalten. 
 
Die für die einzelnen digitalen Sendearten empfohlenen Frequenzen finden Sie auf verschiedenen 
Listen im Internet, z.B. 
 
Buxcom: 
http://www.packetradio.com/frequencies.htm 
 
K8BE's Digital Mode Pages: 
http://www.angelfire.com/oh3/k8be/freqme.html 
 
Hier ist einiges in Bewegung und nicht immer sind die Listen in Übereinstimmung mit dem IARU-
Bandplan. 
 
 

4.4 Macro-Kommandos (Macro Commands) 
 

Sehen Sie unter Macros erzeugen (Configuring Macros) nach, wie Macros verwendet werden.  
Dieses Kapitel enthält folgende Gruppen von Macros : 

• Text-Macros (Text Macros) 
• Zeitbezogene Macros (Time related text Macros) 
• Dateibezogene Macros (File Related text Macros) 
• Bedingungsbezogene Macros (Condition Related text Macros) 
• Macros zur Programmsteuerung (Program Control Macros) 
• Macros zur Frequenzsteuerung (Frequency Control Macros) 
• Auto-CQ-Macros (Auto CQ Macros) 
• Macros zur Macrosteuerung (Macros that control Macros) 
• Macros zur Sendearteneinstellung (Mode Settings Macros) 
• RTTY-spezifische Macros (RTTY Specific Mode Macros) 
• SSTV-spezifische Macros (SSTV Specific Mode Macros) 
• CW-spezifische Macros (CW Specific Macros) 
• Macros zur Rotorsteuerung (Rotor Control Macros) 
• Andere Macros (Other Macros) 
• Spezielle Macros mit Erklärung (Further explanation on the use of some of MixW's special 

Macro commands) 
 
 

4.4.1 Text-Macros (Text Macros) 
 

<MYCALL>  gibt das eigene Rufzeichen wie unter Personal Data eingetragen aus 
<MYMAINCALL> das gleiche, aber ohne Zusätze wie /p 
<MYNAME>  gibt den eigenen Namen (siehe Personal Data) aus 
<MYQTH>  gibt das eigene QTH (siehe Personal Data) aus  
<CALL> gibt das Rufzeichen der Gegenstation, wie es im Log steht, aus  
<NAME>  gibt den Namen der Gegenstation, wie er im Log steht,aus 
<QTH>   gibt das QTH der Gegenstation, wie es im Log steht, aus 
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<WWLOC>   gibt den  WW-Lokator der Gegenstation, wie er im Log steht, aus 
<NOTES> gibt den Inhalt des Feldes Notes aus dem Log aus 
<RSTR>  gibt den empfangenen Rapport aus dem Log aus 
<RSTS>  gibt den gesendeten Rapport aus dem Log aus 
<NRS>   zu sendende laufende Contestnummer 
<NRR>   empfangene laufende Contestnummer 
<CWID>  sendet den unter CWID definierten Text in CW 
<CWID:text> ändert die CWID in die Zeichenkette ‚text’ 
<CWID:DEFAULT> setzt die CWID wieder auf den unter Personal data eingegebenen Text 
<CR>   sendet Wagenrücklauf (WR) 
<LF> -  sendet Neue Zeile (ZL) 
<CRLF>  sendet WR + ZL 
<CTRL-x>  sendet Ctrl-A bis Ctrl-Z (x = Zeichen) 
<VER>   fügt die aktuelle MixW-Versionsnummer ein 
 
 

4.4.2 Zeitbezogene Macros (Time related text Macros) 
 

<DATE>  gibt das aktuelle Datum aus 
<TIME> gibt die aktuelle Uhrzeit in UTC aus 
<LOCALTIME> gibt die aktuelle Lokalzeit (Rechnerzeit) aus 
<STARTTIME> gibt QSO-Startzeit aus 
<FIXSTARTTIME> setzt die aktuellle Zeit als QSO-Startzeit ein 
<CTIME> gibt Zeit in Contestformat  (HHMM) aus 
 
 

4.4.3 Dateibezogene Macros (File Related text Macros) 
 

<FILE>  fügt den Inhalt der Datei <FILE> ein (wählen mit File > Send File ) 
<FILE:filename> fügt die Datei mit dem Namen <filename> ein 
<TEXTFILE>   öffnet die Dialogbox zur Auswahl eines Textfiles, das eingefügt werden soll 
<TEXTFILE:filename>  fügt die Textdatei mit dem Namen <filename> ein 
<RANDOM:filename>  fügt eine Zufallszeichenkette aus einer Datei unter <filename> ein, um den 

Text abwechslungsreicher zu gestalten. 
<INIFILE:file,section,name>  gibt Daten aus der MixW.ini-Datei entsprechend des spezifischen 
Abschnitts (section)  aus 
 

4.4.4 QSO-bezogene Macros (Condition Related text Macros) 
 

<GA>   gibt die Begrüßung nach der Tageszeit bei der Gegenstation aus (GM, GA, oder GE) 
<GAL>   das gleiche, nur lange Form : Good Morning usw.. 
<MODE>  gibt aktuelle Sendeart aus  
<MHZ>  gibt aktuelle Frequenz in MHz aus 
<MHZn>  gibt aktuelle Frequenz mit n Ziffern nach dem Dezimalpunkt in MHz aus 
<KHZ>   dito in kHz 
<KHZn>  dito in kHz 
<QSONR> gibt die laufende QSO-Nummer im Log aus 
<QSONR:Mode> gibt die Zahl der QSOs in der aktuellen Sendeart aus 
<QSONR:BAND> gibt die Zahl der QSOs auf dem aktuellen Band aus 
<AZ>   Azimuth, Antennenrichtung zur Gegenstation in Grad 
<DIST>  Entfernung zur Gegenstation in km (berechnet aus den Daten in cty.dat) 
<WX?>  ein Fenster zur Eingabe des aktuellen Wetters wird geöffnet  
<WX>  der Inhalt des Wetterfensters wird ausgegeben 
<IMD>  gibt den IMD-Wert aus, wenn er in der Statuszeile mit Mausklick eingefroren wurde 
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4.4.5 Macros zur Programmsteuerung (Program Control Macros) 
 

<TX>   schaltet auf Senden 
<RX>   schaltet auf Empfang 
<TXTOGGLE>  Umschaltung zwischen TX und RX 
<RXANDCLEAR>  schaltet auf RX und löscht das Sendefenster 
<MODE:mode>  Setzt die Sendeart auf <mode>.. <MODE:RTTY> schaltet auf  RTTY 
<MODEADD:mode>  ruft eine zusätzliche Sendeart außerhalb von MixW 
<MODETNC:mode>  schaltet auf eine TNC-Sendeart um  
<MODESETTINGS>  aktiviert das Menü Mode settings der aktuellen Sendeart 
<MARKERS:xx,yy,...>  setzt Marken auf maximal 5 NF-Frequenzen xx, yy .. z.B.  
                                      <MARKERS:1200,1800,2300> 
<IMD>    gibt in der Statuszeile eingefroreren IMD – Wert aus  
<BAUDRATE:rate> ändert die Baudrate des PSK-Signals 
<CURSOR:n> - places the input focus to the specified column number of the log bar 
<CLEARWINDOW> löscht das aktuelle Fenster in dem der Kursor steht 
<CLEARTXWINDOW>  löscht das TX-Fenster 
<CLEARRXWINDOW>  löscht das RX-Fenster 
<CLOSERXWINDOWS> schließ alle zusätzlich geöffneten RX-Fenster 
<NEWRXWINDOW:audiofreq>  Erzeugt neuen RX-Fenster bei audiofreq 
<NEWRXWINDOW:audiofreq:mode> Erzeugt ein RX-Fenster mit NF-Frequenz und Sendeart 
<PIC….>  siehe MFSK-Bildübertragung (MFSK Image Mode) 
<SAVEQSO>   speichert das aktuelle QSO ab 
<CLEARQSO>   löscht die aktuelle Logzeile 
<SENDQSL>  sende eQSL 
<SENDQSLNP> sende eQSL ohne Prompt 
<EXEC:command>  führt ein Kommando oder Programm aus 
<ASSCRIPT>script  führt einen vorbereiteten Script (*.scr) aus 
<SCRIPT:filename> führt den Script filename aus 
<TNCSCRIPT:filename> führt den Script filename für den 2nd TNC aus 
<TELNETSCRIPT:filename> führt den Script filename für eine Telnet-Sitzung aus 
            z.B. <TELNETSCRIPT:EA7URC_DXC.scr> 
 
<SHOW:name>  schaltet den Werkzeugbalken name  auf ON (EIN) 
<HIDE:name>   schaltet den Werkzeugbalken name auf OFF (AUS) 
 
Adressierbare Werkzeugbalken bzw. Fenster sind : CONTROLBAR, LOGBAR, CATBAR, TUNINBAR, 
WORLDMAP, STATUSBAR, DXCLUSTER, CALLBOOK, TNC. 
 
<WAVE:filename>  spielt die adressierte  *.WAV-Datei ab (siehe unten) 
<STARTRECORD>  startet eine  WAV-Aufzeichnung 
<STARTRECORD:filename>  startet eine WAV-Aufzeichnung unter filename 
<STOPRECORD>  beendet die WAV-Aufzeichnung 
<FILTER:name>  schaltet DSP-Filter (NONE, PASS, NOTCH, NOISE) zu  
<REPLAY>  spielt die Signalaufzeichnung (History) ab 
<REPLAY:n>   spielt n Sekunden der Signalaufzeichnung ab 
<SNAPNOW>   schalte SNAP ein 
<SEEKLEFT>   starte Suche nach links 
<SEEKRIGHT>  starte Suche nach rechts 
<INPUTVOLUME>  öffne Regler für Eingangssignal 
<OUTPUTVOLUME>  öffne Regler für Ausgangssignal 
<TUNE>  schaltet auf Abstimmen, Abbruch mit ESC 
<STARTSCAN>  startet Suchlauf 
<STOPSCAN>   beendet Suchlauf 
<LASTCALL> -  bringt das letzte empfangene Rufzeichen aus dem RX-Fenster ins Log unter 

CALL und auch in das Macro <CALL> 
<GRABCALL>  bringt empfangene Rufzeichen aus einem Stack ins Callfenster, auch in 

<CALL>) 
<ESCAPE>   gleiche Funktion wie ESC auf der Tastatur (=Abbruch), stoppt AutoCQ usw. 
<WORDMODE:x>  schaltet Wortmodus ein (x=1) oder aus (x=0) 
<CAPITALSONLY:x> schaltet auf Großbuchstaben, x=1=EIN, x=0=AUS 
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<YAPPRECV>  YAPP-Empfang 
<YAPPSEND>  YAPP-Senden 
<YAPPSEND:filename sende Dateie filename als YAPP 

4.4.6 Macros zur Frequenzsteuerung (Frequency Control Macros) 
 

<FQ:fq_in_kHz> setzt Transceiverfrequenz auf fq  
<ZFQ:fq_in_kHz>  setzt die Zerobeat-Frequenz auf fq 
<AUDIOFQ:fq_in_Hz>  setzt die Audiofrequenz auf fq 
<JUMPTOTXFQ>  RX-Frequenz auf TX-Frequenz setzen 
<ALIGN:fq_in_Hz>  holt markiertes Signal mit CAT auf fq  
<SPZOOM:n>   setzt den Spektrum/Wasserfall-Zoom auf 0.5, 1, 2, 3, oder 4  
<SPSHIFT:fq_in_Hz>  setzt die Spektrum/Wasserfall-Shift auf fq 
<BOOKMARK>  schaltet Buchzeichen aus oder ein 
<BMERASE>   löscht alle Buchmarken auf der eingestellten Frequenz 
<CATCMD:text_command>   sendet ein Kommando an den Transceiver als Text 
<CATCMDHEX:hex_command> sendet ein Kommando an den Receiver im HEX-Format z.B.  

 0A 3F 56 08 oder 0A3F5608  
<CATWAIT:ms>   CAT verzögert um x ms. 
<MEMW:n> schreibe Speicherplatz n (n=1…20) entspricht CTRL+n (n=1..10) für Platz 

1..10 bzw. SHIFT+CTRL+n (n=1..10) für Platz 11…20 
<MEMR:n>  lese Speicherplatz n (N=1..20) und setze TCVR, entspricht ALT+n (n=1..10) 
    bzw. ALT+SHIFT+n 
 
 

4.4.7 Auto-CQ-Macros (Auto CQ Macros)  
 

<AUTOCQ>  Löst eine Auto-CQ-Routine wie unter Options | AutoCQ  ausgewählt aus  
<ACQ>  Erzeugt eine Pause und restauriert AutoCQ  
<ASAUTOCQ> Weist das aktuelle Macro als AutoCQ-text zu    
<ACQDELAY:seconds>  setzt die Wiederholzeit auf seconds 
<ALARM:string>  Löst einen Piep aus, wenn die Zeichenkette <string> empfangen wird 
 
 

4.4.8 Macros zur Macrosteuerung (Macros that control Macros) 
 

<MACROS:filename>  Lade einen anderen Macrosatz. Der neue Satz unter <filename> wird als 
voreingestellter Satz anstelle von MixMacros.mc genommen  

<MODEMACROS:filename>  Lade einen anderen Macrosatz für diese Sendeart. <filename> wird 
ab sofort als Macrosatz für diese Sendeart (macros for this mode) 
genommen 

<EDITMACRO:name>  mit diesem Macro wird der Macrosatz <name> zum Editieren aufgerufen 
<ONQSOBEFORE:name> starte das Macro <name>, wenn es ein Doppel-QSO ist (für Conteste) 
<HIDETEXT>    zeige das Macro nicht im TX-Fenster 
<SHOWTEXT>   zeige Macros wie üblich 
<QSOCMDDDE:command>  übermittle QSO-Daten an die DDE-Schnittstelle 
 

4.4.9 Macros zur Sendearteneinstellung (Mode Settings Macros) 
 

<SQUELCH>   Squelch um (AUS/EIN) 
<SQUELCHON>  schaltet Squelch EIN 
<SQUELCHOFF>  schaltet Squelch AUS 
<AFC>    schaltet AFC um (AUS/EIN) 
<AFCON>   schaltet AFC EIN 
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<AFCOFF>   schaltet AFC AUS 
<SNAP>   schaltet SNAP um (AUS/EIN)  
<SNAPON>   schaltet SNAP EIN   
<SNAPOFF>   schaltet SNAP AUS 
<INV>    schaltet Inversion um (AUS/EIN) 
<INVON>   schaltet Inversion EIN 
<INVOFF>   schaltet Inversion AUS 
<LOCKTX> -  hält die TX-Frequenz fest (LOCK EIN) 
<UNLOCKTX>   gibt TX-Frequenz frei (LOCK AUS) 
<LOCKTXTOGGLE>  schaltet LOCK um 
<THRESHOLD>  öffnet die Schwelleneinstellung für den Squelch 
<MODESETTINGS> öffnet das Modesettings-Menü 
 

4.4.10 RTTY-spezifische Macros (RTTY Specific Mode Macros) 
 

<SHIFT:shift_n_Hz>  setzt die RTTY-Shift auf n Hz 
<BAUDRATE:baudrate> setzt die RTTY-Baudrate auf <baudrate>  
<LETTERS>   Zwangsumschaltung ins Buchstabenregister 
<NUMBERS>   Zwangsumschaltung ins Ziffernregister 

4.4.11 SSTV-spezifische Macros (SSTV Specific Mode Macros) 
 

<FONTSIZE:n>  setzt die Fontgröße 
<FONTFACE:name>  setzt den Font auf <name> 
<FONTBOLD:n> schaltet fette Schrift mit n=0 AUS und mit n=1 EIN 
<FONTITALIC:n>  schaltet kursive Schrift mit n=0 AUS und mit n=1 EIN 
<LOADPICTURE:filename> lade Bild mit dem Namen <filename> mit Kopfzeile 
<LOADPICTUREONLY:filename> lade Bild mit dem Namen <filename> ohne Kopfzeile  
<PUTHEADER:filename>  wähle <filename> als Kopfzeile 
<LOCKMODE>   arretiert aktuelle SSTV-Modeeinstellung 
<UNLOCKMODE>  gibt SSTV-Modeeinstellung frei  
<PUTRXPICT:x0:y0:x1:y1> setzt das empfangene Bild an definierte Stelle ein 
<PLACETEXT:x:y> setzt Text an die Koordinaten x,y, 
 <PLACETEXT:x:y:text> setzt angegebenenText an die Koordinaten    x,y 
<TEXTSTYLE:n>  legt Textstil n fest 
 

4.4.12 CW-spezifische Macros (CW Specific Macros) 
 
<WPM:n>  setzt Gebegeschwindigkeit auf  n WPM 
<WPM:+n>   erhöhe Gebegeschwindigkeit um n WPM 
<WPM:-n>  vermindere Gebegeschwindigkeit um n WPM 
<WPM:RX>  Setze Gebegeschwindigkeit gleich dem empfangenen Signal 
<LANGUAGE:xxx> - wählt eine Sprache  
<FORCELANGUAGE:XXX>  Empfang als xxx forcieren 
-----------------------------------  
 

4.4.13 Macros zur Rotorsteuerung (Rotor Control Macros) 
 

<ROTOR:SP>  drehe die Antenne zu <CALL> über den kurzen Weg 
<ROTOR:LP>  drehe die Antenne zu <CALL> über den langen Weg 
<ROTOR:n>  drehe die Antenne auf n Grad 
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4.4.14 Andere Macros (Other Macros) 
 

<WKDPERIOD:nnn>  QSO wird ignoriert wenn mehr als nnn vergangen sind 
<WKDIGNODREBEFORE:date time>  QSO vor einem bestimmten Zeitpunkt ignorieren 
<PTTON> PTT EIN 
<PTTOFF> PTT AUS 
<PTTSWITCH>  PTT umschalten 
<PRINTQSL>  Setzt das angewählte QSO in die Druck-Warteschlange  
<FROMCLIP>  Bild für SSTV aus der Windows-Zwischenablage holen 
 

4.4.15 Spezielle Macros mit Erklärung (Further explanation on the use of 
some of MixW's special Macro commands) 
 

CWID: Soll Ihrer Sendung beim Abschied eine CW-Identifikation angehängt werden, die unter den  
Configure > Personal Data eingetragen wurde, so  muß sie mit use CWID freigegeben werden. Sie 
können ein CWID auch als Macro einbauen, z.B. 73 <CALL> DE <MYCALL> SK<CWID>. Halten Sie 
die CWID kurz und verwenden Sie sie nur beim letzten Abschied, denn auf dem Schirm der 
Gegenstation wird in dieser Zeit nur Müll geschrieben. 
 
AutoCQ: Auto-CQ wiederholt den CQ-Text in regelmäßigen Abständen. Das Auto-CQ stoppt 
automatisch, wenn ein Rufzeichen im RX-Schirm erkannt wurde. Konfigurieren Sie das Auto-CQ mit 
Options > Auto CQ > Text wie ein normales Macro : 
 

 
 
 
 
Stellen Sie dann mit Options > Auto CQ > Delay den Abstand zwischen den CQ-Rufen ein :  
 

 
 

Weisen Sie <AUTOCQ> einer Ihrer Macrotasten als zusätzliches Macro zu (speziell den CQ-Macros).   
 
Sie können das AutoCQ  auch mit  Options > Auto CQ > Start  starten und mit Options > Auto CQ > 
Stop wieder anhalten. Es reicht aber, wenn Sie eine beliebige Taste oder ESC drücken. Der Auto-CQ-
Status ist links unten im Statusbalken zu sehen. Der Eintrag verschwindet, wenn Sie den Auto-CQ 
anhalten. 
Wenn Sie unter Options > Auto CQ > Watch squelch wählen, wird das Auto-CQ nur gesendet, wenn 
der Pegel am RX unter der Squelchschwelle liegt, so daß Sie nicht in ein laufendes QSO hineinrufen. 
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<ASAUTOCQ> Mit diesem Macro am Beginn eines CQ-Textes, definieren Sie, daß der folgende Text 
ab sofort (bis zu einer neuen Zuweisung) als Auto-CQ genommen wird. Sie können so zwischen CQ 
und CQDX umschalten. Sonst wird der unter Options | Auto CQ editierte Text genommen. 
 
<WAVE:filename>  Gibt die *.WAV-Datei über die Soundkarte an den Transceiver, um z.B. im SSB-
Contest CQ zu rufen. Nehmen Sie die WAV-Datei vorher mit einem Soundrecorder (wird ab Win95 
mitgeliefert)  über ein Mikrofon auf. Hier ein Beispiel für ein Contest-Macro :  
 

 
 
CQCONTEST.wav ist die aufgezeichnete Date, z.B. "CQ Contest CQ Contest CQ Contest CQ 
Contest, this is K4SET calling CQ Contest". MixW schaltet den Transceiver ein, sendet die Datei über 
die Soundkarte und schaltet wieder auf Empfang. Sie können auch andere WAV-Dateien für QRZ u.ä,. 
erzeugen und Ihre Stimmbänder im Contest oder an einer Sonderstation schonen. 
 
Hinweis: <WAVE:filename> kann auch in Zusammenhang mit  <AUTOCQ>  oder  <ASAUTOCQ> 
verwendet werden, wenn Sie automatisch CQ rufen wollen. 
 
<TEXTFILE:filename> : Fügt die im Macro angegebene Datei ein. Wenn Sie den Text dafür editieren, 
achten Sie darauf, dass er mit einem ENTER abgeschlossen ist, ehe Sie ihn als *.txt-Datei 
abspeichern. Haben Sie das ENTER vergessen, erscheint im Text lediglich eine Leerzeile. 
 
 <INIFILE:file,section,name> : Übernimmt eine Zeile aus einer INI-Datei. Nehmen wir, an, Sie hätten 
ein digtales Meteo-Center, daß regelmäßig die Wetterwerte in der Datei d:\temp\sensor.ini ablegt : 

 
--- start of d:\emp\ensor.ini --- 
[Sensor] 
Temperature=xx 
Humidity=yy 
Illumination=zz 
--- end of d:\emp\ensor.ini --- 

 
Daraus können Sie ein Macro machen :  

 
The current temperature in <MYQTH> Kiev is <INIFILE:d:\temp\sensor.ini,Sensor,Temperature> 
degrees centigrade. 
 
 
MFSK – Bildkommandos 
 
Hinweis : Die Methode mit MFSK16 unter MixW Bilder zu senden, ist in den USA auf 10 bis 80 Meter 
nicht erlaubt ! 
Sie können ein Bild von etwa 250 x 200 Pixeln mit folgendes Macros verschicken : 
  
 <PIC?N>  entspricht dem Menüpunkt  File > Send Picture... > B/W...  
                          Sie können eine Schwarz-Weiss-Bild aus dem Auswahlfenster senden  
  
<PIC?N%C>   entspricht dem Menüpunkt  File > Send Picture...>  Color 
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                             Sie können ein Farbbild aus dem Auswahlfenster senden 
  
<PIC:filename.ext%2000>  sendet ein Bild mit hoher Auflösung in S/W  
 
Siehe auch MFSK-Bildübertragung (MFSK Image Mode) 
 

4.5 

4.6 

Script-Kommandos (Script Commands) 
 

Script-Kommandos werden auf einer Zeile geschrieben. Eine Zeile, die mit einem Semikolon beginnt, 
wird als Kommentar gewertet. Ungültige Kommandos werden übersprungen. Der folgende Text wurde 
von der Webseite von Nick, UT2UZ, übernommen : 
 
Folgende Script-Kommandos sind erlaubt :  
 
send "string to send" 
DieZeichenkette String kann Steuerzeichen wie ^C (CTRL-C)enthalten 
 
timeout n 
Es wird auf einen Timeout in n Sekunden gewartet 
 
waitfor "string to wait for" 
Es wird auf eine Zeichenkette gewartet, nach deren Eintreffen weitergearbeitet wird (^C ist erlaubt) 
 
sleep n 
 n Sekunden schlafen 
 
Pause 
Pause, bis der OP die Taste Continue drückt 
 
Close 
Beendet den Script und schliesst das Script-Fenster 
 
runmacro "macroname" 
Startet das Macro mit dem Namen macroname, z.B. runmacro "FQ:14071" 
 
sendmacro "macroname" 
Fügt das Macro als Text ein, z.B. sendmacro "MYCALL” 
 
 
Macros mit Scripts verwenden   
 
<SCRIPT:filename> 
Startet das Script von der Datei  
 
<ASSCRIPT> 
Definiert den Rest des Macros als Script 
 
<TNCSCRIPT:filename> 
Script an den zweiten TNC schicken 
 
<TELNETSCRIPT> 
Script im Telnet-Fenster abarbeiten 
 

Transceiverfernsteuerung übers Netz (The Eye of a Needle 
(TEOAN)) 

 
von Denis Nechitailov, UU9JDR  
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Sie können mit MixW 2.12, einem MixW RigExpert und dem TEOAN-Programm einen Transceiver 
über ein lokales Netz ankoppeln und dann über eine Internetverbindung an einem PC mit MixW 2.12. 
oder höher fernsteuern. 
 
 

 
 
Links : Computer mit dem Netzwerknamen dn-acer und laufendem MixW-Programm 
Rechts : Computer mit dem Netzwerknamen dn-compaq mit MixW RigExpert verbunden.  
Stellen Sie im TEOAN-Programm eine virtuelle  COM-Schnittstelle für den MixW RigExpert und eine  
TCP-Portnummer ein (die voreingestellten Werte funktionieren in der Regel).  
 

 
 
Einstellungen am TEOAN-Computer dn-compaq 
 
Stellen Sie bei MixW unter Sound Device Settings  als Gerät The Eye of a Needle als Audiogerät 
ein und geben Sie eine IP-Adresse mit dem gleichen TCP-Port und den Namen des Computers, hier  
dn-compaq an, auf dem TEOAN läuft,. 
Stellen Sie sicher, das die CAT-Schnittstelle (Baudrate, Datenformat) richtig funktioniert. Überprüfen 
Sie den Menüpunkt  Configure >  TRCVR CAT/PTT . 
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MixW-Einstellungen am  dn-acer – Computer 
 
Hinweis : Der NF-Datenstrom wird nicht komprimiert, so dass kein Qualitätsverlust zu erwarten ist. Es 
wird aber eine höhere Datenrate von bis zu 0.4 Mbit/sec (RX oder TX) oder 0.8 Mbit/sec für TX im 
Duplexmodus benötigt. Bei einem 10 Mbit LAN gibt es keine Probleme, aber Verbindungen über ein 
langsames Modem reichen für diesen Datenstrom nicht aus. 
Das TEOAN-Programm finden Sie im  MixW-Verzeichnis. Kopieren Sie TEOAN.EXE vom Computer, 
auf dem MixW installiert ist, auf den anderen Computer in ein separates Verzeichnis.. 
 

4.7 TNC-Konfiguration und Betrieb (TNC Configuration and 
Operation)  
 

Dank an  RICHARD B. GRIFFIN, NB6Z 
 
Unter MixW kann ein TNC oder Controller (wie KAM oder PTC2)  angeschlossen und angesteuert 
werden. Der TNC wird ausschließlich im Terminalmodus angesprochen und über Kommandos 
gesteuert, Der Hostmode wie unter XPWIN und KaGold wird nicht realisiert. Informieren Sie sich im 
Handbuch des TNCs über die von MixW zu sendenden Kommanos.  
 
Wählen Sie Configure > TNC settings zur Konfiguration der Schnittstelle zum TNC : 
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Verwenden Sie die gleichen Einstellungen wie bei anderen Terminalprogrammen, mit denen Sie den 
TNC angesprochen haben. Wenn Sie Echo auf Ein (mit einem Haken im Feld) setzen, werden die 
Eingaben als Echo zurück gegeben. Es wird aber empfohlen, Echo auf Aus zu lassen. 
 
Wählen Sie jetzt  Mode > TNC mode settings  :  
 

 
 

Ersetzen Sie in der ersten mit UNDEFINED (undefiniert) beginnenden Zeile das Wort UNDEFINED 
durch den Namen der TNC-Sendeart, wie sie im Log erscheinen soll. Tragen Sie in der Spalte 
Description die nähere Beschreibung der Sendeart ein und dann in der Spalte Macros for TNC-
Modes den Namen der Datei mit der Extension *.mc ein, in der die Macros für den TNC stehen. Mit 
dem Feld … können Sie eine Datei importieren und editieren , die sie bereits an einer anderen Stelle 
im PC angelegt haben.  
Jetzt können Sie eine TNC-Sitzung mit einem Klick Mode > TNC modes > <definierte Sendeart> 
starten : 
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Falls Sie unter Configure > Merge macros angehakt haben, werden die voreingestellten Macros 
auch für den TNC verwendet. Sie können aber auch einen Macrosatz speziell für Ihren TNC erzeugen. 
Ein sehr einfaches Beispiel für einen KAM-TNC ist das Macro <CTRL-C>, das den KAM-TNC in den 
Kommandomodus umschaltet, die dann direkt im TX-Fenster eingegeben werden können und mit 
ENTER abzuschließen sind. Hier ist als Beispiel das auf der Taste F4 programmierte Macro zu sehen 
: 
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Sie können dieses Macro in TNC-Start  ändern und mit dem Text <CTRL-C>X belegen. Wenn Sie den 
Eintrag Default for all Modes in For this mode ändern, wird es in dieser Form nur in der 
angewählten TNC-Sendeart wirksam. 
 
Hinweis : Zur Verbesserung der Arbeit mit dem TNC werden Sie sicher die Macros anpassen, 
Wagenrückläufe hinzufügen, das Echo an oder ab schalten usw….. 
 
Zum Start und zum Ende der Arbeit mit dem TNC stehen Ihnen die Macros OnStartMode und 
OnEndMode zur Verfügung, mit denen Sie den TNC initialiseren und nach Ende des Betriebs wieder 
deinitialisieren können. Sie müssen diese Macros über Configure >  Macros > Edit anwählen und 
editieren : 
 

 
  
Sie erscheinen nicht als Taste und können daher nicht mit einem Rechtsklick geöffnet werden. 
 
MixW liefert das Macro PACTOR-KAM.mc für den KAM-TNC mit. Sie können mit dieser Datei mit 
dem KAM-TNC arbeiten und es für andere Sendearten wie G-TOR und AMTOR duplizieren oder für 
einen anderen TNC modifizieren. 
 
Informieren Sie sich im Handbuch des Herstellers Ihres Controllers über die zur Verfügung stehenden 
Kommandos und passen Sie die MixW-Macros entsprechend an. 
 
 

4.8 Fehlerbehebung (Troubleshooting) 
 

MixW sendet nicht : 
 

• Ihr Rufzeichen ist unter Configure > Personal Data nicht eingetragen 
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• Die TX/RX-Umschaltung via VOX, RTS/DTR oder CAT ist nicht richtig konfiguriert.  
Siehe Grundeinstellung (Basic Set Up) und PTT-Schaltung (PTT Circuit) 

 
 
Bei sehr langsamen PCs :  

• Schalten Sie den tuning indicator (die Windmühle) mit View | Tuning indicator ab  
• Setzen Sie unter Configure | Soundcard settings  den spectrum speed auf  Slow  
• Setzen Sie die Abtastrate (sample rate) der Soundkarte mit Configure | Soundcard auf 8000   
• Setzen Sie Configure | Soundcard settings die DSP filter auf  none   
• Vermindern Sie die Höhe des Wasserfalls 
• Schalten Sie die Durchschnitts(average)-Linie im Spektrum ab mit View | Spectrum | 

Average curve | None  
 
Der Wasserfall scheint sich zu lansam zu bewegen :  
 
Setzen Sie unter Configure | Souncard settings die Geschwindigkeit (Spectrum speed) auf einen 
höheren Wert z.B. x4 
 
Die CAT-Steuerung geht nicht :  
 
Einige dieser Interfaces werden aus der Schnittstelle mit Spannung versorgt. Hier müssen die Signale 
RTS und DTR unter  Configure | TRCVR CAT/PTT auf Always On gestellt werden. Ebenfalls 
abgeschaltet werden muß die Hardware Flow Control , da sie unter diesen Status nicht arbeitet. 
 
MFSK16-Signale lassen sich nur mühsam einstellen:  
 
Klicken Sie rechts auf den Wasserfall und wählen Sie einen Zoom von x2 oder x3. 
Tip DM3ML : Mit den Tastenkombinationen STRG+Pfeiltasten links/rechts (10 Hz/Schritt) oder 
ALT+Pfeiltasten (1 Hz/Schritt) links/rechts können Sie den Kursor im Wasserfall fein und ganz fein 
nach links oder rechts verschieben, bis das Signal eingefangen ist.  
 
Name und QTH von Nicht-US-Stationen werden von der Radio Amateur Callbook (RAC) CD-
ROM nicht übergeben:  
 
Schicken Sie einen Brief an P.O. Box 2013, Lakewood, NJ 08701, USA und fragen Sie, warum es 
nicht ordentlich funktioniert. Bis dahin können Sie die Daten aus dem Callbook-Fenster ins Log mit der 
Maus hinüberziehen. 
 
 
Wie wird der richtige Pfad für das Callbook eingetragen ?  
Unter Configure | Callbook wird das Laufwerk eingetragen. Ist  D: der Laufwerkbuchstabe Ihrer CD-
ROM (oder der Partition, in die das Callbook auf die Festplatte gespeichert wurde (DM3ML) gilt :  

• für die QRZ CD-ROM geben Sie ein D:\callbk\  
• für die Buckmaster's HAMCALL geben Sie ein  D:\ham0\ 
• für das Radio Amateur Callbook (RAC) geben Sie ein D:\ 

 
HAMCALL und RAC-Callbooks benötigen DLL-Dateien im MixW-Verzeichnis (HAMCAL32.DLL und 
RACCD32A.DLL).  
 
Gibt es ein <RESYNC> - Macro für MT63? 
 
Versuchen Sie <REPLAY> oder <REPLAY:seconds>. Damit wird der RX resynchronisiert und Sie 
können die Vorgeschichte abspielen, ohne zu viel Information zu verlieren 
 
Kann man ausgewählte QSOs exportieren ? 
Sicher, selektieren Sie die QSO im Log mit der Maus u.U. mit Hilfe der Strg (CTRL) und Shift-Taste 
und wählen Sie  export (oder Statistik berechnen (calculate statistics)). 
 
Kann man parallel zu einem PSK-QSO ein QSO in einer anderen Sendeart mitschreiben ? 
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Ja, klicken Sie rechts auf das zweite RX-Fenster, wählen Sie unter Mode eine andere Sendeart 
 
 
  
 
Für ergänzende Hilfe und Diskussionen schreiben Sie sich bitte ein beim MixW-Reflektor unter : 
 http://www.yahoogroups.com/group/mixw/ 
 
Wir erwarten Berichte über Fehler !   
Bitte geben Sie nicht nur eine kurze Info über den Fehler, sondern auch eine detailierte Beschreibung 
: 

• Beschreiben Sie den Fehler und den Weg bis zu seinem Auftreten ab dem Start von MixW  
• Beschreiben Sie Ihren PC (Prozessortyp, Grafikkarte, Soundkarte, freier Platz auf der HD, 

installierter RAM usw.)  
• Falls das Programm eine Fehlermeldung abgibt (Adressen, Register usw.) schreiben Sie sie 

bitte ab 
• Senden Sie uns in jedem Fall die Datei MixW2.ini aus dem WINDOWS-Verzeichnis 

 

4.9 MixW mit DXAtlas verwenden (Using MixW with DXAtlas)  
 

von  Finn Helmuth Pedersen, OZ6LI 
 
Holen Sie sich die neueste Version von MixW und vom DxAtlas .  
 
Arbeiten Sie diese Folge ab : 
 

• Installieren Sie MixW und DXAtlas in Ihren vorgeschlagenen Verzeichnissen oder in 
Verzeichnissen Ihrer Wahl 

• Informieren Sie sich unter Übergabe von Daten an externe Karten  (Using DDE to 
pass data to external maps). 

•  Holen Sie sich die Datei Mix2DxAtlas1.zip von 
http://mixw.net/files/Mix2DxAtlas1.zip. und entpacken Sie sie in in das MixW-
Verzeichnis. 

• Erzeugen Sie ein neues Macro unter MixW und nennen Sie es z.B. ATLAS : 
<EXEC:C:\Programmer\Afreet\DX Atlas\DXAtlas.exe>  
<EXEC:C:\Programmer\MixW\Mix2DxAtlas.exe> 
 
(setzen Sie jeweils hier das aktuelle Verzeichnis des *.exe-Programms ein) 
 

Die erste Zeile ruft DXAtlas auf, die zweite Zeile startet die DLL zur DDE-Übergabe von 
MixW an DXAtlas. Setzen Sie bei beiden Programmen den gültigen Pfad im Macro ein. 
Nun können Sie die Vorzüge des großen DigiMode-Programms MixW zusammen mit dem 
großen DXAtlas verwenden. 
 
Gehen Sie so vor : 
 

• Starten Sie MixW wie üblich 
• Klicken Sie auf das neue Macro ATLAS 
• DXAtlas wird geladen und die DDE-Routine Mix2DxAtlas.exe gestartet 
• Nach einigen Sekunden öffnet sich ein kleineres DxAtlas-Fenster oben links 
• Vergrößern Sie den Atlas auf den ganzen Schirm 
• Wollen Sie zurück zum MixW-Schirm, klicken Sie auf den MixW-Schmetterling ganz 

unten. Mit einem erneuten Klick schalten Sie zurück zum DXAtlas usw. 
 
Täglich mit DxAtlas und MixW arbeiten : 
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Verwenden Sie MixW wie üblich. Sobald Sie eine Station durch einen Klick auf Ihr Call ins 
Log geholt haben, wird ihr Rufzeichen automatisch zum DXAtlas übertragen. Wenn Sie auf 
den MixW-Schmetterling unten im Schirm klicken können Sie das DX korrekt auf der 
Weltkarte sehen. Schalten Sie durch einen neuen Klick zurück zu MixW. 
 
Sie finden die Gegenstation in der Mitte des Prefix-Bereichs. Stehen die Koordinaten der 
Gegenstation auf der Callbook-CDROM, wird der genaue Standort angezeigt. 
 

4.10 MixW mit anderen Programmen koppeln (Using MixW with 
other Programs) 
 

By Denis Nechitailov, UU9JDR 
 
MixW stellt ein DDE-Interface zur Verfügung, um Daten von MixW in andere Programme zu 
übergeben. Öffnen Sie zur Information die Datei MixW DDE test.doc aus dem MixW-Verzeichnis, 
nachdem Sie MixW gestartet und ein QSO ins Log eingetragen haben. Sie bekommen eine Übersicht 
über die DDE-Daten und ihre Schreibweise. 

4.10.1 Verwendung von DDE für den QSL-Druck  
(Using DDE for printing QSL cards) 

. 
 
Im MixW-Verzeichnis finden sie die Datei QSL card test.doc. Sie zeigt eine Beispiel-QSL, für die das 
eigene Rufzeichen und die aktuellen QSO-Daten automatisch an eine MS-WORD-Datei übergeben 
werden. Wollen Sie ein früheres QSO drucken, öffnen Sie den Dialog Search Results. 

 
 
 
Drei Dateien werden für den Druck von QSL-Karten benötigt :  
 

• MixW DDE test.doc 
• MixW QSL card test.doc 
• StarOffice MixW DDE test.sdw 

 
 
Falls eine dieser Dateien nicht in Ihrem MixW-Verzeichnis steht, können Sie sie wie folgt holen : 
 

• die  Microsoft Word DDE –Testdatei von 
mixw.net/files/MixW%20DDE%20test.doc 

• die Datei MixW DDE test.doc und Beispiel-QSL von : 
mixw.net/files/MixW%20QSL%20card%20test.doc 

• die  Sun Star Office notes von  
mixw.net/files/StarOffice%20MixW%20DDE%20test.sdw 
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4.10.2 Übergabe von Daten an externe Logprogramme 
(Using DDE to pass QSO data to external loggers) 

 
. Mit DDE können Sie QSO-Daten zu externen Logprogrammen übertragen : 
Hier ist ein Beispiel für die Übergabe an DXBase 2002-Software (www.dxbase.com)  
 
Holen Sie sich den Visual Basic – Quellcode und die EXE-Datei unter :  
 
http://mixw.net/files/Mix2DxBase4.zip  
 
(Alle Visual Basic EXE-Dateien benötigen Visual Basic 6 DLLs auf ihrem System) 
 
 

 
 

Klicken Sie die Send! –Taste um die Daten an DXBase zu senden oder erzeugen Sie ein Macro z.B. 
auf F2 : 

Macro: F2 
Label: Save 
Text: <QSOCMDDDE:WRITE><QSOCMDDDE:>  
 

MixW erzeugt automatisch <QSOCMDDDE:Send> wenn Sie die Save-Taste im Log drücken und  
<QSOCMDDDE:Remove> wenn Sie die Löschtaste im Log drücken. 
 
 

4.10.3 Übergabe von Daten an externe Karten  
(Using DDE to pass data to external maps) 

 
.Hier ist eine Anwendung für DX Atlas Software (www.dxatlas.com) : 
http://www.dxatlas.com/   
 
Holen Sie sich den Visual Basic – Quellcode und die EXE-Datei von:  
http://mixw.net/files/Mix2DxAtlas1.zip    
 

 
 

MixW212_DtHilfe  22.07.2004 

http://mixw.net/files/Mix2DxBase4.zip
http://www.dxatlas.com/
http://www.dxatlas.com/
http://mixw.net/files/Mix2DxAtlas1.zip


MixW2-Hilfe V.2.12 Seite 90 von 155 Übersetzung von Eike,DM3ML 

 
 

Das Beispielprogramm gibt Ihre und die Position Ihres QSO-Partners in die Karte aus. Verwenden Sie 
ein Callbook und dieses enthält die Koordinaten Ihres Partners, werden diese genommen, da sie 
genauer sind. 

4.10.4 Antennen mit DDE umschalten und drehen 
(Using DDE to switch/rotate antennas) 

 
Holen Sie sich den Visual Basic – Quellcode und die EXE-Datei von:  
http://mixw.net/files/MixAntSw1.zip 

 

 
 

Nehmen wir an, Sie hätten zwei 80m-Dipole die senkrecht zueinander (N<>S und O<>W) aufgehängt 
sind, einem Multibandbeam für 20,15 und 10m und eine Langdraht für andere Bänder. 
 
Das Programm demonstriert das automatische Umschalten zwischen den drei Drahtantennen und 
dem Drehen des Beams : 
 
Klicke auf Switch! um die Antennen abhängig von der Frequenz umzuschalten (die 80m-Dipole 
hängen auch vom Azimuth ab) 
 
Klicke auf  Rotate! Um den Beam in die Richtung zur anderen Station zu drehen : 
 
Erzeugen Sie zwei Macros z.B. auf F3 und F4 : 
 

Macro: F3 
Label: Switch 
Text: <CATCMDDDE:SWITCH><CATCMDDDE:>  
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Macro: F4 
Label: Rotate 
Text: <CATCMDDDE:ROTATE><CATCMDDDE:>  
 

F3 schaltet die Antennen, F4 dreht den Beam. 
 
Wenn Sie Auto switch und Auto rotate wählen, beginnt das Umschalten und Beamdrehen 
unmittelbar dann, wenn die Frequenz oder die Richtung sich ändert. 
 

4.10.5 Externe Callbücher (Custom Callbooks) 
 
Mit externen DLL-Treibern können Callbooks verarbeitet werden, die nicht direkt von MixW unterstützt 
werden. 
 
Schreiben von Callbook-Treibern in C  : 
Holen Sie sich die C++ -Quelle und die DLL-Datei unter :  
http://mixw.net/files/MixCallBook1.zip 
 

 
 
Übertragen Sie MixCallBook.dll ins MixW-Verzeichnis. Gehen Sie zu Configure | Callbook und 
wählen Sie MixW custom DLL als Callbook-Typ. Geben Sie den Pfad zur Datenbasis ein. 
 
Die Beispiel-DLL liefert nur Daten von UU9JDR, aber eine reale Datenbasis kann ohne Probleme 
angeschlossen werden. Sehen Sie sich die beigefügten C++-Dateien zu Details an. 
 
Callbook-Treiber in Visual Basic schreiben : 
Wenn Sie eine “Brücken-DLL” in C nutzen, können Sie unter Visual Basic ActiveX eine DLL für einen 
Callbook-Treiber verwenden :  
 
Holen Sie sich die C++ -Quelle und die DLL-Datei unter 
 http://mixw.net/files/MixActiveXCb1.zip 
 
Kopieren Sie beide DLLs (MixActiveXCallBook.dll und MixCallBook.dll) ins MixW-Verzeichnis, 
dann regisrieren Sie sie bei der ActiveX DLL durch Eingabe von 
 
regsvr32 MixActiveXCallBook.dll 
 
Wählen Sie wieder MixW custom DLL als Callbook-Typ, um die "Brücken-DLL” zu aktivieren. 
 
Diese Visual Basic ActiveX DLL – Beispiel öftnet ein MsgBox – Fenster um die DLL zu initialisieren, zu 
deinitialisieren und für die Rufzeichensuche : 
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Es gibt auch die Daten für UU9JDR zurück. 
 
Sie müssen die MixActiveXCallBook.dll (geschrieben in C) nicht modifizieren. Fügen Sie den Code 
für drei Visual Basic Funktionen zur Unterstützung Ihrer Callbook-Datenbasis hinzu :  
 

Private Sub Class_Initialize() 
' Add your initializing code here 
...  

End Sub 
Private Sub Class_Terminate() 
' Add your terminating code here 
... 

End Sub 
 

Public Function LookupCall(Path As String, Callsign As String, ByRef Info As String) As Long 
' Add your lookup code here 

... 
End Sub 
 
Siehe auch das Beispiel des Visual Basic Projekts im VB-Verzeichnis der ZIP-Datei für EinzelheitenI. 
 

4.10.6 Callbuchsuche im Internet 
(Searching at WWW callbook sites) 

 
 
Howard, KH6TY, schlug vor, den Internet Explorer zu öffnen, um nach dem aktuellen Rufzeichen zu 
suchen : 
 
Holen Sie sich den Visual Basic – Quellcode und die EXE-Datei von:  
http://mixw.net/files/MixWebLookup3.zip 
. 

MixW212_DtHilfe  22.07.2004 

http://tav.kiev.ua/~nick/mixw2/MixWebLookup2.zip


MixW2-Hilfe V.2.12 Seite 93 von 155 Übersetzung von Eike,DM3ML 

 
 

Dieses Beispiel sieht automatisch in unterschiedlichen Internet-Callbooks nach je nach Land des 
Rufzeichens : 
 
Kanadische Rufzeichen werden in  www.rac.ca. gesucht 
Russische Calls unter  www.octavia.com. 
Andere Rufzeichen unter  www.qrz.com . 
 
Um die Suche zu starten, geben Sie das Rufzeichen in das MixW-Log ein und klicken dann auf die 
Search-Taste. Um die Suche aus dem MixW-Fenster zu starten, erzeugen Sie ein Macro z.B. auf F4 : 
 

Macro: F4 
Label: Search 
Text: <QSOCMDDDE:LOOKUP><QSOCMDDDE:> 
 

Das Programm zeigt das ganze Fenster, übernimmt aber keine Daten ins Log. 
 

4.11 Verwendung der Spektrumanzeige  
(Using the Spectrum Display) 

 
By Jim Jaffe, WA2VOS  
 
Sie können bei MixW zwischen zwei Anzeigen für die Abstimmung auf digitale Signale wählen :  

• Wasserfall 
• Spektrum 

 
Der Wasserfall ist dabei keine Echtzeitanzeige, sondern eine Durchschnittsdarstellung der Signal in 
einem Frequenzbereich über eine gewisse Zeit. Wenn Sie an der VFO-Abstimmung drehen, 
verschieben sich die einzelnen Signallinien zusammen mit der Abstimmung. 
Die Spektrumsanzeige ist eine Echtzeitdarstellung der Signal, wobei die Durchschnittskurbe (Average 
Curve) die Spitzenwerte der Signalamplituden erfasst. 
Sie können mit ALT-W  während des Betriebs zwischen Wasserfall und Spektrum hin und her 
schalten. 
Sie können das Sepktrum über das Menü View > Spectrum so einstellen : 
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Wählen Sie unter Average Curve die Zuschaltung der 10dB-Skala. Im Beispiel ist die Spitzenkurve 
(Peak Curve) orange und die Durchschnittskurve (Average Curve) gelb. Die Average Curve  ist auf 
Inverted geschaltet 
 

 
 

Mit der Spektrum können Sie sehr einfach abstimmen. Wenn Sie ein Notchfilter benötigen, klicken Sie 
rechts auf das zu unterdrückende Signal. und wählen Sie Set Notch filter und das störende Signal 
wird im Spektrum unterdrückt. Sie sehen im Spektrum auch das Verhältnis des Nutzsignals zu 
anderen zu empfangenden Signalen. 
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In diesem Bild sehen Sie die Wirkungen eines Schmalbandfilters mit einer Banbreite von 500 Hz und 
einer Mittenfrequenz bei 1360 Hz :  
 

 
 

Die Abstimmung eines MFSK-Signals ist im Wasserfall ziemlich mühsam, weil Sie nur beim 
Zuschalten des Signals die Spur sehen, auf die der linke genau Cursor gesetzt werden muss. Wählen 
Sie die Spektrumsdarstellung sehen Sie mehrere Spitzen zwischen den beiden Cursoren, auf die Sie 
die Cursoren setzen und so das MFSK schneller dekodieren können :  
 

 
 

Die Spektrumanzeige ist so effektiv, dass ich den Wasserfall nie benutze. Ich schalte den Wasserfall 
nur an, wenn ich die Signalqualität einer Station auf Anfrage beurteilen soll. 
 
Anmerkung DM3ML : Das ist die persönliche Meinung von WA2VOS, die ich nicht teile. 
 

4.12 Verwendung des Wasserfalls 
(Using the Waterfall--Step by Step) 
 

Dieser Abschnitt bezieht sich auf die Nutzung von MixW ohne CAT und beschreibt die Nutzung des 
Wasserfalls und der Frequenzmarken. Er ist vor allem für Nutzer interessant, die von anderen 
Digimodeprogrammen zu MixW kommen. 
 
MixW funktioniert so intuitiv, dass sie meist garnicht datüber nachdenken müssen, was dort auf dem 
Schirm passiert, bis einmal etwas unerwartetes passiert. Wir wollen Schritt für Schritt vorgehen und 
uns die Abstimmung eines BPSK-ignals ansehen. Voraussetzung ist, dass Transceiver und Computer 
richtig miteinander verbunden sind. 
  
Schritt 1  
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Starten Sie MixW und stelen Sie den Transceiver auf 14,070,000 Hz. (14.070 MHz.) und USB. Ist im 
Wasserfall nichts zu sehen, gehen Sie zu Konfiguration und Einstellung (Configuration and Set Up). 
Sehen Sie was, gehen Sie zum Menü Configure > TRCVR CAT/PTT  und machen Sie eine Haken 
bei  Display zero beat frequency und klicken Sie dann auf OK . Wählen Sie dann  View > Spectrum 
>| Auto und machen Sie einen Haken davor. Klicken Sie dann rechts in den Wasserfall und wählen 
Sie  Zoom x2 im sich öffnenden Menü. Sie sollten jetzt folgendes sehen :  
 

 
 

Bei 1200 Hz sehen Sie ein stärkeres BPSK31-Signal und ein schwächeres bei 1580 Hz. Bei 1100Hz 
steht der Diamant-Cursor mit einer grünen Flagge und markiert die aktuelle Empfangsfrequenz. Im 
Statusbalken stehen weitere Informationen und zeigen an, dass der Transceiver auf Empfang (RX) 
steht, der Squelch (Sq),  die automatische Frequenznachführung (AFC) und der Fangautomat (Snap) 
zugeschaltet sind. Die Sendefrequenz  ist nicht gesperrt (Lock aus) und folgt der Empfangsfrequenz.  
Setzen Sie den Mauszeiger auf das Signal bei 1205 Hz und klicken Sie links. Der Doppelcursor samt 
Flagge wird auf das gewünschte Signal gesetzt und der gesendete Text im RX-Fenster (oben) 
mitgeschrieben. 
Wenn Sie einen CQ-Ruf mitgeschrieben haben, können Sie einen Text ins Sendevorschreibfenster 
(Mitte) eingeben und mit einem Klick auf RX auf Senden schalten. 
Welche Frequenz sollte im Log stehen ? 
 Es gilt die Mittenfrequenz des gesendeten BPSK-Signals, hier Transceiverfrequenz 14070.0 kHz 
PLUS (weil auf USB geschaltet) 1205 Hz, also genau 14071.205 kHz 
 
  
Schritt 2  
 
Sie brauchen bei MixW nicht zu rechnen. Entweder wird die Frequenz und das am Transceiver 
eingestellte Seitenband per CAT am Transceiver ausgelesen oder Sie tragen die aktuelle Frequenz in 
das Fq-Fenster  ein, die angezeigt wird ,wenn Sie View >  CAT bar gewählt haben. Haben Sie als 
Einstellung View > Spectrum  > RF, USB gewählt, wird wie oben die genaue Frequenz auch ohne 
CAT ausgerechnet.  
Beim folgenden Beispiel kommt MixW auf eine Frequenz von 14070.882 KHz für das Log. Die NF-
Frequenz des Signals liegt bei 882 Hz. 
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Hinweis : Haben Sie keine CAT installiert, müssen Sie darauf achten, dass die am Transceiver 
eingestellte Frequenz jeweils exakt in das Fq-Fenster eingetragen ist. 
 
Schritt 3  
 
Sie müssen die Seitenbandlage (hier USB)  und die gewählte Sendeart beachten. Als Nennfrequenz 
eines RTTY-Signals wird bei MixW die Mittenfrequenz zwischen dem niedrigen Ton (Space) und dem  
höheren Tons (Mark) angeben.  Im folgenden Beispiel ist ein RTTY-Signal zu sehen, dessen Mitte 
(grüne Fahne) bei 14085.275 kHz liegt. Diese Frequenz ergibt sich aus der am Transceiver 
eingestellten Frequenz von 14084 kHz und der NF-Mitten-Frequenz 1275 Hz. 
Anmerkung DM3ML : Üblicherweise wird die Frequenz des Marktons als Bezug angeben. 
  
 

 
 

Inversion 
 
Bei traditionellen TNCs wird das Signal oft invertiert ausgegeben, der Mark-Ton ist tiefer als der 
Space-Ton und damit auf dem Band die richtige Signallage entsteht, muss am Transceiver auf LSB 
geschaltet und bei MixW RF, LSB  eingestellt werden, damit die Frequenzen wieder stimmen. 
Auch wählen Transceiver meist automatisch auf Bändern unter 10 MHz das untere Seitenband als 
Normallage. 
Bei den Digimode-Programmen gibt seitenbandabhängige Programme, wie RTTY, QPSK31, MFSK16, 
AMTOR, Hellschreiber, THROB und FAX. Können Sie ein Signal zwar gut hören, aber nicht 
mitschreiben, versuchen Sie unter Modes > Inverted  einzuschalten. Pactor und BPSK31 sind nicht 
seitenbandabhägig 
Tip von DM3ML : Am besten auf allen Bändern in den Digimodes in USB arbeiten und die Einstellung 
unter MixW nicht verändern.  
 
Schritt 4 
 
Gehen Sie zu Funkbetrieb (Operation) und arbeiten Sie sich in den QSO-Betrieb ein. MixW hat eine 
Menge an Werkzeugen bereit, einen flüssigen und abwechslungsreichen Betrieb zu realisieren. 
  

5. Digitale Sendearten (Digital Modes) 
 
Diese digitalen Sendearten werden in den folgenden Abschnitten beschrieben : 
 

• Amtor 
• CW 
• FAX-Empfang (FAX Receiving) 
• FSK31-Theorie und Betrieb (FSK31 Theory and Operation) 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 98 von 155 Übersetzung von Eike,DM3ML 

• Hellschreiber-Einführung und Theorie (Hellschreiber Intro and Theory) 
• MFSK 
• MT63 
• Packet 
• Pactor 
• RTTY 
• SSTV 
• THROB 

 
 
 
 
 

5.1 Amtor 
 

5.1.1 Amtoreinführung und Theorie (Amtor Intro and Theory) 
 
mit Dank an  Tony Lonsdale, VK2DHU und  Norm Sternberg, W2JUP 
 
AMTOR ist eine spezielle Form von RTTY.  Die Abkürzung kommt von AMateur Teleprinting Over 
Radio und ist vom kommerziellen SITOR-System (Simplex Telex Over Radio) abgeleitet, das primär 
für die Schifffahrt ab  etwa 1970 genutzt wird.  
 
Ende der 70er machte  Peter Martinez, G3PLX,  etliche Änderungen im SITOR-Protokoll, damit es für 
den Amateurfunkbetrieb verwendbar wurde und taufte es AMTOR. 
  
AMTOR verbessert RTTY durch Einbau einer Fehlererkennung. Das System blieb relativ 
unkompliziert, arbeitet aber selbst noch unter schlechten Bedingungen. Die Fehlerrate ist zwar immer 
noch relativ hoch, aber gegenüber RTTY stellt es eine wesentliche Verbesserung dar. Normaler Text 
hat genug Redundanz, so daß kleinere Fehler tolerierbar sind. Bei der Übertragung kritischer Daten 
wie Programmkodes oder technische Mitteilungen sind allerdings keine Fehler tolerierbar. 
 
Es gibt zwei Modi, die bei AMTOR verwendet werden :  ARQ und FEC.  
 
 >>>> MixW unterstützt momentan NUR den FEC-Modus  
 
ARQ: Dieser Modus ist ein synchrones Protokoll, beide Stationen sind über Ihre Signale in einem 
festen Zeitrahmen synchronisiert. 
Im ARQ-Modus (Automatic Request = automatische Anforderung)- auch Mode A genannt – werden 
die Daten in Gruppen von drei Zeichen gesendet. Dem RTTY-5-Bit-Kode werden 2 Bit so hinzugefügt, 
daß das gesendete Zeichen jeweils 4 Marks (H) und 3 Spaces (L) enthält. Die Gegenstation prüft 
diese Bedingung. Wenn Sie feststellt, daß das Verhältnis 4:3 verletzt ist, wertet sie das Zeichen als 
fehlerhaft. Der Überhang von 40% dient der Fehlererkennung. Es werden eine Menge an Fehlern 
erkannt, aber nicht alle. Die Sendearten PACKET und PACTOR (siehe unten) arbeiten hier wesentlich 
genauer. 
Der Empfänger quitiert jede richtig empfangene 3er-Gruppe mit einem 7-Bit-Zeichen ACK 
(ACKnowledge) oder bei fehlerhaftem Empfang mit dem Zeichen NAK (Negative AcKnowledge). 
Empfängt die Gegenstation ein NAK, wiederholt sie die 3-Zeichengruppe.  
Ein AMTOR-QSO hört sich wie ein chiiiirp-chirp-chiiirp an. Auch wenn aktuell kein Text gesendet wird, 
ändert sich nichts am Signal, dann werden Füllzeichen (idle) gesendet. 
Ein AMTOR-Programm kann im Listen-Modus ein ARQ-QSO mitschreiben, die Mitschrift ist aber 
mitunter mühsam, weil Sie kein ACK oder NAK abgeben können. 
 
FEC: Im  FEC-Modus (Forward Error Correcting = Vorwärtsfehlerkorrektur) – auch Mode B genannt – 
werden alle Zeichen doppelt und verschachtelt gesendet. Dieser Modus ist für Rundsprüche gedacht, 
die empfangende Station gibt keine Quittung. Stimmen die doppelt empfangenen Zeichen überein, 
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werden Sie ausgegeben, andernfalls wird ein Lückenzeichen (meist ein Punkt) eingefügt. Eine FEC-
Sendung ähnelt einem Baudot-RTTY-Signal. 
Um die beiden Stationen in Phase zu halten, werden zu Anfang und im Text in regelmäßigen 
Abständen  Gruppen von Synchronisierzeichen gesendet, die keine Daten enthalten. Mit einiger 
Übung hört man daran ein AMTOR-FEC-Signal heraus. 
 
Der FEC-Modus ist besser als gewöhnliches  RTTY, aber die Fehlererkennung ist nicht so gut wie im 
ARQ-Modus.  
 
AMTOR-Systeme sind auf die Technologie der 60er Jahre begrenzt und orientieren sich an 
mechanischen Maschinen. Die AMTOR-HF-Übertragungsrate  beträgt 100 Baud, die zur Maschine 50 
Baud. Die Fehlererkennung ist zwar besser als einfaches RTTY, sie sollte aber besser 
Fehlerreduktion anstelle von Fehlererkennung heißen, denn sie ist für kritische Daten nicht 
ausreichend. 
  

5.1.2 Amtor-Betrieb (Amtor Operation) 
 
MixW unterstützt nur den FEC-Modus von AMTOR, daher entspricht der AMTOR-Betrieb in FEC 
weitgehend dem RTTY-Betrieb. 
 
Transceiver-Einstellung : 

 
Fine Tuning: Falls Ihr Transceiver eine Feinabstimmung hat, schalten Sie diese ein. Die genaue 
Abstimmung wird ohnehin im Wasserfall gemacht. Schalten Sie den Cursor mit View > Use stick 
cursor um, so daß er als senkrechte Haarlinie eine genauere Abstimmung ermöglicht. 
 
Processor (Kompression) : Starten Sie ohne zugeschalteten Kompressor, nur gelegentlich kann 
er die Verständlichkeit verbessern. Empfehlung : Prozessor ausschalten ! 
 
Pre-Amp: Schalten Sie den Vorverstärker nur zu, wenn sie auf eine sehr leise Station hören. Oft 
haben Sie aber größere Probleme mit starken Nachbarstationen. 
 
USB/LSB: Stellen Sie sicher, daß die MARK-Frequenz unabhängig von der Seitenbandlage die 
höhere Frequenz ist. Die Shift (Differenz zwischen MARK und SPACE) wird auf 170 Hz gestellt. 
Empfehlung DM3ML : Auf allen Bändern den Transceiver auf USB schalten. 
 
VOX: Sehen Sie unter Grundeinstellung (Basic Set Up) wie die RX-TX-Umschaltung realisiert wird 
 
Filtering: Mit einem 500Hz-Filter können Sie den Empfang von RTTY und AMTOR wesentlich 
verbessern, andererseits sehen Sie bei einem breiteren Filter mehr vom Empfangsbereich im 
Wasserfall. Lesen Sie im Handbuch Ihres Transceivers nach, wie Sie unter SSB ein schmaleres 
CW-Filter einschalten können. 
 

 
  
MixW-Einstellung :  
 
Wählen Sie Mode > AMTOR im Menü oder durch Klicken auf die Sendeart im Statusbalken. Gehen 
Sie innerhalb von AMTOR zu Mode >  Mode Settings :  
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TX- und RX-Frequenz zeigen die aktuelle Frequenz des MARK-Signals an. Empfohlen wird ein Wert 
um 1500 Hz, dann liegt das Signal im Paßband, aber die erste Oberwelle des NF-Signals wird bereits 
abgeschnitten. Als Shift wird in der Regel 170 Hz verwendet. Unter Zeichensatz wird meist Englisch 
eingestellt, aber auch andere Zeichensätze, z.B. Englisch/Russisch sind möglich. Wenn Sie das Feld 
Inverted  anklicken, werden Mark und Space vertauscht. 
 
AFC (automatische Abstimmung) kann  auf on stehen und unterstützt die Feinabstimmung des 
AMTOR-Signals. Nach der Abstimmung schalte ich (VK2DHU), die AFC ab, es sei denn sie driftet 
oder ich bin in einem Netz, dessen Stationen nicht genau auf meiner Frequenz arbeiten. Die 
Abstimmung von AMTOR ist nicht so kritisch wie PSK31, so daß die AFC mehr ein Option als eine 
Notwendigkeit ist. 
 
Ist Lock abgeschaltet (off) senden Sie auf  der gleichen Frequenz wie Sie empfangen. Zweckmäßig 
ist es Lock auf On zu schalten, wenn man selbst CQ ruft oder wenn die Gegenstation deutlich driftet. 
 
Inverted: vertauscht MARK und SPACE > probehalber dann einschalten, wenn beim Mitschreiben 
einer starken AMTOR-Station nur Müll mitgeschrieben wird. Nehmen Sie Mode > Inverted oder 
klicken Sie das Feld Inverted bei den AMTOR-Einstellungen an. 
 
AMTOR-FEC-Empfang 
 
Ein FEC-AMTOR-Signal zeichnet zwei parallele 170 Hz von einander entfernte Linien im Wasserfall. 
(etwa viermal breiter als ein PSK-Signal). Um ein AMTOR-Signal aufzustimmen, klicken Sie links 
zwischen die beiden Linien. Der Text erscheint im RX-Fenster. Die Abstimmanzeige besteht aus zwei 
durch eine Linie verbundene diamantförmigen Cursoren, die um den Betrag der Shift voneinander 
entfernt sind. Die Cursoren werden durch die AFC auf die Mitte der Linien des Signals gezogen. 
Hier sehen Sie ein AMTOR-QSO :  
 
 

 
 

Das Signal sollte grob auf eine NF-Frequenz um 1500 Hz  oder die Mitte des Fensters eingestellt 
werden. 
 
AMTOR senden 
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Um eine Station anzurufen, stimmen Sie wie oben beschrieben ab. Sie können bereits Text im TX-
Fenster vorschreiben. Klicken Sie zum Senden auf die TX/RX-Taste oder drücken Sie die 
Pause/Break-Taste oder klicken Sie auf das RX-Feld im Statusbalken. Der Text aus dem 
Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-Fenster. Nach Druck auf 
die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der letzten Zeichen wieder auf 
Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab. 
 
Hinweis : AMTOR und  RTTY haben nur zweimal 32 Zeichen zur Verfügung. Sie verwenden 
ausschließlich Großbuchstaben. Nicht alle Sonderzeichen sind möglich.  
Zur Verfügung stehen:  - ( ) $ ! " / : ? .    
 
Während des Sendens wird der Wasserfall bis zum Zurückschalten auf RX eingefroren. 
 
Stellen Sie die NF-Amplitude am PC so ein, daß – während Sie keine Zeichen eingeben (idle) der 
Ouput gerade nicht mehr ansteigt (DM3ML : Die ALC sollte noch nicht ansprechen). Sie erreichen so 
ein sauberes Signal ohne unerwünschte IM-Produkte. Rechnen Sie aber damit, daß Ihr Transceiver 
während eines FEC-AMTOR-QSOs im Dauerstrichbetrieb sendet und u.U. überlastet wird. Nehmen 
Sie dann die Aussteuerung zurück. 
 
Anmerkung DM3ML : In der Regel sendet eine Station in AMTOR-FEC den CQ-Ruf und teilt darin ihr 
Selcall bestehend aus 4 Buchstaben mit. Eine Station, die den CQ-Ruf mitschreibt, ruft Sie mit diesem 
Selcall im ARQ-Modus an. Ein „echtes“ AMTOR-QSO wird durchgehend im ARQ-Modus gefahren. Sie 
sehen dann im Wasserfall die 210ms langen Pakete mit 3 Zeichen und die 70ms langen 
Quittungspakete und hören das typische AMTOR-Chiiirp-chirp.  
Sie können mit MixW nur im AMTOR-FEC-Modus senden und empfangen. Sie können aber eine 
Station, die einen CQ-Ruf in AMTOR-FEC sendet, auch in AMTOR-FEC anrufen. Teilen Sie ihr aber 
gleich im Anruf mit, daß Sie kein ARQ können, denn ein AMTOR-FEC-QSO ist in der Regel nur eine 
Verlegenheitslösung. 
 

5.2 CW 
 

5.2.1 CW-Einführung und Theorie (CW Intro and Theory) 
 

mit Dank an  Steven R. Hurst, KA7NOC 
 
CW und Morse-Kode 
 
CW steht für continuous wave (kontinuierliche Welle), aber wenn Funkamateure diese Bezeichnung 
verwenden, beziehen sie sich auf die Verwendung des Internationalen  Morse-Kodes, mit dem sie 
durch eine Serien von Signalen und Pausen auf einer HF-Frequenz kommunizieren- 
Der Morsekode ist nach Samuel F.B. Morse, 1791-1872, benannt. Der Kode besteht einer Serien von 
Punkten und Strichen. Jeder Buchstabe des Alphabets und jede Ziffer von 0 bis 9 hat eine individuelle 
Kombination davon. Der einfachste (und häufigste) Buchstabe ist das E mit einem einfachen Dit. Es 
gibt Leute, die bis zu 70 Worte (zu 5 Buchstaben)per Minute  mitlesen können, aber das Mittel liegt bei 
10 bis 30 Worten/Minute. Wenn Sie den Morsekode lernen, wird er nach einer Weile zur zweiten 
Sprache, Sie hören Worte statt einzelner Buchstaben und erkennen am Rhythmus den 
Zusammenhang und Sie folgen der Konversation. 
Anfänger senden üblicherweise mit einer einfachen Handtaste und schreiben jeden einzelnen 
Buchstaben an ihrem Empfänger mit. Fortgeschritte verwenden eine halbautomatische Taste (Bug) 
oder eine elektronische Taste, die autoamtisch Striche und Punkte erzeugt.  
 
 CW als computerisierte digitale Sendeart 
 
Mit einem Programm wie MixW kann CW auf dem Bildschirm wiedergegeben und per Tastatur 
gesendet werden, ähnlich wie bei den anderen digitalen Sendearten. MixW kann vom Computer 
erzeugten Morsekode nahezu fehlerfrei mitschreiben, den mit einer elektronischen Taste gegebenen 
ebenfalls, solange die Zeitbedingungen eingehalten werden. Es kann kleinen Variationen folgen, wenn 
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der Nutzer Fehlausgaben akzeptiert. Es ist aber nahezu unmöglich, von Hand gegebene 
Morsezeichen mit dem Computer fehlerfrei zu dekodieren, hier ist das menschliche Ohr wesentlich 
toleranter und dem Computer überlegen. 
Anmerkung DM3ML : Wer ein CW-Programm am PC zum Mitschreiben einsetzt, sollte CW zur 
Beurteilung des Erfolgs ausreichend mithören können.  
CW über die Tastatur kann behinderten OPs helfen, die Schwierigkeiten mit einer Taste oder Paddle 
haben, aber CW lieben und CW auch bei höheren Gescjwindigkeiten mitlesen oder –hören können. 

5.2.2 CW-Betrieb (CW Operation) 
 
Konfiguration  
 
Der Empfang und die Dekodierung von CW läuft wie bei den anderen Digimodes mit der Soundkarte. 
Beim Senden wird ein anderer Weg genommen, hier gibt es vier verschiedene Möglichkeiten : 

• Über die Soundkarte, der Transceiver steht dabei auf SSB  
• Tastung der CW-Leitung des Transceivers analog zum Schalten der PTT-Leitung über eine 

COM-Schnittstelle. Der Transceiver steht auf CW  
• Über ein CAT-Kommando an den Transceiver. Der Transceiver steht auf CW. 
• Über einen Hardware-TNC, der CW sowohl kodiert als auch dekodiert  

 
 
Soundkarten-CW : Die Soundkarte gibt CW als getasteten Ton aus. Der Sender wird damit in SSB 
moduliert.  Wählen Sie bei Configure >  TRCVR CAT/PTT...  die Möglichkeit CW out via soundcard. 
Wählen Sie dann Mode >  CW und dort unter Mode > Mode Settings einen Empfangsalgorithmus RX 
Algorithm. Wählen Sie dann im Wasserfall eine RX- und eine TX-Frequenz. Schalten Sie mit der 
RX/TX-Taste auf Senden und zurück auf Empfang. Sie senden nicht CW im hergebrachten Sinn, 
sondern arbeiten in SSB, u.U. sind die Oberwellen Ihres NF-Signals noch ein zweites oder drittes Mal 
zu hören. Sie können u.U.  die schmalen Filter für CW nicht oder nur mit einer Umprogrammierung 
verwenden, Andererseits brauchen Sie gegenüber z.B. PSK31 keine zusätzlichen Installationen. Sie 
können VOX, PTT und/oder CAT wie bisher verwenden. 
 
Direkte CW-Tastung: Der Transceiver wird über eine COM-Schnittstelle und eine zur PTT-Schaltung 
analoge Schaltstufe getastet. MixW arbeitet wie eine elektronische Taste. Ihr Transceiver steht auf 
CW und wird in CW getastet. Sie können die CW-Filter wie gewohnt zuschalten. Ihr Interface wird an 
die Leitungen RTS oder DTR wahlweise der CAT-Schnittstelle oder einer anderen COM-Schnittstelle 
angeschlossen. Wählen Sie Configure | TRCVR CAT/PTT oder Configure | Secondary PTT/RTTY 
Port und legen Sie unter Details fest, welches der Signale RTS oder DTR Sie zur CW-Tastung 
verwenden.  

 
 
Zur Schaltung sehen Sie unter PTT-Schaltung (PTT Circuit) nach. Die NF-Frequenz für das TX-Signal 
wird vom Transceiver vorgegeben. Im Wasserfall ist die Sendefrequenz fest (LOCK) und wird mit einer 
roten Fahne markiert. Die RX-Frequenz ist frei wählbar und Sie können per Ohr dekodieren. Wenn Sie 
den RX-Algorithmus auf Manual  gesetzt haben, können Sie den empfangenen Text von Hand in das 
RX-Fenster eintragen und die Möglichkeiten des automatischen Loggens nutzen. Sie sollten im 
Wasserfall die eigene Sendefrequenz auf die Sendefrequenz der Gegenstation setzen, um in Zero-
beat anzurufen.  
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CAT-Tastung : Falls Sie die PTT Ihres  Transceivers bereits über die CAT steuern, können Sie die 
CW-Tastung auch über ein CAT-Kommando steuern (falls Ihr Transceiver über diese Möglichkeit 
verfügt). Setzen Sie im Dialog Configure | TRCVR CAT/PTT ein Häkchen in das Feld CW via CAT 
Command :  
 

 

 
 
Sie können zusätzlich die Frequenzanzeige korrigieren, wenn Sie unter  Cat correcting in Hz die 
Ablage für CW eintragen. Falls Sie diese Einstellung wählen, wird Ihr Transceiver automatisch auf CW 
geschaltet, die Frequenzablage berücksichtigt und der Transceiver über ein CAT-Kommando getastet. 
  
  
CW mit einem separaten TNC:  
Konfigurieren Sie diesen TNC wie unter  TNC-Konfiguration und Betrieb (TNC Configuration and 
Operation) beschrieben für den externen CW-Betrieb 
 
CW-Betrieb   
Wählen Sie CW mit Mode >  CW  oder klicken Sie auf die Sendeart im Statusbalken, bis CW 
erscheint. Stellen Sie dann Ihre Vorstellungen unter Mode > Mode settings ein :  
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Die RX- und TX-Frequenzen werden hier angezeigt, können aber wesentlich einfacher mit der Maus 
angeklickt werden . 
Sie können MixW vorgeben, wie die Zahlen 0, 1 und 9 abgekürzt werden sollen. Die Geschwindigkeitk 
kann mit diesem nur bei CW angezeigten Bild verändert werden. Mit den Symbolen kann dem 
Programm mitgeteilt  werden, welche Tastenart angeschlossen worden ist (Handtaste oder Paddle) :  
 

 
 

Hinweis : Die Geschwindigkeitseinstellung gilt nur für das Sendesignal. Die Empfangsgeschwindigkeit 
wird vom Empfangsprogramm bestimmt und nachgeführt. 
 
Empfang :  Stellen Sie den Transceiver in  den CW-Bereich eines Bandes und suchen Sie im 
Wasserfall oder Spektrum ein CW-Signal und klicken Sie darauf. Im RX-Fenster wird das empfangene 
Signal nach einer kurzen Abtastzeit wiedergegeben. 
Sie können auch unter CW mehrere Fenster für verschiedene Stationen öffnen und zwischen diesen 
Fenstern umschalten.  
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Sie sehen an diesem Bild, daß die Gegenstation zuerst zu kurze und dann zu lange Abstände 
zwischen den Zeichen und auch den Worten macht. Sie werden feststellen, daß die Dekodierung von 
CW nur dann fehlerfrei ist, wenn die Gegenstation fehlerfrei gibt und vor allem die Pausenlängen 
innerhalb und zwischen den CW-Zeichen einhält. Am besten geht es mit Signalen, die vom Computer 
erzeugt werden, danach kommen Elbugs. Sie werden sehen, daß die Dekodierung selten fehlerfrei 
erfolgt, da das Zeitraster selten korrekt eingehalten wird. Probieren Sie es am besten einmal selbst, 
MixW dahin zu bringen, Ihr eigenes Signal fehlerfrei mitzuschreiben. Das ist eine echte 
Herausforderung, denn es ist sogar mit einer einfachen Taste möglich, so zu geben, daß MixW das 
Signal richtig lesen kann ! 
Die meisten Fehler entstehen durch zu kurze Abstände zwischen den Zeichen, die Zeichen werden 
verschmiert und können dann nicht dekodiert werden. 
 
Anmerkung DM3ML : Bei jedem (!) PC-CW-Programm sollte man CW können, um zu entscheiden, 
ob es richtig dekodiert hat. Und das Wichtigste sind die Pausen und die sind (fast) immer falsch. 
 
Senden : Wenn Sie auf Senden schalten wollen, drücken Sie die Pause/Break-Taste, klicken Sie auf 
das RX-Feld im Statusbalken oder verwenden Sie im Menü Options | RX oder Options | TX. 
Informieren Sie sich unter Allgemeiner Funkbetrieb ( General Operation ).  
 
Sie können bei MixW eine Taste an den Gameport (Joy Stick port) oder die parallele Schnittstelle 
anschließen, falls Sie dieses Angebot nutzen wollen. Sie können CW aber auch über die Tastatur 
eingeben oder parallel dazu die Taste am Gameport nutzen. 
 
Schließen Sie die Taste so an : 
 
Gameport : 
 

 
 
 

Parallele Schnittstelle :  
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5.3 FAX-Empfang (FAX Receiving) 
 
Für Informationen über HF-FAX-Stationen und die Theorie empfehlen wir : 
http://www.hffax.de/HF_Fax/HF-Fax_Schedules/hffax_schedules.htm 
 
Die aktuelle Version von MixW unterstützt nur den FAX-Empfang. Die folgenden Prozeduren 
unterstützen Sie beim FAX-Empfang mit MixW : 
 
Stellen Sie Ihren Transceiver auf USB und stimmen Sie auf eine Frequenz der FAX-Stationen nach 
der obigen Liste ab. Schalten Sie mit  View >  Spectrum auf Sound  und wählen Sie den Wasserfall. 
 
Schalten Sie mit dem Menü View die verschiedenen Balken ab, damit Sie ein größeres Fenster für ein 
einlaufendes FAX bekommen. 
 
Stimmen Sie auf den Pilotträger bei 2400 Hz ab und setzen Sie den FAX-Cursor 400 Hz tiefer. Sie 
überstreichen dann den Bereich von 1500 Hz für schwarz und 2400 Hz für weiß. Wenn Sie den Cursor 
höher setzen (in Richtung weiß) wird das Bild heller und tiefer (in Richtung schwarz) wird das Bild 
dunkler. 
Warten Sie auf den Beginn des nächsten Bildes, um das Bild auf dem Schirm zu zentrieren. 
  
Die meisten Wetter-FAX-Stationen arbeiten mit 120 lines/min (Umdrehungsgeschwindigkeit der 
Trommel), dieser Wert muß aber mitunter korrigiert werden, um Abweichungen Ihres PC-Takts zu 
kompensieren. Gehen Sie über  Mode > FAX zu Mode > Mode settings oder klicken Sie auf das 
FAX-Feld im Statusbalken. Jetzt können Sie den Wert für Linien/min (your lines/min) eingeben: 
 

 
 

 
 
Wollen Sie das FAX ausdrucken, wählen Sie ein Capture-Programm oder drücken Sie auf die Taste 
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zum Bildschirmausdruck , um das Bild in die Zwischenablage zu kopieren. Sie können es dann mit 
einem Bildbearbeitungsprogramm z.B. MS Paint ausdrucken. 
 
Dieses Bild stammt von einer gut zu empfangenden Wetter-FAX-Station : 
  
 

 
 
 
Beachten Sie, dass das Bild nicht genau abgestimmt ist,  der linke Bildrand liegt in der Mitte. Wollen 
Sie ein falsch abgestimmtes Bild korrigieren, klicken Sie auf eine vertikale Linien im Bild, die die linke 
Bildbegrenzung abgeben soll (siehe Mauszeiger im oberen Bild). MixW gleicht dann das Bild neu ab 
und gibt es wie gewünscht wieder :  
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5.4 Hellschreiber-Einführung und Theorie 
(Hellschreiber Intro and Theory)  
  

By Murray Greenman, ZL1BPU 
 

5.4.1 Feld-Hell 
Hellschreiber wurde 1929 patentiert und wird immer noch im Originalformat verwendet. Hellschreiber 
war das erste erfolgreiche Direktdruck-Übertragungssystem und es war sehr populär als 
Fernschreiber noch komplex und teuer waren. Ein Hellschreiber hatte nur zwei bewegte Teile. Zuerst 
wurden Hellschreiber bei drahtgebundenen Pressediensten bis in die 80er Jahre verwendet. Die erste 
militärische Version wurde von der deutschen Legion Condor im spanischen Bürgerkrieg ab 1933 
eingesetzt. Im 2. Weltkrieg wurden Hellschreiber für den mobilen Feldeinsatz genutzt und erwiesen 
sich als sehr zuverlässig und robust. Der Begriff „Feld-Hell“ stammt aus dieser Zeit und dient der 
Unterscheidung gegenüber anderen Varianten der Hellschreiber. 
 
Jedes Zeichen einer Feld-Hell-Aussendung besteht aus einer Serie von Punkten (Pixeln) , die in einer 
Matrix angeordnet sind ähnlich wie bei einem Matrixdrucker. Die Punkte werden in einer Serie als 
aufeinanderfolgende Zeilen von unten nach oben und von links nach rechts gesendet. 
Das folgende Bild zeigt die Zeichen BCDE . Jeder Bildpunkt innetrhalb des Zeichens hat dabei eine 
XY-Adresse bestehend aus Spalte und Zeile. Die gesendete Reihefolge ist A1, A2, A3... A7, B1, B2... 
usw. 
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Die Bildpunkte sind entweder weiß (kein Signal) oder schwarz (Signal vorhanden). Zwischen den 
Zeichen werden leere (weiße) Punkte eingefügt. Wenn Sie die Gesamtpunktzahl mit den gesendeten 
schwarzen Punkten vergleichen, kommen Sie auf einen Lastfaktor von etwa 22%. Das Verhältnis 
Spitze zu Durchschnitt ist hoch, so daß auch unter gestörten Bedingungen eine gute Lesbarkeit 
erreicht wird. 
150 Zeichen werden je Minute gesendet. Jedes Zeichen benötigt 400 ms. Jedes Zeichen besteht aus 
49 Punkten (pixel), jedes Pixel ist 8.163ms lang. Die effektive Baudrate ergibt sich zu 1/8.163 ms = 
122.5 Baud und es werden 2.5 Zeichen/sek oder etwa 25 WPM gesendet.  
Die originalen Feld-Hell-Geräte und die besten Softwareimplementationen senden zwei Pixels (jeweils 
von halber Höhe und halber Dauer) anstelle eines Pixels im Diagramm, um die vertikale Auflösung zu 
verbessern. Wenn Sie sich das obige Diagramm genau ansehen, sehen Sie diese Eigenschaft und 
auch, warum die Bandbreite dabei nicht erhöht wird. Rudolf Hell entwarf den Font so, daß ein 
einzelnes halbes Pixel  nie gesendet werden muß. Z.B. ist die rechte Seite des B in der Auflösung 
durch eine Verschiebung des Pixels in voller Höhe um eine halbe Pixelhöhe verbessert worden. Drei 
Pixel mit halber Höhe werden ohne Pause gesendet, so daß die Bandbreite dabei nicht vergrößert 
wird. 
 
Beim Entwurf des Systems wurde darauf geachtet, daß die Impulslänge nie kürzer als 8 ms ist. 
Kürzere Halb-Pixel werden nicht gesendet, da sie durch die Anstiegszeit des Senders stark verzerrt 
und sowohl eine höheren Bandbreitebedarf als auch Schwierigkeiten beim mechanischen 
Druckhammer hervorrufen würden. 
Eine weitere Technik bei der Verringerung des Bandbreitenbedarfs ist die Verwendung von sorgfältig 
geformten Punkten nach dem “raise cosine”-Profil. Würden die Signale hart getastet, würden die 
Tastfrequenz von 122,5 Hz eine Bandbreite von mehr als 500 Hz zu beiden Seiten des Trägers 
erzeugen. Das Bild zeigt ein „raised cosine“Signal in einer realen Aussendung, erst zwei Pixel-Paare, 
dann eine Gruppe von Pixeln. Achten Sie auf die Form der Punkte, beide Punkte sind genau 
identisch. Das Signal belegt eine Bandbreite von 245 Hz und wäre ohne die Impulsformung wesentlich 
breiter.  
 

 
 
Das “raised cosine”-Profil moduliert den Träger mit einer 122.5 Hz-Sinuswelle zu einem 
100%modulierten Träger. Im Ergebnis entstehen zwei Seitenbänder jeweils 122.5 Hz zu beiden Seiten 
anstelle eine breiten impulsmodulierten Signals.  
 
Die Ausgänge der Armee-Feld-Hell-Maschinen lieferten einen getasteten 900 Hz –Ton, der zu einem 
Telefon oder einem Sendermodulator gingen. Manche Geräte hatten einen direkten CW-Tastausgang. 
Feld-Hell  wird wie  Morse als CW oder MCW amplitudengetastet. Jedem Pixel in der Punktmatrix wird 
nach einem festen Schema als CW-Punkt gesendet. Wenn nichts gesendet wird, gibt es keinen 
schwarzen Punkt. Feld-Hell ist in der Realität ein einfacher Facsimile-Modus. Das frühere 
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Pressesystem F-Hell war damit identisch nur mit dem Unterschied, daß es mit 245 Baud (5 
Zeichen/Sekunde) lief.  Eine asynchrone Variante GL-Hell verwendete einen festen Startblock links 
von jedem Zeichen, ist aber für Amateuranwendungen uninteressant. Ein exzellenter Artikel über Feld-
Hell beschreibt die mechanischen Methoden zum Empfang und Senden und ist zu finden im Ham 
Radio Magazine, December 1979. Ein Artikel, der die Zeichensätze (Fonts) von Hell beschreibt und 
weitere nützliche Informationen enthält, steht in der Radcomm, April 1981. Die vom bejahrten G5XB  
beschriebene Maschine befindet sich jetzt im Besitz von Ian, G4AKD. Die Siemens-A2-
Armeemaschine wird im Detail auf der Feld-Hell-Geschichtsseite beschrieben. 
 
Informieren Sie sich den verschiedenen HELL-Formaten unter  Murray's Website on Fuzzy modes. 
 
Leistungsfähigkeit 
Feld-Hell geht sehr gut, wenn der Pfad stabil (wenig Fading) und das Signal gleich oder besser ist als 
der normale Rauschpegel. Wird das Signal in einer Grauskala wiedergegeben (siehe oben), ist es 
deutlich besser bei einem niedrigen S/N zu lesen. Feld-Hell ist gegen Störungen ziemlich immun, kann 
aber durch CW-Signale auf der Frequenz erheblich gestört werden. 
 

5.4.2  Hellschreiber-Betrieb (Hellschreiber Operation) 
 

Hellschreiber ist eine alleinstehende Sendeart. Man kann durchaus behaupten, sie wäre keine digitale 
Sendeart. Da aber in erster Linie digitale Technik benutzt wird, um in HELL zu funken, wollen wir sie 
doch unter den digitalen Sendearten einordnen. Es hat einen mehr chirpenden Klang als die anderen 
älteren Digimodes. Der Empfang von HELL ähnelt mehr einem FAX-Bild, die empfangenen und 
gesendeten Zeichen sind eher Bilder von Zeichen. 
 
Hellschreiber ist eine Schmalbandsendeart ähnlich PSK31 und Sie benötigen die gleichen 
Transceivereinstellungen. Sehen Sie zum Vergleich unter  PSK31-Betrieb nach. 
 
Schalten Sie auf Hellschreiber mit Mode > Hellschreiber oder klicken Sie auf das Sendeartenfeld im 
Statusbalken und dann auf Hellschreiber im Menü. Anschließend wählen  Sie mit  Mode > Mode 
settings die benötigten Parameter :  
 
 

 
 

Die TX- and RX-Frequenzen ergeben sich aus der aktuellen Cursorstellung. Empfohlen werden Werte 
um 1500 Hz in der Mitte des Paßbandes. 
 
Filter: Sie können ein Software-DSP-Filter zwischen 100 und 250Hz wählen. Ein optimaler Wert ist 
200 Hz, Sie können die Einstellung aber je nach den Empfangsbedingungen variieren. 
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RX scale: Mit der Empfangsskala können Sie die Zeichen mit x2 auf das Doppelte dehnen und 
dadurch schwer lesbare Zeichen u.U, besser lesen. Es geht aber weniger auf den Schirm, so daß Sie 
die Skala auf x1 setzen sollten. 
 
Font Selection; Sie können vier verschiedene Zeichensätze vorwählen und mit einem Klick auf die 
Font-Nummer einschalten. Sie können nur den ausgesendeten Zeichensatz wählen, der empfangene 
wird durch die Gegenstation vorgegeben. Sie sehen aber imFenster “Font sample”, wie Ihr 
Zeichensatz aussieht. 
 
Hier sehen Sie eine Bildschirmkopie eines Hellschreiber-QSOs : 
  
 

 
 

Hellschreiber verwendet den gleichen Diamant-Cursor wie PSK31 und die Bandbreite ist entspricht 
etwa der von PSK. Der empfangene Text wird in Doppel- oder Dreifachlinien ausgegeben.  
Wenn Sie das Log und andere Balken vom Schirm abschalten, bekommen Sie mehr Text auf dem 
Bildschirm unter. 
 
Hellschreiber-Empfang : 
Setzen Sie den Cursor in das Zentrum des Signals mit einem linken Mausklick. Der Text erscheint 
dann als HELL-Streifen im Empfangsfenster. 
 
Hellschreiber-Senden : 
Um eine Station anzurufen, stimmen Sie wie oben beschrieben ab. Sie können bereits Text im TX-
Fenster voschreiben. Klicken Sie zum Senden auf die TX/RX-Taste oder drücken Sie die 
Pause/Break-Taste oder klicken Sie auf das RX-Feld im Statusbalken. Der Text aus dem 
Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-Fenster. Nach Druck auf 
die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der letzten Zeichen wieder auf 
Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab. Sie können den Ablauf mit 
Macros automatisieren. Siehe Macros erzeugen (Configuring Macros) 
 

5.5 MFSK 
  

5.5.1 MFSK-Einführung und Theorie  
(MFSK Intro and Theory) 

 
von  Murray Greenman, ZL1BPU 
 
 
MFSK sendet digitale Daten unter Verwendung von Mehrfachtönen. Die Zweitontechnik 
von RTTY wird auf mehrere Töne erweitert, wobei nicht immer aber meistens nur ein Ton zur gleichen 
Zeit gesendet wird. 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 112 von 155 Übersetzung von Eike,DM3ML 

 
MFSK heißt Multi–Frequency-Shift-Keying (Multifrequenzumtastung) und darf nicht mit MSK (Minimum 
Shift Keying) verwechselt werden. Es gibt eine Anzahl von verschiedenen Techniken, die parallel 
gesendete Töne, sequentiell gesendete Töne (einer nach dem anderen) und eine Kombination davon 
verwenden. MT-Hell sendet Töne entweder parallel oder sequentiell, DTMF sendet immer zwei Töne 
parallel und Piccolo und Coquelet sind, obwohl sie Tonpaare verwenden, definitiv sequentiell. 
 
MFSK-Sendungen haben einen typischen Klang, meist musikalisch, Piccolo und Coquelet haben ihren 
Namen vom Klang bekommen (Coquelet = Hahn).  
 
MFSK verwendet relativ geringe Abstände zwischen den Tönen, so daß bemerkenswerte Datenraten 
bei einer vorgegebenen Bandbreite erreicht werden. 64 bps bei einer Signalbandbreite von 316 Hz 
sind typisch. Das folgende Bild zeigt das Spektrogramm eines MFSK-16-Signals mit 16 Trägern bei 
einem Abstand von 15,625 Hz und einer Baudrate von 15,625 Bd. Die Übertragung läuft mit 62,5 bps 
(etwa 80 Worte/Minute !) und belegt 316 Hz Bandbreite. Die zwei schwarzen horizontalen Linien 
liegen bei 1000 Hz und 1300 Hz und die horizontale Skala geht über etwa 20 Sekunden. In dieser 
kurzen Sendung werden 120 Zeichen übertragen. MFSK16 arbeitet mit FEC (Vorwärts-
Fehlerkorrektur), so daß die Nettorate bei 42 WPM (31,25 bps) liegt. 
 

 

 
Fig. 1. Spectrogram of an MFSK16 Signal 

 
 
Vorteile : 
 
MFSK hat einige Vorteile :  

• Hohe Unterdrückung von Impuls- und Breitbandstörungen wegen der schmalen 
Empfangsbandbreite je Ton  

• Niedrige Baudrate bewirkt hohe Empfindlichkeit und Unterdrückung von 
Mehrwegausbreitung > Datenbitrate ist höher als die Symbolbaudrate 

• Konstante Sendeleistung  
• Toleranz gegenüber Ionosphäreneffekten wie Doppler, Fading und Mehrwegausbreitung 
• Bei allen MFSK-Systemen steigt die Fehlerrate mit der Anzahl der Töne, mit 32 Tönen 

fällt die Leistungsfähigkeit deutlich ab. Bei PSK-Systemen läuft es anders herum 
  

 
Nachteile : 
MFSK hat – ehrlich gesagt – auch Nachteile  : Bei der schmalen Bandbreite der einzelnen 
Tondetektoren und ihrem geringen Abstand kann Drift ein Problem werden und eine genaue 
Abstimmung ist Voraussetzung für die Funktion. Gute Abstimmindikatoren und eine AFC sind bei 
niedrigeren Geschwindigkeiten nötig. Die Frequenz des Transceivers muß sehr stabil sein und die 
Differenz zwischen Sende- und Empfangsfrequenz sollte geringer als 5 Hz sein. 
MFSK benötigt mehr Bandbreite für einen gegebenen Text im Vergleich zu 2FSK- oder PSK-
Systemen, aber es ist robuster als diese.  
 
 
Kodieralphabet : 
Es gibt mehrere Wege, das Alphabet zwischen Tastatur und Aussendung zu kodieren. Der 
bekannteste Weg ist der ASCII-Kode (ITA-5) mit 7 oder 8 Bit-Zeichen oder der TTY-Kode (ITA-2) mit 
5-Bit-Zeichen. MFSK16 und PSK31 basieren auf einem Varicode, der einem Zeichen eine variable 
Anzahl an Bits zuordnet. Oft benutzte Zeichen sind kurz, selten benutzte lang, ähnlich wie beim 
Morsealphabet, z.B. : 
 

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 113 von 155 Übersetzung von Eike,DM3ML 

Zeichen   Varicode 
  ZWR    100 
  a          101100 
  e          1100 
  E          111011100 
  Z          101010110100 

 
Die Leistungsfähigkeit hängt vom gewählten Kode und beim Varicode auch noch vom Text ab (kleine 
Buchstaben haben einen kürzeren Code als große (DM3ML)) : 
 
  Alphabet Bits/Zeichen  
  ITA-5 ASCII 10  
  ITA-2  7.5  
  Varicode ~ 7-8 

 
Die Stärke des Varicodes ist, daß das Alphabet beliebig erweiterbar ist. Die europäischen Zeichen 
sind festgelegt und weitere Steuerzeichen wurden hinzugefügt, die außerhalb der Zeichenmenge 
liegen. Der MFSK16-Varicode ist nicht der gleiche wie bei PSK31, aber die Technik ist die gleiche. 
Mit dem Varicode kann ein Datenstrom nach einem Fehler wesentlich schneller resynchronisiert 
werden (DM3ML : Code ‘00’ am Ende jedes Zeichens, ‘00’ tritt innerhalb nie auf ) und die 
Datenverluste werden minimiert. 
 
Textdurchsatz :  
Den Nutzer interessiert am meisten, wieviel Text er pro Zeiteinheit übertragen kann. Diese Rate wird 
als Zeichen/Sekunde (characters/second) oder Worte/Minute (WPM) angegeben. Beides hängt vom 
verwendeten Alphabet und der durchschnittlichen Wortlänge ab. In Englisch wird ein Wort zu 5 
Zeichen + 1 Zwischenraum angenommen. Gerechnet wird mit : 
 
CPS = Nutzerdatenrate/ Bit je Zeichen  
WPM = CPS x 60 / Buchstaben je Wort  

 
Arbeitsbeispiel :  

 
MFSK-System mit 16 Tönen (16FSK) bei 15.625 Baud mit FEC-Rate = ½ und einem ASCII-
Alphabet mit 10 bits/Zeichen :   
 
Symbolrate            = 15.625 baud 
Kanaldatenrate      = 15.625 x log216 = 15.625 x 4                = 62.5   bps 
Nutzerdatenrate         = 62.5 x 1/2 (FEC RATE)                       = 31.25  bps 
Textdurchsatz in CPS   = 31.25 / 10 CPS                          =  3.125 CPS 
Textdurchsatz in WPM  = 31.25 x 60 / (10 x 6)                  = 31.25  WPM 
Benötigte Bandbreite  = 16 x 15.625 = 250 Hz.  
 

Vergleiche :  
Amateur-Radio RTTY arbeitet mit  45.45 Baud und erreicht 60 WPM ohne Fehlerkorrektur und 
benötigt 300 Hz Bandbreite. Packet mit 300 Baud ist fehlerkorrigiert, aber für HF-Bedingungen 
ungeeignet. liefert selten mehr als 30 WPM und benötigt 1 kHz Bandbreite. PSK31 arbeitet mit 
31,25 Baud, ist bei QPSK fehlerkorrigiert und überträgt 31,25 WPM bei einer Bandbreite von 
weniger als 100 Hz. 
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Fig. 5. Rohdatenrate verschiedener Digimodes über der Bandbreite  
 
Ihrer Leistungsfähigkeit nach sind nur MFSK16 und PSK31 praktisch für DX-QSOs geeignet. PSK31 
geht schlecht auf dem langen Weg, die FEC bringt kaum Verbesserung und wird meist nicht 
verwendet. MFSK16 ist ähnlich empfindlich wie PSK31 in der Praxis, unempindlich gegen 
Dopplereffekte, hat wenig Probleme mit Überlagerungen und hat eine effektive FEC. Die Ergebnisse 
wurden in Ionosphären-Simulationstests gewonnen. 
 
 

5.5.2 MFSK16 in der Praxis  
 
 
Die neue Sendeart MFSK16 enthält kontiunierliche Phasentöne und andere Verbesserungen speziell 
auf der Empfängerseite. Die Sendeart ist lose mit Piccolo verwandt, hat aber folgende wesenliche 
Unterschiede : 

• Die gesendeten Daten sind nicht zeichen- sondern bitoriientiert. 
• Das Grundsignal ist ein einzelnes Symbol, kein Symbolpaar 
• Eine Kodierung zur Fehlerreduzierung ist eingebaut 
• Tonabstand und Bautrate sind Teile von 125.2  
• Die gesendeten Töne sind phasensynchron mit  CPFSK 
• Es wird keine weitere Symbolphase oder AM-Information gesendet 

 
Es ergeben sich folgende Gesichtspunkte :  
 

• Das System kann dadurch jede Art von Text und binären Daten senden, jedes Alphabet 
mit Varicodes verwenden und es erlaubt eine Fehlerkodierung 

• Die Töne und Baudraten (15.625 Hz, 31.25 Hz usw.) wurden für einfache PCs mit 
Soundkarten bei einer Abtastrate von 8 kHz gewählt.  

• Der Sender muß nicht unbedingt linear sein. Beim Empfänger wird FFT verwendet, um 
die Trägerphase zu bestimmen und davon die Symbolphase abzuleiten. Diese Technik ist 
sehr schnell und zuverlässig. 

 
MFSK16 ist computerorientiert und kein elektromechanisches System. Es kann einfach installiert 
werden und  ist einfach zu bedienen. Es gibt keine Kompromisse bezüglich der Leistungsfähigkeit. 
 

• Genaue Abstimmung mit der Maus mit einem Klick  
• Faltungskode (Convolutional code) für die FEC (Vorwärtsfehlerkorrektur) mit 

Verschachtelung (interleaver) zur Fehlerreduzierung   
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• FFT (Fast Fourier Transformation) zur Symbolrückgewinnung   
• Wiederherstellung der Synchronisation durch Messung der Phasenübergänge in der 

Trägerphase im FFT-Symboldetektor 
• Zwei Signalisierungsgeschwindigkeiten mit einer unterschiedlichen Anzahl von Tönen bei 

gleicher Bandbreite zur Anpassung an die Bedingungen 
 

Der MFSK-Varicode ist etwas effektiver als andere Codes, aber es sind auch kleinere Code-Sätze 
verwendbar. Die Kombinationen "000", "0000" usw. müssen nicht für den Leerlauf reserviert werden 
und können innerhalb des Bitstroms genommen werden. Lediglich die Kombination "001" ist verboten, 
da sie das Ende eines und den Anfang des nächsten Zeichens markiert. Ein normaler Text wird etwa 
20% schneller übertragen als mit dem  G3PLX-Varicode. Die durchschnittliche Bitzahl je Zeichen 
wurde mit 7,44 gemessen, so daß MFSK16 auf 42 WPM bei einer Baudrate von 31.25 Baud kommt.  
 
Hinweis : Murray, ZL1BPU, hat eine vorzügliche Website mit viel weiteren Informationen zu MFSK16 
und damit verwandten Sendearten. Sie können hier sehr viel über diese faszinierenden neuen 
Sendearten lernen.  
 
MFSK, "The official MFSK website" Murray Greenman, ZL1BPU. 
http://www.qsl.net/zl1bpu/MFSK/ 
 
 

5.5.3 MFSK-Betrieb 
 
MFSK16 verwendet etwa die gleiche Bandbreite wie RTTY mit einer Shift von 170 Hz. Sie können Ihre 
RTTY-Einstellung am Transceiver etwa so lassen wie bei RTTY. 
 
Transceiver-Einstellung : 

 
Feinabstimmung : Benutzen Sie die Feinabstimmung an Ihrem Transceiver, wenn er darüber 
verfügt. Sie werden aber schnell finden, daß die eigentliche Abstimmung nicht mehr mit dem VFO 
gemacht wird. Ihr Transceiver muß eine Frequenzstabilität von einigen Hertz aufweisen, ältere 
Transceiver sind mitunter nicht stabil genug. Verfolgen Sie die Änderung der NF-Frequenz durch 
die AFC im Statusbalken, notieren Sie den Wert beim Start des QSOs und prüfen Sie, ob Ihre 
Station oder die Gegenstation driftet. 
 
Processor/Compressor:  AUS ! Bei MFSK16 nicht verwenden ! 
 
Pre-Amp: Schalten Sie den Vorverstärker nur zu, wenn sie auf eine sehr leise Station hören. Oft 
haben Sie dann größere Probleme mit starken Nachbarstationen  
 
USB:  Sie können bei MFSK16 die Töne invertieren und mit LSB arbeiten. 
 
VOX: Hängt davon ab, wie Sie Ihren Sender einschalten. 
 
Filter: Mit einem breiten Filter haben Sie eine größere Übersicht über das Stationsangebot, Sie 
können aber Probleme bei starken Signalen haben, die dieGesamtverstärkung über die AGC 
herunterregeln. Ein schmales Filter (CW-Filter) kann in manchen Situationen den Empfang 
wesentlich verbessern. Informieren Sie sich im Handbuch Ihres Transceivers, wie Sie die meist 
primär für CW eingebauten schmalen Filter bei SSB einschalten können. (Tip DM3ML : Sie sehen 
die Wirkung eines schmalen Filters unmittelbar im Wasserfall).   

 
MixW-Einstellung  
 

Mode muß auf MFSK gesetzt werden. Klicken Sie auf das Sendeartenfeld im Statusbalken und 
wählen Sie MFSK. Gehen Sie dann zu Mode > Mode Settings., der schnellste Weg geht auch 
hier über den Statusbalken. Dieses Fenster wird geöffnet :  
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Die TX- und RX-Frequenzen ergeben sich aus der aktuellen Cursorposition im Spektrumfenster. Ich 
empfehle Werte um 1500 Hz in der Mitte des Durchlaßbereichs. Sie sollten die AFC immer auf ON 
setzen, denn die MFSK-Abstimmung ist kritisch. Der Squelch und die Squelchschwelle können je nach 
Wunsch und zur Untedrückung von Datenmüll zugeschaltet werden, mitunter gehen aber Zeichen 
verloren. Die MFSK-Töne können invertiert werden, wenn Sie einen Haken in die entsprechende Box 
machen. 

 
Inversion: Bei dieser Einstellung unterscheidet sich MixW von den meisten anderen Soundkarten-
Digimodeprogrammen. Bitte lesen Sie den folgenden Text aufmerksam durch, um Irrtümer zu 
vermeiden.  
 
"Inverted" heißt, daß die Lage der Mark- und Space-Töne gegenüber der normalen Lage vertauscht 
wird. Sie benötigen diese Funktion, wenn Sie eine Station mitschreiben oder arbeiten wollen, die 
invertiert arbeitet.  
 
Zur Erklärung : In allen Modes hat unabhängig von der Seitenbandwahl der MARK-Ton (=Strom) die 
höhere Frequenz. Der SPACE-Ton (=kein Strom) liegt um die SHIFT (meist 170 Hz) tiefer. Bei 
traditionellen Hardware-TNCs wird RTTY immer in der LSB-Lage gemacht, um die richtige MARK-
Lage zu erzeugen. Wird MixW analog dazu auf  "RF, LSB" eingestellt, ist der MARK-Ton der jeweils 
höhere Ton. Wird MixW auf  "RF, USB" gesetzt hat der MARK-Ton die tiefere Frequenz, das Signal 
wird invertiert.   
Wenn Sie die CAT-Funktionen von MixW verwenden, weiß MixW, welche Seitenbandlage sie am 
Transceiver eingestellt haben. Sie können auf View > Spectrum | Auto schalten und die richtige 
Seitenbandlage wird automatisch eingestellt. Sie können – falls benötigt -  mit Mode > Inverted  in die 
invertierte Lage umschalten. 
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MixW berücksichtigt automatisch die Einstellung auf USB oder LSB und liest die am Transceiver 
eingestellte Frequenz aus. Die Frequenzskala im Wasserfall und die Frequenzanzeige stehen an der 
richtigen Stelle und die Audio-Offset wird je nach Seitenbandeinstellung der Trägefrequenz 
hinzuaddiert (USB) oder von ihr abgezogen (LSB), Falls Sie die CAT nichtverwenden, tragen Sie die 
eingestellte Frequenz und die Seitenbandlage manuell im Menü ein. 
 
MFSK abstimmen  : 
 
Die MFSK-Stationen treffen sich um 14.080 MHz. Sie erkennen das Signal an der Melodie. Es ähnelt 
einem RTTY-Signal, aber mit mehreren und nicht gerade musikalischen Tönen (DM3ML : Es hört sich 
an, wie ein verwimmerter unstabiler Träger). Im Wasserfall sehen Sie ein MFSK16-Signal : 
  

 
 
Die MFSK-Töne sind über die Bandbreite verteilt. RTTY hat im Gegenteil dazu die festen Lagen von 
MARK und SPACE. MFSK16 benötigt auch etwas mehr Bandbreite. Setzen Sie Ihren Cursor in die 
Mitte des MFSK-Signals und machen Sie die Feinabstimmung mit CRTL (Strg)+Pfeiltasten 
links/rechts., bis der Text mitgeschrieben wird und die AFC einrastet. MFSK ist etwas mühsamer 
einzustellen als RTTY oder PSK. Es dauert auch eine Weile, bis der Text kommt. Er wird in Paketen 
zu mehreren Zeichen und nicht laufend ausgegeben. (Tip DM3ML : Am Beginn jeder MFSK-Sendung 
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wird für eine kurze Zeit ein Träger in der MARK-Lage gesendet. Schieben Sie den linken Cursor im 
Wasserfall auf diese Linie). 
 
 
Senden : Wenn Sie auf Senden schalten wollen, drücken Sie die Pause/Break-Taste, klicken Sie auf 
das RX-Feld im Statusbalken oder verwenden Sie im Menü Options | RX oder Options | TX.).  
 
Auch unter MFSK können Sie mehrere RX-Fenster öffnen und Ihre Daten ins Hauptfenster (Swap) 
holen.  
 

5.5.4 MFSK-Bildübertragung (MFSK Image Mode) 
 
Hinweis :   Die Methode zum Senden von kleinen Bildern in MFSK16 unter MixW ist zur Zeit in den 
USA auf den HF-Bändern noch nicht legalisiert. Die folgende Webseite von Mark Miller, N5RFX, 
erklärt den Zusammenhang und was Sie tun können, die Bilder unter den FCC-Regeln zu legalisieren 
. http://www.kramrellim.com/~markm/mixw_fcc.html 
 
Unter MFSK ist es möglich, auf eine Schmalbandbildübertragung umzuschalten, ohne daß der 
Operator die Sendeart MFSK beim Senden oder Empfangen verlassen muß. 
Die Bilder sollten klein und nicht größer als  250 x 200 Pixel sein. Das Senden wird vereinfacht, wenn 
das Bild im MixW-Verzeichnis zu finden ist, es muß aber nicht dort stehen. 
 
Die sendende Station sollte die Gegenstation informieren, daß sie ein Bild senden will (DM3ML : die 
Umschaltung geschieht aber automatisch). Die sendende Station wählt  File | Send Picture  und dann  
B/W (schwarz/weiß) oder Color (Farbe) . Eine Dialogbox öffnet sich :  
 

 
 

Hinweis : B/W oder Color beziehen sich nur auf die Sendemethode. B/W  wird in einer kürzeren Zeit 
gesendet als Color. 
 
Wählen Sie das zu sendende Bild als *.bmp oder *.jpg aus und klicken Sie auf Open, um das Bild zu 
senden.   
Auf dem RX-Schirm der sendenden Station erscheint ein Icon mit einem Kopf während das Bild 
gesendet wird. Erscheint anstelle des Icon ein ‚X’ kann MixW das Bild nicht senden, weil es entweder 
die Datei nicht findet oder der Dateityp nicht stimmt. 
Auf dem Bildschirm der empfangenden Station erscheint das Bild in einem sich automatisch öffnenden 
getrennten und auf dem Bildschirm verschiebbaren Fenster, das sich ähnlich wie bei SSTV 
zeilenweise füllt.  Mit einem rechten Mausklick kann das Bild auf einem wählbaren Platz abgespeichert 
werden. 
Nach der Bildübertragung schalten beide Stationen zurück in den MFSK-Textmodus. 
Hinweis DM3ML : Der Bildmodus in MFSK unterscheidet sich akustisch deutlich vom Textmodus. 
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Bei der empfangenen Station erscheint das gleiche Icon im RX-Fenster und das dazugehörende Bild 
erscheint in der oberen linke Ecke des Schirms. Es ist aber vetrschiebbar. :  
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Wenn die Übertragun beendet ist, öffnet sich ein Menü mit dem der OP Save Picture. wählen und das 
Bild an einer gewünschten Stelle abspeichern kann :  
. 
 
 

 
 

Nach der Bildübertragung schalten beide Stationen zurück in den MFSK-Textmodus. 
 
Macros zum Senden von MFSK-Bildern : 
 
Unter MixW sind drei Macros für die Bildübertragung vorgesehen : 
 

• <PIC?N>  : öffnet wie  File | Send Picture... | B/W... die Dialogbox und sendet das Bild in 
schwarz/weiß 

• <PIC?N%C> :  öffnet wie  File | Send Picture... | Color die Dialogbox und sendet das Bild in 
Farbe 

• <PIC:filename.ext> : sendet das Bild in Farbe, z.B. <PIC:dm3ml.jpg>, das Bild dm3ml.jpg. 
• <PIC:filename.ext%2000> sendet das Bild in hoher Auflösung und in schwarz/weiß 
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5.6 MT63 
 

5.6.1 MT63-Einführung und Theorie (MT63 Intro and Theory) 
 
von Murray Greenman, ZL1BPU 
 
MT63 ist eine fortgeschrittene Sendeart für Kurzwelle, die auf DSP basiert. Sie ist gedacht für 
Verbindungen von Tastatur zu Tastatur unter schlechten Bedingungen. MT63 setzt eine Reihe von 
revolutionären Ideen ein und ist technisch sehr komplex. Das Arbeiten mit MT63 ist nicht schwieriger 
als mit RTTY und man kann es einfach abstimmen. Es hat eine deutlich bessere Leistungsfähigkeit als 
andere Sendearten, speziell dann wenn die Signale sowohl schwach als auch unstabil sind. 
 
Einfache Beschreibung : 
Zum Kodieren der über die Tastatur eingegebenen Zeichen werden 64 verschiedene Töne moduliert 
und der Erfinder von MT63, Pawel Jalocha, SP9VRC , hat eine große Anzahl von Daten zu jedem 
Zeichen hinzugefügt. Der Empfangsdekoder kann dadurch ein Zeichen zweifelsfrei erkennen, auch 
wenn nur 25% der Information angekommen ist. Diese Technik wird als FEC (Vorwärtsfehlerkorrektur) 
bezeichnet, aber MZ53 hat weitere Vorteile. Im Gegenteil zu den meisten anderen HF-Sendearten, bei 
denen ein Zeichen durch einen einzelnen Störimpuls verfälscht werden kann, ist MT63 sehr robust, da 
es ein Zeichen sowohl über mehrere Töne als auch über mehrere Sekunden verteilt, um 
Kurzzeitstörungen auszuschließen. Für jeden einzelnen Ton ist die Übertragungsrate relativ gering, so 
daß ionosphärische Störungen einen geringen Einfluß haben. Trotz der niedrigen Datenrate wird aber 
eine gute Textgeschwindigkeit erreicht, da der Text über mehrere Töne zur gleichen Zeit gesendet 
wird. Das System kann je nach Bedingungen mit verschiedenen Geschwindigkeiten laufen, aber eine 
Rate von 100 WpM, wesentlich schneller, als Sie auf der Tastatur tippen können, ist typisch. 
 
MT63 hört sich etwas ungewöhnlich an, etwa wie ein blubberndes Rauschen oder eine unrund 
laufende Maschine, aber die Leistungsfähigkeit ist spektakulär. Es wird kein Connect hergestellt wie 
bei Pactor, Amtor oder Packet. Einige Nutzer finden, daß es bei schlechten Bedingungen besser 
funktioniert als Pactor II oder Clover, bei guten Bedingungen ist dieser Vorteil geringer. Die Sendeart 
ist geeignet für Netze und Zufalls-QSOs, es muß kein Link hergestellt werden. MT63 ist immuner 
gegen Störungen als andere Sendearten. Die Tastenübergabe von RX zu TX und andersherum 
dauert länger als bei anderen Sendearten. 
 
MT63 hat auch Nachteile. Es ist breiter als andere Sendearten und ziemlich aggresiv, d.h. es erzeugt 
Störungen bei anderen Sendearten, wird aber selbst von diesen wenig gestört. Wegen der 
Verzögerung durch die FEC und die Verschachtelung der Zeichen dauert das Einrasten beim Start 
und die Tastenübergabe relativ lang, so daß für ein schnelles Hin und Her im QSO nicht geeignet ist. 
 
Über breite Sendearten : 
MT63 unterscheidet sich deutlich von den traditionellen Amateurdigimodes und auch von den 
neueren. MT63 ist sowohl breit als auch relativ langsam. Es erzeugt seine Leistungsfähigkeit durch die 
Verteilung des Signals in Raum und Zeit, es ist aber keine „Spread spectrum“-Sendeart. MT63 hat 
einige Probleme gehabt, einen Platz im Bandplan zu finden, weil es ein breiteres Signal für eine 
gegebene Datenrate benötigt als andere Sendearten. Wählen Sie Ihre Frequenz sorgfältig !  
 
Hinweis : Murray hat eine exzellente Website mit viel mehr Information zu MT63 und verwandten 
Sendearten. Sie stellen eine gute Quelle dar für jeden, der sich weiterbilden will : 
http://www.qsl.net/zl1bpu/MT63/MT63.html 
 
  

5.6.2 MT63-Betrieb (MT63 Operation)  
 
Sie können jetzt MT63 wie die anderen Digimodes mit einem Mausklick abstimmen (früher mußte es 
mit dem VFO eingestellt werden). Die NF-Frequenz für MT63 liegt fest, kann aber mit Mode > Mode 
Settings  geändert werden :   
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Die Startfrequenzen für TX and RX legen den Begfinn des Abstimmbereichs im Wasserfall fest. 
Lassen Sie sie am besten so, wie sie voreingestellt sind, es sei denn, es gibt Gründe sie zu ändern. 
 

 
Transceiver-Einstellung : 
 
Feinabstimmung : Benutzen Sie die Feinabstimmung an Ihrem Transceiver für MT63, wenn er 
darüber verfügt. MT63 ist nicht so empfindlich gegen eine Fehlabstimmung und verträgt auch eine 
Drift der Station. 
 
Pre-Amp: Schalten Sie den Vorverstärker nur zu, wenn sie auf eine sehr leise Station hören. Oft 
haben Sie dann größere Probleme mit starken Nachbarstationen  
 
USB: Fast alle MT63-Stationen arbeiten in USB. Hinweis: Wenn Sie die CAT-Steuerung unter MixW 
nutzen, werden die Töne automatisch eingestellt. Haben Sie keine CAT, müssen sie dem Programm 
die Einstellung mitteilen. 
 
VOX: Hängt davon ab, wie Sie zwischen RX und RX umschalten. Siehe Grundeinstellung (Basic Set 
Up) 
Filtering: MT63 ist 1 kHz breit. Über MixW kann es zwischen 500Hz und 2000 Hz plaziert werden. Es 
entspricht etwa FAX und SSTV. In der Regel ist das SSB-Filter die beste Wahl für MT63. 
 
Leistung: Hängt von den Bedingungen ab. MT63 benötigt wegen seiner Bandbreite eine höhere 
Leistung als PSK31, um die gleiche Durchschnittsleistung bei der Gegenstation zu erzielen, aber es 
reicht aus, wenn die gleiche Leistung wie bei PSK31 verwendet wird. Verwenden Sie nur soviel 
Leistung, wie Sie unbedingt bei einer gegebenen Situation benötigen. 
 
  
MixW-Einstellung : 
 
Startfrequenzen : Lassen Sie den MT63 zwischen 500…1500 Hz stehen, es fällt dann in das 
Paßband des SSB-Filters..  

 
Bandwidth: Die Bandbreite ist wählbar, sollte aber auf  1000Hz stehen bleiben.  

 
Squelch und Threshold : können eingeschaltet werden 
  
Interleave: Interleave (Verschachtelung) hängt von der Bandbreite ab :  

Bandwidth Audio Range Interleave/char  
500 Hz 500 - 1000 Hz Long  
1000 Hz 500 - 1500 Hz Short  > (DM3ML: auf LONG stellen) 
2000 Hz 500 - 2500 Hz Very Short  

MixW212_DtHilfe  22.07.2004 



MixW2-Hilfe V.2.12 Seite 123 von 155 Übersetzung von Eike,DM3ML 

 
8-bit-Kodierung und ESC-Zeichen : Im Original unterstützt MT63 nur eine 7-bit-Kodierung und hat 
damit einen beschränkten Zeichenvorrat. Mit einer 8-bit-Kodierung wird der Zeichenvorrat von 128 auf 
256 Zeichen erweitert. Die Zeichen mit einem Kode über 127 werden als zwei 7-bit-Zeichen gesendet, 
sie bestehen aus dem ESC-Zeichen (127 voreingestellt) gefolgt von dem Symbolcode minus 128.  
 
Video ID und Optionen : 
 
Die Video-Identifikation (VID) ist im Wasserfall zu sehen :  

 

 
 

Informieren Sie sich unter SSTV über diese VID. 
 

Inverted sollten sie probieren, wenn Sie ein starkes MT63-Signal hören, es aber nicht dekodieren 
können. Klicken Sie auf Mode | Inverted oder gehen Sie zu Mode | Mode Settings . Oft können Sie 
die Station dann 100% mitschreiben. 
 
"Inverted" heißt, daß die Lage der Mark- und Space-Töne gegenüber der normalen Lage vertauscht 
wird. Sie benötigen diese Funktion, wenn Sie eine Station mitschreiben oder arbeiten wollen, die 
invertiert arbeitet.  
 
Empfang von  MT63 : 
Stimmen Sie Ihren Transceiver so ab, daß die Diamant-Cursoren symetrisch zum MT63-Signal im 
Wasserfall stehen : 
 

 
 
Der Text erscheint nach mehreren Sekunden im RX-Fenster. Ist das Signal deutlich breiter oder 
schmaler als die Cursoren, müssen Sie die Bandbreiteneinstellung unter Mode > Mode Settings 
entsprechend korrigieren. 
 
Senden von MT63 : 
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Stimmen Sie auf die Gegenstation wie oben beschrieben ab. Sie können Text im TX-Fenster 
vorschreiben. Wenn Sie auf Senden schalten wollen, drücken Sie die Pause/Break-Taste, klicken Sie 
auf das RX-Feld im Statusbalken oder verwenden Sie im Menü Options | RX oder Options | TX.  
Der Text aus dem Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-
Fenster. Nach Druck auf die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der 
letzten Zeichen wieder auf Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab. 
Beim Senden wird der Wasserfall eingefroren und läuft erst weiter, wenn wieder auf Empfang 
geschaltet ist. 
Stellen Sie die NF-Amplitude der Soundkarte so ein, daß der Output im Leerlauf (ohne Texteingabe) 
nicht mehr ansteigt und nehmen Sie ihn dann auf 50% der maximalen Amplitude zurück. Sie erhalten 
dadurch die maximale unverzerrte Leistung unter MT63. Sollte Ihr Transceiver den Dauerpegel nicht 
vertragen, müssen Sie ihn weiter zurücknehmen. 
 
 

5.7 Packet  
 

5.7.1 Packet-Einführung und Theorie (Packet Intro and Theory) 
  

Übernommen aus TAPR, Publication #95-1. 1995. 130 pages.  
 
Geschichte von VHF/UHF-Packet : 
Packetradio wurde auf den VHF-Bändern zuerst 1978 in Montreal, Canada am 31. May gesehen. 
Danach entwickelte die Vancouver Amateur Digital Communication Group (VADCG) den ersten 
Terminal Node Controller (TNC). Darauf folgte die VADCG-Leiterplatte 1980. Die TAPR (Tucson 
Amateur Packet Radio) folgte 1982 mit dem TNC-1 und 1984-85 mit dem TNC-2. Vor über 10 
Jahren verkaufte die TAPR über tausend TNC2-Bausätze und begann damit den Lauf von 
Packetradio. 
MixW könnte mit dem Umstieg vom TNC zur Soundkarte eine weitere Revolution auslösen. Mit 
MixW haben die meisten Amateure das Werkzeug, um in Packet QRV zu werden. 
 
Was können Sie machen ?  
 
Mailboxsysteme : Die meisten Städte haben ihre Mailbox (PBBS). Mailboxen machen zwei Sachen : 
Sie senden und empfangen persönliche Nachrichten und sie senden und empfangen lokal bis weltweit 
adressierte Mitteilungen und Nachrichten AN ALLE. Sie sind in ein nationales und internationales 
System eingebunden und verteilen empfangene Nachrichten an andere Boxen weiter. Mailboxen 
bieten darüber hinaus Dienste wie Callbooks, Entfernungsberechungen u.a. an. 
Unter  PBBS Commands finden Sie den Kommandosatz der amerikanischen Mailboxen.. 
 
 
Tastatur zu Tastatur : Sie können sich mit MixW über Packetradio mit anderen Funkamateuren 
unterhalten. Die Verbindungen können direkt zwischen den Stationen oder über das Packetnetzwerk 
laufen. Da die Stationen aber nicht immer zur gleichen Zeit QRV sind, wird Packetradio oft dazu 
benutzt Informationen und Emails über das Netz zu schicken und über die öffentlichen oder die private 
Mailbox auszutauschen. 
 
DX-Packet-Cluster: Ein DXCluster erlaubt vielen KW-Stationen gleichzeitig eingeloggt zu sein und 
DX zu jagen. Wer eine seltene Station hört, sendet eine Packetmitteilung an den lokalen DXCluster. 
Die DXCluster sind international vernetzt und Sie finden seltenes DX schneller, als wenn Sie selbst 
übers Band drehen. 
 
RACES/ARES/NTS und Notfallkommunikation : Packetradio wird (in den USA) von vielen 
Notfalldiensten, z.B. vom  National Traffic System (NTS) genutzt.Eine neue Anwendung ist APRS 
kombiniert mit GPS (Global Positioning Satellites), bei dem Sie die Position einer APRS-Station auf 
einer Karte sehen können. Dadurch können z.B. Stationen, die Wetterberichte geben, genau 
lokalisiert werden, ohne daß sie zusätzlich ihre Position bestimmen müssen. 
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Networking:  Packetstationen arbeiten in der regel über Digipeater. Digipeater arbeiten als 
“Wiederholer” und verteilen die empfangenen Pakete an die im Adreßfeld des Packets eingetragene 
Adresse des nächsten Digipeaters. Mit Digipeatern wird die Reichweite einer Station bis weltweit 
ausgedehnt. 
 
Satellitenkommunikation : Viele Amateursatelliten im Orbit tragen ein Computersystem mit 
Packetradiomöglichkeiten. Sie können genutzt werden, Nachrichten weltweit zu übertragen. Für den 
direkten Zugriff werden in der Regel spezielle Programme (z.B. WiSP32) und Geräte benötigt. 
 
 Für weitere Informationen zu Soundkarten-Packet gehen Sie zu  
  
http://radioministries.org/k4set/packet/index.htm 
und  TAPR, Tucson Amateur Packet Radio.  
 

5.7.2 Packet auf UKW (VHF Packet Operation) 
  

MixW hat viele Optionen, um den Packetbetrieb auf Kurzwelle und VHF zu konfigurieren. Für Packet 
auf Kurzwelle gehen Sie zu HF-Packet-Betrieb. 
 
TCP/IP über das AX.25-Packetradio-Protokoll wird ab sofort unterstützt. Gehen Sie zu  TCP/IP für 
Details. 
 
MixW stellt zahlreiche vom Nutzer einstellbare Zeitparameter zur Verfügung, es kann als Bake und als 
Digipeater eingesetzt werden. 
 
Schalten Sie auf Packet mit Mode > Packet ein oder klicken Sie auf die Modebox im Statusbalken 
und wählen Sie Packet. Öffnen Sie dann Mode > Mode settings : 
 
 
 

 
 

Geben Sie Ihr Rufzeichen ein und starten Sie mit  VHF 1200 baud Standard oder wählen Sie die 
Einstellung, in der Sie arbeiten wollen.Der meiste VHF-Packetbetrieb in meiner (K4SET) Gegend läuft 
gegenwärtig auf  1200 Baud, da Bedingungen und Geräte keine höheren Baudraten unterstützen. 
Falls Sie MixW als Digipeater nutzen wollen, tragen Sie Ihr Digipeaterrufzeichen ein und geben klicken 
Sie enable digipeating an. Die Boxen use PSK und OEM können Sie frei lassen. Ignorieren Sie 
anfangs auch die Karteikarten Parameters, Beacon/Monitor und TNC. 
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Mit der Parameter-Karteikarte können Sie Ihre Station an bestimmte Mailboxen anpassen. In der 
Karteikarte Beacon/Monitor können Sie den Bakentext eingeben und mit der TNC-Karte, können Sie 
einen externen Hardware-TNC anstelle der Soundkarte anschalten. 
Stimmen Sie jetzt Ihre Station auf eine Station oder eine Mailbox ab. Anders als auf Kurzwelle 
brauchen Sie nur die richtige Frequenz auf Ihrem FM-Gerät einstellen. Am Wasserfall können Sie die 
Abstimmung nicht verändern. MixW geht davon aus, daß die Standardtöne 1200 und 2200 Hz 
genommen werden, 
 
Nach dem Mitschreiben auf der Frequenz suchen Sie sich eine Station oder eine Mailbox, die Sie auf 
dieser Frequenz connecten wollen. 
 
Im Gegensatz zu  RTTY, PSK und MFSK müssen Sie eine Station, auf die Sie abgestimmt haben, zu 
einem QSO oder einem Mailbox-Kontakt erst connecten. Öffnen Sie dazu das Menü  Mode | 
Connect.  
Hinweis:  Sie können dieses Feld auch mit der Tastenkombination Ctrl-Alt-C öffnen. 
 

 
 

Tragen sie unter MyCall Ihr eigenes und unter Remote das Rufzeichen der Gegenstation ein. Soll die 
Verbindung über Digipeater gehen, tragen Sie die Digis in der Digi-Box ein. Klicken Sie dann auf das 
Feld Connect, um die Gegen(remote)-Station zu connecten. 
 
Auf dem folgenden Bildschirmausschnitt können Sie sehen, wie ich die K4MSU-Mailbox (unseren 
Radioclub in Murray, KY) direkt connected habe und eine Message an meinen Freund Ron, W4ET, 
geschrieben habe, der ebenfalls Nutzer der Mailbox ist. Ich habe meine vorher geschriebene Message 
mit dem Kommando R <message #> wieder ausgelesen :   
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Die Verbindung läuft duplex und der gesendete Text wird im RX-Fenster wiederholt. Jede Station muß 
die empfangenen Pakete bestätigen, Ihre Software wird automatisch kurze Bursts senden, auch wenn 
Sie nichts auf der Tastatur eingegeben haben. Bei schlechten Bedingungen müssen Daten und 
Quittungen u.U. mehrfach wiederholt werden, ehe sie richtig empfangen werden. 
 
 
Nach einem QSO oder einer Mailbox-Sitzung müssen Sie sich mit Mode > Disconnect von der 
Gegenstation disconnecten (trennen), indem Sie ein Disconnect senden.  
 
Hinweis : Von einer Mailbox trennen Sie sich durch Eingabe von Bye, die Mailbox löst dann selbst 
den Disconnect aus. 
 
Die typischen Mailbox-Kommandos (in den USA) finden Sie unter PBBS Commands 
 

5.7.3 Packet auf Kurzwelle (HF Packet Operation) 
 

MixW hat viele Optionen für den Packet-Betrieb auf KW und UKW. Für UKW informieren Sie sich 
unter UKW-Packet-Betrieb ( VHF Packet Operation). 
MixW stellt zahlreiche Zeitparameter zur Verfügung, es kann als Bake und als Digipeater eingesetzt 
werden. 
Schalten Sie auf Packet mit Mode > Packet ein oder klicken Sie auf die Modebox im Statusbalken 
und wählen Sie Packet. Öffnen Sie dann Mode > Mode settings : 
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Geben Sie Ihr Rufzeichen ein und wählen Sie HF. Der HF-Packet-Betrieb läuft mit 300 Baud, da die 
HF-Bedingungen höhere Baudraten nicht gestatten. Falls Sie als Digipeater arbeiten wollen, geben 
Sie ein Rufzeichen ein und schalten enable digipeating ein. 
Hinweis :  Diese Möglichkeiten werden meistens für UKW-Packet eingesetzt. Die Parameter, 
Beacon/Monitor und TNC-Tabs können auch ignoriert werden. Sie können Sie aber verwenden, wenn 
sie eine bestimmte BBS connecten wollen. Die voreingestellten Werte arbeiten ganz gut. Das Feld 
Beacon/Monitor  kann genutzt werden, um einen Bakentext und die Parameter einzutragen und das 
TNC-Fenster kann ausgefüllt werden, wenn Sie einen externen Hardware-TNC anstelle der 
Soundkarte verwenden wollen. 
 
Als nächstes müssen Sie eine Packetstation oder eine Packet-Mailbox finden, die Sie connecten 
wollen. Im Wasserfall ist folgendes Packet-QSO zu sehen : 
 
 

 
 

Stimmen Sie auf das Packetsignal ab, indem Sie den Cursor in die Mitte des Signals setzen. Machen 
Sie eine Feinkorrektur mit ALT+Pfeiltaste rechts/links. Der empfangene Text erscheint im RX-Fenster. 
Der Packetabstimmindikator besteht aus zwei Diamant-Cursoren, die durch eine weiße Linie 
verbunden sind. Die Cursoren folgen bei der Abstimmung zusammen dem Signal. 
 
Im Gegensatz zu  RTTY, PSK und MFSK müssen Sie eine Station, auf die Sie abgestimmt haben, zu 
einem QSO oder einem Mailbox-Kontakt erst connecten. Öffnen Sie dazu das Menü  Mode > 
Connect.  
Hinweis:  Sie können dieses Feld auch mit der Tastenkombination Ctrl-Alt-C öffnen. 
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Tragen sie unter MyCall Ihr eigenes und unter Remote das Rufzeichen der Gegenstation ein. Soll die 
Verbindung über Digipeater gehen, tragen Sie die Digis in der Digi-Box ein. 
Hinweis : Digis sind auf Kurzwelle nicht üblich. 
Klicken Sie dann auf das Feld Connect, um die Gegen(remote)-Station zu connecten. 
 

 
 
Sie sehen auf dem Bildschirmausschnitt, daß ich nun mit Ron, W4ET, verbunden bin. 
Genaugenommen, hat Ron mich connectet und meine Station hat automatisch geantwortet  
Die Verbindung läuft duplex und der gesendete Text wird im RX-Fenster wiederholt. Jede Station muß 
die empfangenen Pakete bestätigen, Ihre Software wird automatisch kurze Bursts senden, auch wenn 
Sie nichts auf der Tastatur eingegeben haben. Bei schlechten Bedingungen müssen Daten und 
Quittungen u.U. mehrfach wiederholt werden, ehe sie richtig empfangen werden. 
 
Nach einem QSO oder einer Mailbox-Sitzung müssen Sie sich mit Mode > Disconnect von der 
Gegenstation disconnecten (trennen), indem Sie ein Disconnect senden.  
Hinweis : Von einer Mailbox trennen Sie sich durch Eingabe von Bye, die Mailbox löst dann selbst den 
Disconnect aus. 
 
Die typischen Mailbox-Kommandos (in den USA) finden Sie unter PBBS Commands 
 
 

5.7.4 TCP/IP über AX.25 (TCP/IP over AX.25) 
 
MixW 2 unterstützt TCP/IP über AX.25 (Datagramm-Modus). Das bedeutet, saß Sie die Standard- 
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Windows-Software verwenden können, um über andere TCP/IP-Systeme (UNIX/Linux, AGW Packet 
Engine, Flexnet, MixW 2) über einen VHF-Radiokanal zu kommunizieren. 

 
 
Holen Sie sich den “virtual network adapter driver” für Windows 98/ME/2000/XP von Nicks Website mit 
einem Klick auf : 
http://mixw.net/files/MixNic6.zip 
 
Oder eine frühe Windows98-Version: 
http://mixw.net/files/MixNic6Old.zip 
 
Unzippen Sie die Dateien in eine separates Verzeichnis und lesen Sie die ReadMe.txt-Datei für 
Installationsinstruktionen. 
 
Die Treiber wurden für Windows 98 SE 4.10.2183A, Windows 2000 5.00.2195 SP2 und Windows XP 
5.1.2600 getestet. 
 

5.7.5 Mailbox-Kommandos (PBBS Commands) 
 
(Nicht übersetzt, da vorzugsweise für USA gültig) 
 
 
MSYS PACKET BBS COMMAND SUMMARY  
 
Version 1.18 (The first letter alone will invoke most major commands: example, B = Bye) 
Note: The MSYS commands are used on many other PBBSs as well. 
 
A Commands 
Abort..................Stop current action  
 
B Commands 
Bye.....................Disconnect 
 
C Commands  
Conference......Multi-user/DX Node  
 
D Commands 
Download........Download from FILES  
 
G Commands 
Grep..................String search file  
 
H Commands 
Help..................Help  
 
I Commands 
Information......PBBS hardware 
Info....................Basic Information  
ID.......................Port definitions  
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J Commands 
Just Heard......Log  
JB......................BBS Stations  
JD......................Digipeaters  
JG.....................Gateways  
JK......................K and KA nodes  
JM.....................MSYS PBBSs  
JN.....................Net/Rom  
JT.....................TCP/IP protocol  
 
K Commands 
Kill.....................Kill a message  
KM....................Kill mine  
KT....................Kill traffic 
K-Nodes........K-Node output 
                   
L Commands 
List...................Message headers  
L x....................List category x  
LC....................List categories  
LM....................List mine  
LN....................List not read  
LT....................List traffic  
LL....................List last message  
LL #.................List last #  
LO #................List older #=yymmdd  
LU...................List unread to you  
LY...................List read to you 
LW..................List weather  
L?....................List ? forward  
L<< x...............List fm x=callsign  
L>> x...............List to x=callsign  
L@ PBBS.....Messages to PBBS  
L #...................List since #  
LL #.................List last #  
L # #................List from # to #  
L"x".................List with x=string  
L'x'..................List with x=sTrInG  
L$....................List bulletins  
 
M Commands 
Message......Message of the day  
 
N Commands 
The N commands are used while to give the BBS your information, either the first time you log on, or if 
you need to edit your information: 
Name............First name  
NH..................Home board  
NQ..................QTH=City,  
NZ...................Zip code  
 
P Commands 
Path................Path to a user 
PF...................Path to a PBBS 
PC...................Request a callsign  
 
R Commands 
Read.............Read a message 
R x..................Read all category x 
R@ xxxx.......Read all at xxxx BBS 
R> xxxx..........Read all to xxxx 
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R< xxxx..........Read all from xxxx 
RM.................Read Mine 
RE..................Read for export 
RH..................Read with headers 
RN..................Read only text 
RP..................W/O mark as read 
REPly #.........Reply auto title 
REP # ...........Reply to given message number. If you put a period after the number, a title will 
automatically be generated. Same as SR command. 
The following variations of the R command read messages: 
R # # ............. Reads the given message numbers Ex: R 12734 11521 27185 
RM .................Reads your messages (Read Mine) 
R ....................category Reads the messages in a given category ("TO" field). Ex: R SALE 
R> ..................callsign Reads msgs with given "TO" field 
R< ..................callsign Reads msgs from given callsign 
R@ ................callsign Reads msgs with given @BBS Ex: R@ ARRL 
RH # # ...........Like R but displays all the R: lines as well (Read Headers) 
RP # # ............Like R but doesn't mark msgs as read (Read Preview) 
RN # # ............Like R but gives msg text only (Read Noheaders) 
RE # # ............Reads the given message numbers in export form (Read Export) 
REM ...............Reads all messages to you in export form (Read Export Mine) 
#RS ................Reads all messages to SYSOP (Read Sysop) 
#RES..............Reads all messages to SYSOP in export form (Read Export Sysop) 
#R* ..................Reads held messages showing text 
#R+ .................Reads held messages showing why held verbosely 
#R- ..................Like R+ but very concise 
Typically, after a screefull of lines is displayed on your terminal, you will be asked:  
More? [Y]es, No or Continuous 
Press just return for next screenfull, N to quit reading this message or category), or C to display all the 
rest without pausing. The number of lines per screen is set by the X command. 
 
> REQDIR 
To list files in subdirectory XXX, put /XXX in the title of a msg to REQDIR. 
For information on how to request a file, send a msg to REQFIL and put 
REQFIL.HLP in the title. 
> REQFIL 
To request a file, send a private message to REQFIL at this BBS. Put in the 
title the name of the file you want. If the file is in a subdirectory, 
include the name(s) of the subdirectories. Examples: 
SP REQFIL @ WA8BXN 
REQFIL.HLP 
 
S Commands 
The S command is used to send messages. It several formats: 
SP call @ bbscall.haddr Send a private msg Ex: SP K8EIW @ WB8BII.OH.USA.NA 
ST zipcode @ NTSst Send traffic msg Ex: ST 44070 @ NTSOH 
SB category @ route Send a bulletin Ex: SB NEED @ ALLOH 
SR msg# Send reply Ex: SR 12723 or SR 12723. 
In SB if call is a user of this system you can omit the @ bbscall.haddr 
In ST, NTSst means to replace st with the state its going to: OH for Ohio, etc. 
In SR, if you put a period after the msg #, a title will automatically be made 
by preceeding the original title with RE: 
IMPORTANT: SR tries its best to determine where the reply should go, but 
it is not always perfect! The same applies to the REP command. 
Never uses SSID's in callsigns (ex: don't use WA8BXN-2, just use WA8BXN) 
Hierarchical addresses are of the form state.country.continent. Other parts 
may be used by a particular BBS, if you know them, use them. 
When sending personal messages to a distant bbs, it is a good idea to put 
the destination city and state in the title. 
When you are done typing your message, end it with either ^Z (Control-Z) or 
Putting * at the beginning of a line makes it a comment. 
It also suppresses the next command prompt (but the system will 
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be waiting for another command). * is useful to answer the SYSOP if you 
get a MESSAGE FROM SYSOP ... 
 
Send...........Send a message 
^A................Abort message 
CC................Carbon copy 
SP................Send personal 
ST................Send traffic 
 
T Commands 
The T cmd is used to connect to the sysop's keyboard. This if the sysop is present you may enter into 
a direct conversation. If there is no response from the sysop in 60 seconds you will be returned to the 
BBS. TCP/IP Telnet users note: Server 87 connects directly to the keyboard without going through the 
bbs. 
 
U commands 
The U cmd lists the current users of MSYS and what they are doing. The UP command may be used 
to upload ASCII files. You must be authorized by the SYSOP to upload files. After you use the UP 
command you will be asked the file name to upload. Follow the prompts given by the command. 
 
V Commands 
The V command gives the version of this software. 
Version........Version 
 
W Commands 
The What command lists the available files for downloading. The format: W - Lists all files with sizes. A 
directory name may be specified to list files names in directories that appear in the list. 
What...........Download list 
W x..............What in x=subdir 
 
X Commands 
The X command can be used to set a variety of options. If no argument is given, X simply toggles and 
displays the new Expert status. If a number is given after X, this is the number of lines to display for a 
command before asking More? To continue displaying the current message when More? is sent press 
return. To abort the message, type N and then return. This facility has been added to prevent a long 
message from scrolling off your screen faster than you can read it. Experiment with different values 
until you find one that pleases you. To not use this facility, set the number of lines to zero. Examples: 
X.........Toggle expert 
X 20 (pause after every 20 lines) X 0 (don't pause ever) 
XF Set "fast" mode: BBS will put more than one line per packet 
XS Set "slow" mode: BBS will put only one line per packet. 
Note: If you have very good path to bbs, use XF. If you have a poor 
path to bbs, use XS since short packets make it through easier. 
XC............. toggles the automatic display of msg catagories when you connect to the 
bbs and are using non-expert mode. 
XR toggles the automatic asking if you want to reply to a msg after you read 
it. Can be useful if you get a lot of personal mail. 
XU toggles the automatic display of Unread mail when you connect. 
X #............Lines per page 
 
Y Commands 
Yapp...........Down and uploads 
YW..............YAPP Directory 
YD................Download a file 
YU................Upload a file 
YW ..............Lists available files for YAPP Download 
YD filename Downloads specified file using YAPP protocol 
YU filename Uploads specified filename using YAPP protocol 
 
*.....................Comment to sysop 
 
^ZH..................Conference help  
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^ZQ or /ex......Return to PBBS  
^ZU..................List users  
^ZA #...............Invite user on #  
 
^Z gets you this file, as you may already know! 
SP REQFIL @ WA8BXN 
XXX\EWFILE.DAT 
^Z 
would get you file NEWFILE.DAT from directory XXX. 
SP REQFIL @ WA8BXN 
STUFF.BAS @ K8EIW 
^Z 
would send the file STUFF.BAS back to you at BBS K8EIW, instead of the one 
from which you sent the message. 
NOTE: YOU CAN REQUEST ONLY ONE FILE PER MESSAGE TO THE SERVER! 
 
NETWORK NODE COMMANDS 
BBS............Connect to the PBBS 
Bye............Disconnect 
Connect CALL...Connect to call 
C# CALL...C on port # to call 
Help...........Help 
Nodes..........Nodes heard 
Justheard......Limited output JH 
Nodes CALL..Info on node 
Ports..........Port information 
Routes.........Direct connect nodes 
Route CALL..Other node 
State Talk...........Page Sysop 
Users..........Users/nodes 
 
 

5.8 Pactor 

5.8.1 Pactor-Einführung und Theorie (Pactor Intro and Theory) 
 
von der Webseite von RICHARD B. GRIFFIN, NB6Z 
 
(Anmerkung DM3ML : Die folgenden Ausführungen beziehen sich auf PACTOR-1)  
 
I. Überblick  
 
PACTOR (PT)wurde speziell für die Arbeit in gestörten und fluktuierenden Kanälen als halbduplexes 
ARQ-System entworfen, das die Zuverlässigkeit von PACKET  mit der festen Paketlänge von AMTOR 
kombiniert. 
Die Grundlagen für den Entwurf sind :  
PACTOR kombiniert alle wichtigen AMTOR und Packet-2-Weg-Charakteristika :  

• Fester Zeitrahmen und volle Synchronität zur Sicherung der maximalen Geschwindigkeit  
• Schnelle und zuverlässige Tastenübergabe und Break-in 
• Weniger als 600 Hz Bandbreite  
• 100% ASCII-kompatibel (wahre Binärdatenübertragung)  
• extrem niedrige Wahrscheinlichkeit unentdeckter Fehler mit 16 bit CRC  
• unabhängig von der Shift-Polarität 
• kein Mehrnutzerüberhang in Schmalbandkanälen  
• billige Hardware (einfache Z80-Leiterplatte)  
• hoher Betriebskomfort (Mailboxsystem eingebaut usw.)  
• Monitor-Modus (listen-mode)  
• FEC-Modus beim CQ-Ruf 
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Als Neuigkeiten im Amateurfernschreiben wurden weitere hochwertige Eigenschaften eingeführt : 
• Optimaler kohärenter Modus, wenn beide Systeme auf ein Frequenznormal (DCF77, TV-

Zeilenfrequenz oder lhochstabiler Rundfunksender) eingerastet sind 
•  Online-Datenkompression (Huffmann-Kodierung) 
• automatischer Geschwindigkeitswechsel (100/200 Baud) ohne Verlust der 

Synchronisation 
• quittiertes Verbindungsende  
• Memory-ARQ (gestörte Pakete können durch Wiederholung restauriert werden) 

 
II. System-Details  
 
1. Taktierung 
 
Die Pactor-Aussendung ähnelt vom Prinzip her AMTOR : Blöcke mit Information werden gesendet und 
durch ein kurzes Steuersignal (CS) von der empfangenden Station bestätigt. Die Shiftlagel wird in 
jedem Zyklus gewechselt, um die ARQ (siehe unten) zu unterstützen. Eine Mark-Space-Definition wird 
dadurch überflüssig. 

• Zykluslänge :  1.25 sec  
• Paketlänge :    0.96 sec = 192 (96) bits bei 200 (100) baud  
• Quittungssignal (CS) :  0.12 sec = 12 bits zu je 10 msec  
• CS-receive gap : 0.29 sec  

 
Eine Änderung der Übertragungsgeschwindigkeit ändert nur die interne Paketstruktur aber nicht die 
anderen Zeitparameter. 
 
2. Pakete 
Eine Pactor-Paket besteht aus dem Kopf (Header), dem Datenfeld mit 20 bzw. 8 Byte bei 200 bzw. 
100 Baud, einer Statuskennung und 2 Byte CRC (Cyclic Redundance Code = Prüfdaten) 

• Header : Dieses Byte erlaubt eine schnelle Synchronisatopn und liefert zusätzliche 
Informatioon (Memory-ARQ, Listen mode) 

• Data : Binärdaten 
• Status : Systemsteuerbyte mit einer 2-Bit-Paketnummer, TX-Mode, Breakanforderung oder 

QRT-Ankündigung 
• CRC : 16-Bbit-CRC-Kode auf der Basis des CCITT-Polynoms X^16+x^12+x^5+1 berechnet 

über das ganze Paket ohne Header 
 
3. Steuersignale  (CS)  
Es werden vier CS-Signale verwendet. Ein CS-Signal ist als Kompromiß zwischen schneller 
Erkennung und sicherer Übertragung 12 Bit lang. Die Kodierung im Hex-Code ist :  
CS1: 4D5 /  CS2: AB2 / CS3: 34B / CS4: D2C  
Die Hammingdistanz ist 8 bit, um die chance des Empfangs eines falschen CS zu vermindern. CS1/2 
und CS3/4 haben ein symmetrisches bitinvertiertes Muster. CS1..3 haben die gleiche Funktion wie bei 
AMTOR,  CS4 schaltet doe Übertragungsgeschwindigkeit um, CS3 bewirkt die Umkehr der 
Senderichtung.  
 
 4. Master <> Slave 
Die anrufende Station ist der Master und sendet spezielle Synchronisierpakete bestehend aus : /head 
(100 bd)/..address (8 bytes, 100 bd)../..address (8bytes, 100 bd) Normalerweise benutzt der 
Empfänger nur die 100-Baud-Sektion für eine schnelle Synchronisation. Die 200-Baud-Sektion liefert 
eine zusätzliche Inforamtion über die Kanalqualität. Falls Sie richtig empfangen wird, ist das erste CS 
eine CS4, sonst wird CS1 gesendet. Der Meister sendet dann nach der Synchronisation normale 
Pakete in 100 und 200 Baud. Das erste übertragene Zeichen ist die „system level number” (die 
Pactor-Software-Version), gefolgt von der Master-Adresse (seinem Rufzeichen). 
 
5. Ändern der Senderichtung  
Wie bei AMTOR kann die empfangende Station die Senderichtung wechseln, sobald sie ein gültiges 
Paket empfangen hat. Ein spezielles Umschaltpaket wird gesendet. Die sendende Station schaltet 
unmittelbar auf Empfang, wenn sie das Steuerpaket CS3 empfängt und wertet das Paket aus. Sie 
sendet CS1 und CS3 als Quittung oder ein CS2 als Wiederholungsanforderung. 
  
6. Ändern der Geschwindigkeit  
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Eine Verringerung der Geschwindigkeit ist nur bei schlechten Bedingungen sinnvoll oder wenn nur 
wenige Daten z.B. bei manueller Eingabe zu übertragen sind. Beide Senderichtungen werden 
unsymmetrisch behandelt. 
- langsamer   
Der Empfänger kann nach jedem falsch empfangenen Paket mit CS4 eine Umschaltung von 200 Baud 
auf 100 Baud anfordern. Ein unbestätigtes 200-Baud-Paket wird dann mit 100 Baud wiederholt. 
- schneller  
jedes gültig empfangene Paket kann mit CS4 quittiert werden um beim Sender eine Erhöhung der 
Geschwindigkeit anzufordern. Wenn das anschliessend mit 200 Baud gesendete Paket trotz 
mehrfacher Wiederholung nicht als richtig empfangen quittiert wird, schaltet der Sender automatisch 
auf 100 Baud zurück. 
 
7. Ende eines PACTOR-Kontakts 
Zum Ende eines ARQ-Link muß sicher gestellt werden, daß alle Daten übertragen worden. Pactor hat 
ein spezielles QRT-Paket eingeführt, das ein aktives QRT-Statusbit und die invertierte 
Empfängeradresse enthält. Wird diese Adresse gefunden, antwortet der Empfänger mit einem 
abschließenden CS und die Verbindung wird definitiv und im richtigen Zeitrahmen beendet. 
  
8. Datenkompression  
Eine Textanalyse eines typischen deutschen oder englischen Texts zeigt, daß die durchschnittliche 
Information je Zeichen kaum über 4 Bit liegt. ASCII-Texte mit ihren festen 8-Bit-Zeichen sind also zu 
50% redundant. Dieser Überhang kann durch einen Code mit variabler Länge abhängig von der 
Zeichenverteilung abgebaut werden. Das populärste Beispiel für einen solchen Kode ist das 
Morsealphabet. Bei Pactor wird der Huffmann-Code mit einer ähnlichen Effizienz eingesetzt und ein 
Gewinn von bis zu 100% erzielt. Jedes Paket enthält einen komprimierten Zeichensatz, die Kodelänge 
je Zeichen variiert von 2 bis 15 Bit. 
 
9. Memory-ARQ  
In konventionellen ARQ-Systemen muß der Sender ein Paket so lange wiederholen, bis es der 
Empfänger fehlerfrei erkannt hat. Die Übertragungsgeschwindigkeit verringert sich bei einem 
schechten S/N-Verhältnis dramatisch. Ein Ausweg ist, die Pakete deutlich zu verkürzen oder eine 
Fehlerkorrekturinformation einzubauen, die wieder bei guten Bedingungen die 
Übertragungsgeschwindigkeit deutlich verschlechtert. Pactor setzt dagegen einen Memory-ARQ ein. 
Jedes empfangene Bit eines Pakets wird mit einem 8-Bit-AD-Konverter bewertet. Die Amplitudenwerte 
zwischen 0 und 255 der Bits der wiederholt gesendeten Pakete werden im Speicher aufsummiert. Da 
die Shiftlage von Paket zu Paket gewechselt wird, werden konstante Störpegel eliminiert. Nach jeder 
Übertragung wird das Paket getestet, ob der CRC-Kode erfüllt wird.  
Anmerkung DM3ML : Pactor kann auf diese Weise bis zu einem S/N von -18 dB arbeiten. 
Voraussetzung ist, daß ein A/D-Wandler eingesetzt wird. Bei „aufgebohrten“ (amerikanischen)  
Kontrollern wird in der Regel nur eine digitale 1 oder 0 abgespeichert, so daß der Vorteil der analogen 
Memory–ARQ bei weitem nicht erreicht wird. 
 
10. Monitor (listen mode)  
Pactor-Pakete können im Monitormodus mitgeschrieben werden. Es werden nur gültige Pakete mit 
erfolgreichem CRC-Test ausgegeben. 
 
11. FEC-Aussendung  
CQ- und Rundspruchsendungen werden in einem FEC-Modus gesendet. Die CS-Austastlücke entfällt. 
Die sendende Station kann Geschwindigkeit und Wiederholrate wählen.  
Anmerkung DM3ML : Typisch ist der Unproto-Modus in 100 oder 200 Baud 
 
12. Praktische Aspekte   
Die ersten PACTOR-Programme liefen auf  Z80-Computern. Sie führten zu einem dedizierten 
'PACTOR- Controller' mit eingebautem Modem und einer Abstimmanzeige. Die konventionellen 
Sendearten BAUDOT und AMTOR wurden hinzugefügt um die Kompatibilität zu wahren und um 
Vergleiche zu ermöglichen. PACTOR lief bis zu viermal schneller als AMTOR.  
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5.8.2  Pactor-Betrieb (Pactor Operation) 
 

Mit der aktuellen Ausgabe von MixW Version 2 kann man Pactor (DM3ML: genauer Pactor-1) über 
das Soundkarteninterface mitschreiben . Es ist nicht  möglich ohne einen zusätzlichen Hardware-TNC 
zu senden, der unter MixW problemlos konfiguriert werden kann. Siehe  TNC Configuration and 
operation . 
 
Um Pactor ohne einen TNC zu empfangen, wählen Sie unter Mode |> Pactor oder klicken Sie auf das 
Modefeld im Statusbalken. Ein Pactor-Signal erkennen Sie an den längeren chirpenden Pakete mit 
kurzen Quittungen dazwischen. Im folgenden Bild sehen Sie ein Pactor-QSO im Wasserfall :  

 

 
 

Es sieht ähnlich aus wie RTTY  und verwendet die gleichen mit einem Balken verbundenen 
Diamantcursoren.  
 

5.9 PSK 

5.9.1 PSK-Einführung und Theorie (PSK31 Intro and Theory) 
 
 
PSK31 basiert auf einer Idee von SP9VRC und wurde von Peter Martinez, G3PLX, der auch AMTOR 
eingeführt hat, entwickelt. Peters Vorstellung war, eine RTTY-ähnliche Sendeart für QSOs direkt von 
Tastatur zu Tastatur mit 50 WPM (31 Baud) zu schaffen, die Phasenumtastung (Phase Shift Keying) 
anstelle der bei RTTY verwendeten Frequenzumtastung (FSK) einsetzt, um die H und L bzw. Mark  
und Space zu kodieren. 
 
Digitale Signalverarbeitung (DSP = Digital Signal Processing) einer Soundkarte wird benutzt um die 
Signalphase um 180 Grad umzutasten und damit einen Wechsel von Mark zu Space und umgekehrt 
zu markieren. Die DSP-Analyse des Programms weist die “Phase Shift" nach.  
 
PSK benötigt nur sehr wenig Bandbreite und reduziert dadurch Rauschen und QRM. Für PSK werden 
nur 5..10 Watt selbst bei Interkontinentalverbindungen benötigt. 
 
Die DSP-Filter und die Impulsformung sorgen dafür, daß das Signal nur 40 Hz bei -3dB und 80 Hz bei 
-40 dB belegt. Die Impulse werden als „raised cosine”-Impulse geformt, die Amplitude wird während 
der Phasensprünge abgesenkt und auf vollem Pegel gehalten, wenn keine Phasenumtastung erfolgt. 
 
PSK31 belegt wesentlich weniger Bandbreite als die traditionellen Digimodes :  
 
 Hier ein  RTTY-QSO auf dem MixW – Schirm :  
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und hier ein PSK31-QSO auf dem gleichen Schirm 
 
 

 
 

Die PSK31- Modes BPSK and QPSK 
 
BPSK heißt Bi-Phase-Shift-Keying und tastet die SignaIe zwischen 0° und 180° um.  QPSK heißt 
Quatro-Phase-Shift-Keying und nutzt zusätzlich die Phasenlagen bei 90° und 270°. Dadurch wird die 
doppelte Datenrate erreicht, die bei QPSK für eine zusätzliche Fehlerkorrektur ausgenutzt wird. QPSK 
arbeitet auch unter verrauschten Bedingungen und bei schwächeren Signalen. 
 
Besuchen Sie die offizielle PSK31 Home Page unter: 
http://aintel.bi.ehu.es/psk31.html 
 
Hinweis :  Die Einführung von Peter Martinez, G3PLX's, zur Theorie von PSK31  kann hier bei den 
Helpfiles nicht eingefügt werden, weil es sich um kommerzielle Software handelt. Sie sollten sie aber 
zum besseren Verständnis von PSK studieren. 
Die Ausführungen von Peter Martinez können Sie auf der Website des MixW-Betatesters und 
Helpfileautors  RICHARD B. GRIFFIN, NB6Z unter folgendem Link finden : 
http://www.teleport.com/~nb6z/psk31.htm 
  
MixW bietet vollen Service für BPSK31 und QPSK31, Nick, UT2UZ, hat aber nicht den Quellcode von 
G3PLX verwendet, um ihn zu realisieren. Er hält sich aber an die Vorgaben von G3PLX zur 
Verwendung  von PSK31, 
 
Das Team der  MixW Version 2 bedankt sich bei Peter, G3PLX, für das große Geschenk der 
Funkkunst (Gift to the radio art). 
 
 

5.9.2 PSK31-Betrieb (PSK31 Operation) 
  

Dank an  RICHARD B. GRIFFIN, NB6Z 
 
PSK31-Grundlagen : 
Wegen seiner geringen Bandbreite ist PSK31 sehr empfindlich gegen eine falsche Einstellung der 
Soundkarte und des Transceivers. Wenn Sie den Transceiver übersteuern, wird das Signal schnell 
breit, es erzeugt zusätzliche Linien im Wasserfall und stört die Nachbar-QSOs. 
Sehen Sie sich die Grundeinstellung (Basic Set Up) an. 
 
Transceiver-Einstellung : 
 

Feinabstimmung : Benutzen Sie die Feinabstimmung an Ihrem Transceiver, wenn er darüber 
verfügt. Sie werden aber schnell finden, daß die eigentliche Abstimmung nicht mehr mit dem VFO 
gemacht wird. Ihr Transceiver muß eine Frequenzstabilität von einigen Hertz aufweisen, ältere 
Transceiver sind mitunter nicht stabil genug. Verfolgen Sie die Änderung der NF-Frequenz durch 
die AFC im Statusbalken, notieren Sie den Wert beim Start des QSOs und prüfen Sie, ob Ihre 
Station oder die Gegenstation driftet. 
 
Processor/Compressor:  AUS ! Bei PSK31 nicht verwenden ! 
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Pre-Amp: Schalten Sie den Vorverstärker nur zu, wenn sie auf eine sehr leise Station hören. Oft 
haben Sie dann größere Probleme mit starken Nachbarstationen  
 
USB, LSB : PSK31 ist seitenbandunabhängig. Sie können LSB oder USB einschalten, sollten es 
MixW aber unter View > Spectrum mitteilen, damit die Skala stimmt, falls Sie kein CAT 
verwenden. 

) 
Filter: Mit einem breiten Filter haben Sie eine größere Übersicht über das Stationsangebot, Sie 
können aber Probleme bei starken Signalen haben, die dieGesamtverstärkung über die AGC 
herunterregeln. Ein schmales Filter (CW-Filter) kann in manchen Situationen den Empfang 
wesentlich verbessern. Informieren Sie sich im Handbuch Ihres Transceivers, wie Sie die meist 
primär für CW eingebauten schmalen Filter bei SSB einschalten können. (Tip DM3ML : Sie sehen 
die Wirkung eines schmalen Filters unmittelbar im Wasserfall).  Im folgenden Bild sehen Sie den 
Wasserfall im breiten SSB-Filter :  

 
 

 
 
Sie sehen 8 verschiedene PSK-Signale innerhalb des 3 kHz-breiten Wasserfalls. Ganz rechts läuft 
ein MFSK-QSO. Wählen Sie ein Signal durch einen Mausklick aus. 
 
Leistung :  Wegen der geringen Bandbreite des Signals können Sie mit kleiner Leistung funken. 
PSK31 eignet sich vorzüglich für QRP-Betrieb. Sie können DX mit einem Watt arbeiten. Der 
Einsatz von großen Leistungen bei PSK31 ist eine schlechte Praxis. 
 

MixW-Einstellung :  
 

Wählen Sie als Sendeart entweder  BPSK31 oder QPSK31. Die Standard-Sendeart von PSK31 ist 
BPSK31, sie können aber im QSO auf QPSK31 umschalten, um die Vorzüge der Fehlerkorrektur 
zu nutzen.  
 
AFC : Sollte EIN sein, um Sie beim Einstellen eines PSK31-Signals zu unterstützen. Abschalten, 
wenn ein starkes Signal daneben die Abstimmung auf eine schwache Station an sich zieht  
 
Lock : Sollte AUS sein. Sie senden dann auf der Frequenz der empfangenen Station. Auf EIN 
schalten, wenn Sie selbst CQ gerufen haben, auf der Frequenz bleiben wollen und/oder die 
Gegenstation übers Band driftet. 
 
Squelch und Threshold können verwendet werden, wenn Sie zwischendurch keinen “Müll” 
mitschreiben wollen. 
 
Inverted : Ist bei BPKS31-Betrieb nicht wählbar. Ist bei QPSK31 einsetzbar und sollte dann 
versuchsweise zugeschaltet werden, wenn Sie eine QPSK31-Station hören (siehe Windmühle !), 
aber keinen lesbaren Text auf den Bildschirm bekommen. Gehen Sie zu  Mode | Inverted und 
testen Sie, ob Sie die Station dann mitschreiben können. Bei QPSK31 müssen beide Stationen 
die gleiche Signallage verwenden. 
 
Inversion:  BPSK31 ist seitenbandunabhängig, QPSK31 dagegen ist seitenbandabhängig. 
 
Hinweis : "Inverted" heißt, daß die Lage der Mark- und Space-Töne gegenüber der normalen 
Lage vertauscht wird. Sie benötigen diese Funktion, wenn Sie eine Station mitschreiben oder 
arbeiten wollen, die invertiert arbeitet.  

 
  
 
PSK31-Empfang : 
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Ein PSK31-Signals sieht aus wie ein Eisenbahngleis. Zwei schmale Linien laufen in geringem Abstand 
parallel, die “Schwellen” markieren die Phasenumtastung. Stimmen Sie auf das Signal ab, indem Sie 
zwischen die beiden Linien klicken. Empfehlung : Schalten Sie auf den Liniencursor mit View > Use 
stick cursor um. Haben Sie das Signal richtig getroffen, wird die Station im RX-Fenster 
mitgeschrieben :  
 

 
 

Links und rechts von dem Signal sind schwache Stationen zu sehen. Die linke kann durchaus noch 
mitgeschrieben werden, die rechte dürfte zu schwach sein. 
 
PSK31 benötigt weniger als 40Hz Bandbreite. Es ist sehr schwierig, eine Station mit der 
Hauptabstimmung am TCVR-VFO genau einzustellen. Eine Feinabstimmung hilft etwas. In der Regel 
werden Sie aber die Hauptabstimmung auf den PSK-Bereich stellen, z.B. auf 14070 und die 
eigentliche Abstimmung mit der Maus im Wasserfall machen. Der Diamant-Cursor zeigt Ihnen, welche 
Station sie gerade empfangen. Versuchen Sie auch die Feinkorrektur mit den Pfeiltasten links/rechts 
und gedrückter STRG- oder ALT-Taste. 
 
Tip DM3ML : Mit CAT, Scroll-Maus und Zeiger auf der Frequenzskala kann man mit der Maus die 
TCVR-Hauptabstimmung verstellen. Schalten Sie mit unter Configure > CAT&PTT die Mouse wheel 
tuning“ ein und wählen Sie die gewünschte Schrittweite, z.B. 50 Hz pro Klick. 
 
PSK31 senden : 
 
Um eine Station anzurufen, stimmen Sie wie oben beschrieben ab. Sie können bereits Text im TX-
Fenster vorschreiben. Klicken Sie zum Senden auf die TX/RX-Taste oder drücken Sie die 
Pause/Break-Taste oder klicken Sie auf das RX-Feld im Statusbalken. Der Text aus dem 
Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-Fenster. Nach Druck auf 
die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der letzten Zeichen wieder auf 
Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab. Sie können den Ablauf mit 
Macros automatisieren. Siehe Macros erzeugen (Configuring Macros) 
 
Hinweis : PSK31 verwendet den kompletten ASCII-Zeichensatz mit allen Groß- und Kleinbuchstaben 
und Satz- und Sonderzeichen. Sie können mit ALL CAPS generell Großbuchstaben senden. Da 
Backspace übertragen wird, können Sie – im Gegensatz zu RTTY und AMTOR -  fehlerhaft 
gesendeten Text auf dem Schirm der Gegenstation löschen und neu schreiben. 
 
Beim Senden friert der Wasserfall ein und läuft erst bei Empfang weiter. 
 
Stellen Sie Ihren Mikrofonregler bzw. den Output der Soundkarte unter Configure | Output Volume 
bei einem leerlaufenden Signal (ohne Texteingabe) beginnend von einem niedrigen NF-Pegel so ein, 
daß der HF-Output gerade anfängt, nicht weiter anzusteigen und nehmen Sie ihn dann auf 50% des 
Outputs zurück. Sie erhalten dann ein Signal von maximaler Reinheit. (Tip DM3ML : Die ALC darf 
gerade noch nicht ansprechen) . 
Beachten Sie, daß Sie mit PSK31 im Dauerstrichbetrieb senden. Nehmen Sie den Output weiter 
zurück, wenn Ihr Transceiver zu warm wird. 
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Auf dem Schirm sehen Sie verschiedene PSK31-Stationen. Die linke Station läuft leer (idling, kein 
Text, keine Schwellen). Weiter unten sehen Sie bei dieser Station unerwünschte zusätzliche 
Seitenbandlinien, die durch die Übersteuerung des Transceivers entstehen. Anscheinend dreht der 
OP gerade am NF-Regler, denn weiter oben ist das Signal in Ordnung. Ganz rechts ist eine typische 
„Breitbandstation“, die das QSO links von ihr deutlich stört. (Hinweis DM3ML : Die Station, auf die 
abgestimmt ist, hat eigentlich einen zu hohen NF-Pegel an der Soundkarte, denn sie wird orange 
wiedergegeben. Gehen Sie zu  
Configure >  Input Volume und nehmen Sie den Eingangspegel etwas zurück) 
 
Der Transceiver sollte so eingstellt werden, daß er möglichst linear arbeitet. Fragen Sie die 
Gegenstation nach dem IMD-Wert Ihres Signals (messen während einer Leerlaufphase). IMD-Werte 
von  -25 dB oder weniger und ein Signal ohne sichtbare zweite und dritte Nebenlinien sollte der 
Standard sein. IMD-Werte größer als  -25 dB wie -20 dB und mehr sollten Sie veranlassen den NF-
Pegel am Sendereingang zurück zu nehmen Siehe Grundeinstellung ( Basic Set Up )  zur Einstellung 
der Soundkartenpegel. 
 
Sie können den Text im TX-Fenster vor dem Ausenden editieren. Bis auf die Windowsfunktion 
Einfügen (Insert) funktionieren alle Editierfunktionen. Meist werden Sie den Text von hinten mit 
Backspace (Rücktaste) löschen und neu schreiben. 
 

5.9.3 PSK63/125-Betrieb (PSK63/125 Operation) 
 

Die Sendearten BPSK63, BPSK125, QPSK63 und QPSK125 sind Varianten von  BPSK31 und 
QPSK31 bei denen die BAUDRATE von 31 auf 63 bzw. 125 geändert wird,  Sie können zum 
Umschalten Macros verwenden oder die Baudrate über Mode > Mode settings ändern. 
Die Bandbreiten der Signale ändern sich. PSK63 ist doppelt so breit wie PSK31 und PSK125 viermal 
so breit. 
MixW erkennt die Sendeart im Log auf der Grundlage der Baudrate. 
Zwei Macros werden empfohlen : . 
 
Umschalten auf  BPSK63:  <MODE:BPSK31><BAUDRATE:62.5> 
Umschalten auf  BPSK125: <MODE:BPSK31><BAUDRATE:125>  
 
Zurück zu BPSK31:    <MODE:BPSK31><BAUDRATE:31.25> 
 
Die Umschaltung unter Mode settings geschieht im Feld Baudrate .  
 

 
 

Hinweis  : Sie finden  PSK63 und  125 normalerweise im traditionellen PSK31-Bereich vermischt mit 
den anderen Signalen. Beachten Sie bitte, dass PSK63 und 125 eine größere Bandbreite benötigen, 
wenn Sie von PSK31 dorthin umschalten. Achten Sie auf Ihren guten Ruf ! 
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5.9.4 FSK31-Theorie und Betrieb (FSK31 Theory and Operation) 
 

Der hauptsächliche Unterschied zwischen FSK31 und PSK31 ist, daß  FSK31 einen 90°/270°- 
Phasensprung (DBPSK) anstelle des 0°/180°- Sprungs des originalen  BPSK31 von G3PLX 
verwendet. 
  
FSK31 ist nicht so empfindlich gegen Übermodulation wie PSK31. FSK31 ist Nick's Lösung zur 
Bereinigung des QRM durch Übermodulation des PSK31-Signals.  Ein Vergleich der Bandbreite 
zwischen PSK31und FSK31 (hier als PSK31-90/270 angegeben) bei einem Pegel von  -40 db lliefert :  
 

  PSK31 FSK31

Sauberes Signal Leerlauf 31 31 

 Zufallstext 80 60 

Leichte Verzerrung Leerlauf 220 124 

 Zufallstext 220 93 

Strake Verzerrung Leerlauf 500+ 160 

 Zufallstext 500+ 93 

 
Im Funkbetrieb besteht kein Unterschied zu PSK31. 
 

5.10 RTTY 
 

5.10.1 RTTY-Einführung und Theorie (RTTY Intro and Theory) 
  

Von der Webseite von Richard B. Griffin, NB6Z 
 
RTTY oder Funkfernschreiben ist eine Sendeart zur direkten Kommunikation zwischen Maschinen 
unter Verwendung des Baudot-(oder Murray-) Kodes.  
RTTY wurde sehr populär als nach dem 2. Weltkrieg ausgesonderte Maschinen billig zu haben waren. 
Diese mechanischen Monster hatten eine Eingabetastatur und eine Papierrolle als Ausgabe. Mit ihnen 
konnte das Haus zu Hurrikanzeiten am Wegfliegen gehindert werden – sie müssen eine Tonne 
gewogen haben. Mitte 1970 gings dann los mit einem Videodisplay, vorher waren das nur exotische 
Träume. Erinnern Sie sich noch an das Basic-Kommando PRINT ? Woher mag das gekommen sein ? 
Wenn man morst, wird der Sender für dits und dahs ein- und ausgeschaltet. Bei TTY läuft der Sender 
durch, nur seine Frequenz wird zwischen MARK und SPACE (Strom und kein Strom) umgetastet. Eine 
Sendertastung wäre auch möglich gewesen, nur die TTY-Pioniere versprachen sich Vorteile davon, 
den Träger stehen zu lassen um Störungen zu unterdrücken. 
Sie experimentierten mit FSK (Frequency Shift Keying  = Frequenzumtastung) und fanden, daß es 
wesentlich besser ging. Bei FSK ist MARK die jeweils höhere Frequenz und SPACE die tiefere. Im 
Amateurfunk wird mit einer Shift von 170 Hz gearbeitet, die Kommerziellen nehmen meist 425 oder 
850 Hz. 
Mit einem SSB-Sender ist AFSK ( Audio Frequency Shift Keying = Tonfrequenzumtastung) eine 
machbare Lösung. Die Sende-NF wird dem Mikrophoneingang zugeführt, die Empfangs-NF wird dem 
Lautsprecherausgang entnommen. Das Ergebnis ist das gleiche, ob FSK oder AFSK verwendet wird. 
Sie werden schnell den Wechsel zwischen Mark und Space im Signal hören lernen. 
Für die Mark- und Spacetöne werden fest abgestimmte Tonfilter verwendet und wenn Sie neben das 
Signal abstimmen, erhalten sie Datenmüll. Zur Abstimmhilfe sendet der RTTY-Operator eine Folge 
von RYRYRY… Hier sind Mark und Space so verteilt, daß sie regelmäßig wechseln und wenn die RY-
Folge richtig mitgeschrieben wird, wird auch der Text annähernd fehlerfrei dekodiert. Sie brauchen 
aber mitunter etwas Phantasie, denn RTTY ist keine fehlerfreie Sendeart ! 
Bei anderen Sendearten mit Fehlerkontrolle/korrektur wird meist entweder garnichts oder nur richtiges 
mitgeschrieben. 
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Der Baudot–Kode verwendet 5 Bits und kann dadurch nur 32 (2 hoch 5) Zeichen kodieren. Dieser 
Zeichenvorrat reicht kaum über die 26 Buchstaben des Alphabets hinaus. Mit einem Trick wurde er 
doppelt belegt. Je nach Maschine wurden zwei oder auch drei Register geschaffen, zwischen denen 
durch Steuerzeichen umgeschaltet wird. Buchstaben stehen im Bu-(LTRS)-Register, Ziffern und 
Sonderzeichen stehen im Zi-(FIGS)-Register. Jedes Register hat 32 Zeichen, von denen die 
Registerumschaltkommandos (3), Zwischenraum (1),  Wagenrücklauf (1) und Zeilenvorschub (1) in 
allen  
Registern vorhanden sind. Es reicht also gerade für die 26 Buchstaben ! 
Manchmal wird das Registerumschaltkommando nicht empfangen und aus "HAPPY BIRTHDAY" wird 
das unverständliche : "#-006 ?845#$-6". Mit dem Computer oder einem TNC können Sie die Option 
„LTRS on Space“ einschalten, dann wird wenigstens nach einem Zwischenraum auf die Buchstaben 
zurückgeschaltet oder Sie drücken eine Bu-Zwangstaste, wenn es die in Ihrem Programm gibt. 
Die Verwendung des ASCII-Kodes mit 7 oder 8 Bit per Zeichen und einem Zeichenvorrat von 128 oder 
256 Zeichen ist zwar möglich, hat sich aber bei RTTY nicht durchgesetzt. Die RTTY-Programme 
setzen automatisch eine Zi-Kommando vor eine Ziffer und dann wieder ein Bu-Kommando vor den 
folgenden Buchstaben. An einer richtigen Fernschreibmaschine müssen Sie das selber machen. 
Die Computer als RTTY-Maschine arbeiten lautlos, effektiver und brauchen weniger Platz als eine 
Fernschreibmaschine, aber die Sendeart hat trotz ihrer Einschränkungen ihre Freunde behalten und 
wird in Contesten nahezu ausschließlich verwendet. 
 

5.10.2 RTTY-Betrieb (RTTY Operation) 
  

Transceiver-Einstellungen :  
 

Feinabstimmung : Benutzen Sie die Feinabstimmung an Ihrem Transceiver, wenn er 
darüber verfügt. Sie werden aber schnell finden, daß die eigentliche Abstimmung nicht 
mehr mit dem VFO gemacht wird. Ihr Transceiver muß eine Frequenzstabilität von 
einigen Hertz aufweisen, ältere Transceiver sind mitunter nicht stabil genug. Verfolgen 
Sie die Änderung der NF-Frequenz durch die AFC im Statusbalken, notieren Sie den 
Wert beim Start des QSOs und prüfen Sie, ob Ihre Station oder die Gegenstation driftet. 
Verwenden Sie mit View > Use stick cursor den Cursor als gestrichelte feine Linie und 
setzen Sie ihn zwischen die beiden RTTY-Linien. 
 
Processor/Kompressor : Normal auf AUS. Nur unter bestimmten Bedingungen kann er 
mitunter die Lesbarkeit erhöhen. 
 
Pre-Amp: Normal auf AUS. Nur bei leisen Signalen und wenig Störungen zuschalten. 
Starke Signale in der Nachbarschaft können mit Vorverstärker mehr stören als ohne. 
 
USB, LSB:  In RTTY (und allen anderen Digimodes) muß MARK in der Frequenz um die 
Shift (hier 170 Hz) höher als SPACE liegen. MixW arbeitet voreingestellt mit USB. Wird 
auf LSB geschaltet, muß das Signal in der NF-Lage andersherum (invertiert) liegen. 
Hinweis :  Mit installierter CAT stellt MixW automatisch die richtige Lage ein. Ohne CAT 
müssen Sie mit View > Spectrum > RF, LSB  dem Programm MixW mitteilen, daß Sie 
auf LSB geschaltet haben (Anmerkung DM3ML: ich funke auf allen Bändern bei RTTY 
mit USB). 

 
Filtering: Mit einem 500Hz-Filter können Sie den Empfang von RTTY wesentlich 
verbessern, andererseits sehen Sie bei einem breiteren Filter mehr vom 
Empfangsbereich im Wasserfalls. Lesen Sie im Handbuch Ihres Transceivers nach, wie 
Sie unter SSB ein schmaleres CW-Filter einschalten können. Das Bild hier zeigt einen 
Wasserfall mit breitem Filter : 
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Sie sehen im Wasserfall drei RTTY-Signale, die Sie mit einem einfachen linken Mausklick anwählen 
können. Das stärkste liegt in der Mitte und wird sich zu 100% mitschreiben lassen, bei den beiden 
anderen müssen Sie mit Fehlern rechnen. 
 
Leistung : Hängt von den Bedingungen ab. RTTY benötigt relativ mehr Bandbreite als CW oder 
PSK31 und damit auch mehr Leistung. Verwenden Sie nicht mehr Leistung, als Sie in einer 
gegebenen Situation benötigen. Dicke Leistungen sind unüblich. Denken Sie daran, daß RTTY eine 
Dauerstrichsendeart ist und reduzieren Sie u.U. die Ansteuerung. 

 
MixW-Einstellungen: 
 

Wählen Sie Mode > RTTY im Menü oder durch Klicken auf die Sendeart im Statusbalken. Gehen 
Sie innerhalb von RTTY zu Mode > Mode Settings : 
  

 
 
 

 
 

TX- und RX-Frequenz zeigen die aktuelle Frequenz des MARK-Signals an. Empfohlen wird ein 
Wert zwischen 1000 und 1500 Hz, dann liegt das Signal im Paßband, aber die erste Oberwelle 
des NF-Signals wird bereits abgeschnitten. Als Shift wird in der Regel 170 Hz verwendet. Die 
Baudrate ist international 45,45 Baud, es gibt aber auch Stationen mit 50 Baud oder Boxen oder 
Rundsprüche mit 75 oder 100 Baud.  Unter Zeichensatz wird meist Englisch eingestellt, aber auch 
andere Zeichensätze, z.B. Englisch/Russisch sind möglich. Wenn Sie das Feld Inverted  
anklicken, werden Mark und Space vertauscht. Zweckmäßig ist auch Unshift on Space 
außerhalb von Contesten zu setzen, um automatisch ins Buchstabenregister zurückzuschalten. 
Sie können 4 Sätze mit Kombinationen von Baudraten, Shift, Zeichensätzen usw. anlegen und 
anwählen. Schalten Sie durch anklicken der Set-Nummer von einem Satz zum anderen. 
The TX and RX frequencies are set to wherever your cursor is in the spectrum window. I 
recommend  
 
AFC : sollte auf ON stehen, um die Feinabstimmung auf ein RTTY-Signal zu unterstützen. Sie 
können es danach auf OFF stellen. Wenn Sie aber einer driftenden Station folgen müssen oder in 
einem Netz verschiedene nicht genau abgestimmte Station mitschreiben wollen, ist ON die 
bessere Wahl. Die Abstimmung ist nicht so kritisch wie bei PSK31. 
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Lock : sollte auf OFF stehen, wenn Sie auf der Frequenz Ihrer Gegenstation senden wollen. 
Machen Sie einen eigenen CQ-Ruf oder driftet Ihr Partner deutlich, sollte LOCK auf ON stehen.  
 
Inverted : tauscht die Frequenzlage von MARK and SPACE. Wenn Sie ein lautes RTTY-Signal 
hören, aber keine verständliche Mitschrift erhalten gehen Sie zu Mode > Inverted oder zu Mode >  
Mode Settings und wählen Inverted , danach können Sie meist 100% mitschreiben. 

 
Squelch und Threshold  : können Sie so einstellen, daß Ihre Anforderungen realisiert werden 
 
RTTY-Senden  : 
 
Um eine Station anzurufen, stimmen Sie wie oben beschrieben ab. Sie können bereits Text im TX-
Fenster vorschreiben. Klicken Sie zum Senden auf die TX/RX-Taste oder drücken Sie die 
Pause/Break-Taste oder klicken Sie auf das RX-Feld im Statusbalken. Der Text aus dem 
Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-Fenster. Nach Druck auf 
die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der letzten Zeichen wieder auf 
Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab. 
 
Hinweis: RTTY kennt nur Großbuchstaben, da es einen begrenzten Zeichensatz hat. Die Einstellung 
entspricht UPPER CASE LETTERS ONLY. MixW kodiert Kleinbuchstaben automatisch in 
Großbuchstaben um. Von den Sonderzeichen werden nur die Zeichen :  - ( ) $ ! " / : ? .   gesendet. 
Sollten Sie andere Sonderzeichen in den Text schreiben, werden sie nicht gesendet. 
 
Der Wasserfall wird während des Sendens eingefroren und läuft unter RX weiter.  
 
Die Standardeinstellung von RTTY verwendet eine Shift von 170 Hz shift zwischen den MARK- und 
SPACE-Tönen. Der MARK-Tone muß unabhängig von der Seitenbandeinstellung die höhere 
Frequenz haben. 
 
Stellen Sie Ihren Mikrofonregler bzw. den Output der Soundkarte unter Configure >| Output Volume 
bei einem leerlaufenden Signal (ohne Texteingabe) beginnend von einem niedrigen NF-Pegel so ein, 
daß der HF-Output gerade anfängt, nicht weiter anzusteigen und nehmen Sie ihn dann auf 50% des 
Outputs zurück. Sie erhalten dann ein Signal von maximaler Reinheit.  
Tip DM3ML : Die ALC darf gerade noch nicht ansprechen. 
Beachten Sie, daß Sie mit RTTY  im Dauerstrichbetrieb senden. Nehmen Sie den Output weiter 
zurück, wenn Ihr Transceiver zu warm wird. 
 
Wenn Sie senden, wird der Wasserfall eingefroren und läuft erst bei Empfang weiter. 
 
 

5.11 SSTV 
 

5.11.1 SSTV-Einführung und Theorie (SSTV Intro and Theory) 
  

von Chuck Schied, Jr., W3OHV 
 
SSTV entspricht Facsimile (FAX). Facsimile ist eine Methode, eine Vorlage Zeile für Zeile zu 
übertragen. Zeitungen und Nachrichtenagenturen wie AP, Reuters, UP übertragen Fotos und Text 
über Draht oder über Funk. Facsimile verwendet eine Zeilenabtastung. Je mehr Zeilen benutzt 
werden, desto länger dauert die Übertragung, aber desto schärfer ist die Auflösung und Bildschärfe. 
Die zeilenweise Abtastung ist ein sehr altes Verfahren. Es wird bei der Herstellung infraroter Karten 
und bei der Militäraufklärung eingesetzt. Künstler haben es verwendet, um Bilder freihand zu kopieren. 
Amateurfunk-SSTV ist ein Kompromißsystem, das schnell genug läuft, um attraktive – manchmal 
sogar schöne – Bilder zu erzeugen. 
SSTV-Bilder werden in verschiedenen Formaten gesendet. Ein einfaches Schwarz-Weiß-Bild kann in 
8,5 Sekunden übertragebn werden. Gute Farbbilder dauern eine bis drei Minuten. Exzellente 
Farbbilder können in vier Minuten verschickt werden. Bilder mit 640 x 480 Punkten und einer 24-Bit-
Farbtiefe benötigen immerhin 17 Millionen Bit für ein True-color-Bild. Die mit Scottie-1 oder Martin-1 
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gesendeten Bilder haben eine erstaunliche Qualität. Inzwischen gibt es an die fünzig verschiedene 
von unterschiedlichen Programmierern geschaffene Formate. 
Aber lassen Sie sich nicht verunsichern. SSTV ist schneller als FAX aber deutlich langsamer als 
normales Fernsehen. Sie können längere Formate wie Scottie-DX oder WRAASE-180 mit 4…5 
Minuten verwenden und schöne Bilder selbst unter schlechten Bedingungen empfangen. Sie haben 
sicher schon SSTV um 14230 kHz gehört. Sie können beim Hören eine Menge lernen. Investieren Sie 
nicht in SSTV, bevor Sie sich nicht angehört haben, was die Leute darüber reden. Newcomer sind hier 
als Lehrer ungeeignet und haben oft irrtümliche Vorstellungen. Andererseits sind Oldtimer, die mit 
ROBOT-Geräten arbeiten und sich nicht auf den PC und die neuen SSTV-Programme umgestellt 
haben, nur eine schwache Hilfe. 
Ein Amateur mit dem Namen  Copthorne MacDonaldhat in den 60ern das entwickelt, was heute 
irrtümlich als SSTV  (Slow Scan Television) bezeichnet wird. Der Ausdruck Slow Scan gehört zum 
normalen Fernsehen.  
Das normale Amateur-TV wird als Fast Scan-TV bezeichnet, weil es in Echtzeit läuft. Dieses 
Fernsehen benötigt aber wesentlich mehr Bandbreite zur Übertragung der bewegten Bilder. SSTV 
verwendet einen Audiokanal mit einem Spektrum zwischen 1200Hz to 2300Hz und sendet 
hochaufgelöste Farbbilder rund um die Welt. Lassen wir ihm seinen Namen Slow Scan TV. Es ist aber 
kein TV !  
 
SSTV heute   
Anfang der 90er kamen die Personal Computer in die Shacks der Funkamateure. SSTV war nicht 
mehr eine teure Sache für Experten. Vorher war ein teurer Konverter gebaut von der Firma ROBOT 
RESEARCH Company so ziemlich die einzige Möglichkeit SSTV zu empfangen und zu senden. Mit 
der zunehmenden Weiterentwicklung der Computer mit schnelleren CPUs und Betriebssystemen wie 
Microsoft Windows gewannen die von Funkamateuren geschriebenen SSTV-Programme zunehmend 
an Popularität. Statt in Schwarz-Weiß wurden die Bilder in Farbe mit immer besserer Auflösung 
übertragen. 
  
Zusätzliche Informationen finden Sie unter : http://www.kiva.net/~djones/ 

5.11.2 SSTV-Betrieb (SSTV Operation) 
 
MixW und SSTV 
 
Nick beabsichtigt nicht, MixW2 mit den eingeführten Programmen wie MMSSTV, ChromaPIX und 
anderen reinen SSTV-Programmen zu vergleichen. MixW hat nicht den ausgebauten Service mit 
Vorlagen oder diagonalen Texten mit Gradientfüllungen, aber man kann ganz normale QSOs damit 
machen. Es hat eine manuelle Möglichkeit zur Korrektur von Phase und Schräglauf. Text kann schnell 
eingegeben und im zu sendenden Bild angeordnet werden, Macros für oft einzugebende Formeln 
stehen bereit. Der SSTV-Bereich von MixW ist als Werkzeug für die OMs gedacht, die Zeit sparen und 
nicht immer in ein aufwendigeres SSTV-Programm umschalten wollen. 
 
Wählen Sie SSTV vom Mode-Menü : 

MixW212_DtHilfe  22.07.2004 

http://www.kiva.net/~djones/


MixW2-Hilfe V.2.12 Seite 147 von 155 Übersetzung von Eike,DM3ML 

 
 

Die Steuertasten (Control buttons) haben folgende Funktionen : 
• RX startet den Bildempfang im gewählten Modus 
• TX startet die Aussendung des im TX-Fenster bereitgestellten Bildes im gewählten Modus 
• Stop hält RX und  TX an 
• COLOR (Farbe)  schaltet die Farbregister durch und die Tasten [<<], [<], [>], [>>] 

korrigieren die horizontale Lage des Bildes  
• Der Schräglauf (Slant) kann mit der Taste Slant  über alles und mit den Tasten  

[\],[\\],[//],[/] schrittweise korrigiert werden  
 
Sie können in dem Feld Auto wählen, welche Option automatisch mitlaufen soll. 
 
Mit den Tasten (Tabs) RX, TX, History und TX wählen Sie aus, was im Bildfenster angezeigt wird.  
Wollen Sie ein Bild in das TX-Fenster laden (Größe 320x256x24) klicken Sie auf das Icon „Datei 
öffnen“ und übernehmen Sie ein Bild aus Ihrem Vorrat. 
 
Um ein empfangenes Bild abzuspeichern klicken Sie auf das Disketten-Icon und geben Sie einen 
Namen und ein Verzeichnis zum Abspeichern ein. 
 
Klicken Sie auf das Icon “Zwischenablage” um ein Bild aus der Zwischenablage in das TX-Fenster zu 
holen. 
 
Sie können Text in das TX-Fenster einfügen :  

Wählen Sie die Textfarbe und den Zeichensatz und geben Sie den Text in das Textfenster ein. 
Setzen mit gedrückter linker Maustaste den Text in das TX-Fenster an die gewünschre Stelle und 
ziehen Sie dann den Mauszeiger wieder aus dem TX-Fenster. Der Text kann während des 
Sendens noch eingefügt werden. 

 
Das folgende Bild zeigt eine BMP-Datei, die nach der beschriebenen Prozedur editiert wurde :  
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RX-Schräglauf- und Phasenkorrektur : 
Ziehen Sie mit der Maus eine Linie über den Rand des Bildes. Ein linker Mausklick auf den Rand 
korrigiert nur die Phase. Der Schräglauf wird nicht korrigiert. Mit einem rechten Mausklick können 
Sie das Bild nach oben verschieben. Schräglauf und Phase können während des Empfangs 
korrigiert werden. 
Wenn Sie die Shift-Taste beim Anklicken der Schräglaufkorrekturtasten gedrückt halten, wird die 
gegenwärtige Schräglaufkorrektur abgespeichert und beim Senden und Empfangen der nächsten 
Bilder verwendet. 

 
Modi : 
Alle üblichen Modi stehen für RX und TX zur Verfügung. Wählen Sie den gewünschten Modus aus der 
Liste. 
 
Kopf (Header) : 
Voreingestellt ist bei MixW  sstvhdr.bmp als Kopfzeile. Sie können dieses Bild editieren oder einen 
anderen Header laden, indem Sie auf bei gedrückter CTRL (Strg)-Taste auf das Lade-Icon klicken. 
Drücken Sie während des Ladens eines Bildes oder der Zwischenablage die Shift-Taste, wird die 
Kopfzeile eliminiert. Den gleichen Effekt erreichen Sie, wenn Sie die Datei sstvhdr.bmp entfernen 
oder umbenennen.  
 
Hier sehen Sie ein abgestimmtes SSTV-Signal im Wasserfall. Es kommt von meinem Freund Ron, 
W4ET : 
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SSTV –Kalibrierung mit WWV : 
Mit  dem WWV-Modus können Sie die Soundkarte kalibrieren. Zeitmarken werden auf 4996, 9996 und 
14996 KHz gesendet. Stellen Sie Ihren Transceiver auf 4994.100, 9994.100, 14994.100 (USB). 
Warten Sie ab, bis die Zeitmarken gesendet werden. Mitunter gibt es 5-Minuten-Pausen zwischen den 
Sendungen. Beginnt die Zeitmarkensendung wählen Sie unter Mode  WWV :  

• Stimmen Sie so ab, daß das WWV im Wasserfall erscheint 
• Klicken Sie auf die Taste RX  
• Sie sehen ein Bild aus weißen und schwarzen Feldern 
• Justieren Sie den Schräglauf so, daß die Kanten senkrecht zueinander laufen 
•  

Das Bild ergibt sich aus den Zeitintervallen, aber die Linien  müssen in jedem Fall senkrecht laufen. Es 
ensteht etwa dieses Bild : 
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Die SSTV-Schräglaufkorrektur kann auch verwendet werden, den Soundkartentakt für andere 
Sendearten zu justieren. Wählen Sie Mode > Mode settings . Im Feld RX Slant correction sehen 
Sie den aktuellen Korrekturwert in ppm (10-6 ). Mit Go! Wird der Korrekturwert übernommen :  
(Anmerkung DM3ML : In Europa eignet sich der Sender RWM auf 9996 kHz für diese Korrektur) 
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Hinweis :  Mit dieser Prozedur korrigieren Sie die Soundkarte für den Empfang. Manche Soundkarten 
haben für RX und TX getrennte Korrektureinstellungen. Wollen Sie den TX überprüfen, starten Sie die 
gleiche Prozedur wie bei  einer kalibrierten RX-Karte und senden Sie ein Bild. an eine Station mit 
kalibrierter RX-Karte. Benötigt Ihr Bild keine Schräglaufkorrektur, ist alles in Ordnung. Tritt doch ein 
Schräglauf müssen Sie auch für die Senderichtung mit der Schräglaufkorrektur experimentieren und 
den Eintrag im Menü verändern. 
 
SSTV-Einstellungen : 
 
Mit Mode | Mode Settings können Sie weitere Einstellungen vornehmen :  

• Das Feld Tuning indicator gibt die SSTV-Abstimmanzeige unterhalb des SSTV-Fensters frei 
oder schaltet sie ab. 

• TX- und RX frequency geben an, wo die Abstimmanzeige im Wasserfall steht. Die Lage der 
roten Fahne kann mit der Maus nicht verändert werden. Sie steht als Standard in der Mitte 
des SSTV-Bereiches bei 1900 Hz (Mitte zwischen 1500 und 2300 Hz). 

• TX and RX slant correction (Schräglaufkorrekur) : Diese Werte werden bei der WWV-
Kalibrierung eingetragen. 

•  Die GO-Taste sendet diese Werte zur Korrektur an die Soundkarte 
 
Mit der history size (Größe der abgelegten TX-Bilder)  bestimmen Sie, wieviel Bilder in die 
Ablage passen sollen  
Mit  Auto Save (Automatisches Speichern) und Open Picture paths (Öffne Pfad zu den Bildern) 
können Sie das Speichern und Laden von Bildern beschleunigen und einfacher handhabbar 
machen. 
Kreuzen Sie use header box an, wenn Sie eine Kopfzeile in jedes Bild einfüfgen wollen und 
geben Sie das einzufügende Bild an. 

 
Video ID : 
Die Video-Identifikation (VID) ist im Wasserfall zu sehen :  
 

 

 
 

Ein einfacher Editor wird mitgeliefert. Da die Leistung auf die Punkte einer Zeile verteilt wird, sollten 
Sie keine zu langen horizontalen Linien wählen. Als Beispiele finden Sie butterfly.bmp und mixw.bmp 
im MixW-Verzeichnis. Sie können wählen, ob Sie die ID am Anfang, am Ende oder an beiden Stellen 
senden wollen. Klicken Sie dann auf Edit :  
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Ich habe das VID aus dem butterfly.bmp gemacht,das ich geladen und dann die Pixel angeklickt 
habe, um mein Rufzeichen hinzuzufügen. Ich habe es unter einem eigenen Namen abgespeichert und 
es als mein VID gewählt. 

 

5.11.3 Fehlerbehebung bei SSTV (Troubleshooting SSTV) 
 
SSTV-Fehlerbehebung  : 
Folgende Tips sollen bei Problemen helfen :  
 
Fügen Sie folgende Zeilen in die Datei mixw2.ini ein : 
  

• Section  
[Device 0 Setup]  
m_iBufRxNum=48  
m_iBufRxSize=256  
m_iBufTxNum=48  
m_iBufTxSize=256 
 
Stellt 48 Puffer zu 256 Bytes für die Soundkarte bereit.  
Bei einer Abtastrate von 11025 sps ergibt sich eine Gesamtlänge von 48*256/11025 ~ 1.1 
sec, also etwas mehr als 1 Sekunde für unerwartete Windowsverzögerungen.  
Wir können die Anzahl der Puffer verringern, aber Ihre Größe erweitern :  
  
m_iBufRxNum=24  
m_iBufRxSize=512  
m_iBufTxNum=24  
m_iBufTxSize=512 
 
• Prioritäten ändern :  

  
[Priority]  
MainThread=0  
Class=32 
 
Das sind die voreingestellten Werte. Versuchen Sie :  
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Class=128 (HIGH PRIORITY)  
Oder   
Class=256 (REALTIME PRIORITY) 
 
Damit können Sie in einer Multitask-Umgebung mit anderen Programmen parallel arbeiten, 
hängen sich aber mit langsamen PCs auf. 
 
Sie können die Pfadpriorität heraufsetzen mit  
  
MainThread=1  
oder  
MainThread=2  
oder  
MainThread=15 
 
Ich habe es mit Class=256 (REALTIME PRIORITY) und MainThread=15 auf meinem  C366 
unter  
W2000 versucht und sowohl  SSTV TX als auch RX arbeiten vorzüglich, während ich 
gleichzeit  PhotoShop geöffnet hatte.  
 
Sie können auch mit dem folgenden Parameter in der [SSTV] section von MixW2.ini spielen :  
FilterLength=4 konnte vergrößert werden auf 64 bei meinem C366.  
Dieser Wert definiert die Anzapfungen im FOR-Filter (aktuell FilterLength*2+1). 
 
Dec=5 Decimation rate kann auf 4 oder 3 verringert werden, aber nicht weniger als 3.  
 

 
  
 

5.12 THROB 

5.12.1 THROB-Einführung und Theorie (THROB Intro and Theory) 
  

vom Autor des  THROB-Programms, G3PPT, auf seiner Webseite unter  
http://www.lsear.freeserve.co.uk/page3.html. 
 
THROB, ein experimentelles Programm mit 9 Tönen und  FFT-Detektion : 
 
Der FFT-Wasserfall gibt Signale wieder, die kaum zu hören sind und führt zu Ideen, wie man ihn für 
Kommunikationszwecke einspannen kann. Man kann die Punkte und Striche von CW erkennen oder 
die beim Multiton-HELL simultan (MZ Hell) oder sequentiell (SMT Hell) gesendeten Töne ausmachen. 
Der Autor hat ein Programm SLOWFELD geschrieben, das einen sehr langsamen Hellschreiber 
nachbildet, bei dem die Intensität ausgewählter FFT-Bits geplottet wird. Das Verfahren ist sehr 
effektiv, aber mit 2 Zeichen/Minute sehr langsam und hat den Nachteil aller Hell-Zeichen, das diese 
als „Bild“ gesendet werden müssen.  
Die Amateurgemeinschaft hat enorme Möglichkeiten eine Sendeart für ein 2-Weg-QSO wie PSK31 
oder Hellschreiber und andere Entwicklungen zu wählen. Das THROB-Programm ist ein Versuch, 
DSP dort zu verwenden, wo andere Methoden wegen schwieriger Ausbreitungsbedingungen 
versagen, und gleichzeitig eine annehmbare Geschwindigkeit zu erreichen. Die Entwicklung ist noch 
im Fluß und in einem relativ frühen Zustand, bei dem viel oder nichts herauskommen kann. 
Das Programm läuft auf einem Pentium-PC mit einer Soundkarte unter Windows 95 mit 2048, 4096 
oder 8192 16-Bit-Abtastblöcken entsprechend den drei Geschwindigkeiten von 4, 2 und 1 Baud. Töne 
aus einer Palette von 9 Tönen in einer Bandbreite von 72 oder 144 Hz werden sequentiell gesendet 
und empfangen. Jeder Ton ist 2048, 4096 or 8192 Abtastungen lang,  mit “raised Cosine” geformt und 
wird in einem als „throb“ (Klopfen) bezeichneten Paket gesendet. Bei Empfang wird das FFT-Filter von 
72 oder 144 Hz symmetrisch über das Signal gesetzt und die Präsenz und Position des/der Töne im 
„throb“ bestimmt bestimmt. 
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Das Programm ist eine Weiterentwicklung einer früheren mit 5 Tönen und 40 Hz Bandbreite. Dieses 
Verfahren war langsam mit 7 WpM und auch seitenbandempfindlich, aber man konnte s auf 3..4 Hz 
genau abstimmen und eine AFC hielt die Abstimmung. Die neuere Version hat drei Geschwindigkeiten 
mit 1,2 und 4 Baud und eine Rate von 10, 20 oder 40 WpM. Es ist seitenbandunabhängig und kann in 
LSB und USB verwendet werden. 
Eine Autosynchronisation wurde hinzugefügt, wobei das Programm auf zwei folgende Minima des 
empfangenen Signals einrastet. Die AFC kann eine Drift von 1 Hz in 5 Sekunden ausgleichen. 
Es gibt weitere Möglichkeiten, dass Programm zu verbessern und fein abzustimmen. 
Die Entwicklung geht mehr in Richtung MFSK. Murray, ZL1BPU, hat eine Lösung für die 
Amateurbänder formuliert und Nino, IZ8BLY, hat zusammen mit Murray das Programm STREAM 
geschrieben, bei dem es zahlreiche Modi und auch eine Fehlerkorrektur gibt, die ich mit meiner 
gegenwärtigen Anzahl an Tönen nicht erreichen kann. 
Es eröffnet sich ein interessantes Feld für eine Weiterentwicklung zum Nutzen des Amateurfunks. 
  

5.12.2 THROB-Betrieb (THROB Operation) 
 
THROB ist eine Schmalbandsendeart, aber nicht ganz so schmal wie  PSK31. Sie können aber die 
Einstellungen an Ihrem Transceiver so wie unter PSK31 stehen lassen.  
 
Als erstes wird Ihnen bei einem THROB-Signals der klopfende Charakter auffallen. Es geht relativ 
langsam im Vergleich zu anderen Digimodes und die Aktivität ist nicht besonders groß. 
 
Schalten Sie auf  THROB  mit Mode > THROB oder klicken Sie auf das Sendeartenfeld im 
Statusbalken. Gehen Sie dann zu  Mode > Mode settings :  
 

 

 
 
 
Die  TX- und RX-Frequenzen zeigen die Werte aus dem Wasserfall. Ich empfehle Werte um 1500 Hz 
in der Mitte des Paßbandes.  
Die THROB-Rate wird unter Throb/sec eingestellt.  
AFC kann auf ON gesetzt werden  
Inverted kann eingeschaltet werden, wenn ein starkes Signal keinen auswertbaren Text liefert. Gehen 
Sie zu Mode > Inverted . 

 
So sieht ein THROB-Signal im Wasserfall aus (hier 1 Throb/Sec): 
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Das Signal liegt zwischen den beiden Diamat-Cursoren und ist deutlich schmaler als bei anderen 
Modi. 
 
Throb-Empfang : 
 
Setzen Sie den Cursor in die Mitte des Signals und klicken Sie mit der linken Maustaste. Der Text 
erscheint im RX-Fenster. Die Cursoren bewegen sich mit der AFC gleichzeitig und parallel. 
Tip DM3ML : Wenn Sie ein Throb-Signal im Wasserfall lokalisiert haben und der Cursor-Abstand 
stimmt nicht mit der Signalbreite überein, korrigieren Sie die Throbrate, bis der Cursorabstand mit dem 
Signal übereinstimmt. Je höher die Throbrate ist, desto weiter liegen die Cursoren auseinander. 
 
 
Throb-Senden : 
 
Um eine Station anzurufen, stimmen Sie wie oben beschrieben ab. Sie können bereits Text im TX-
Fenster vorschreiben. Klicken Sie zum Senden auf die TX/RX-Taste oder drücken Sie die 
Pause/Break-Taste oder klicken Sie auf das RX-Feld im Statusbalken. Der Text aus dem 
Sendefenster wird gesendet und erscheint nach dem Aussenden auch im RX-Fenster. Nach Druck auf 
die eben beschriebenen Tasten schaltet das Programm nach Ausgabe der letzten Zeichen wieder auf 
Empfang. Die Taste ESC bricht das Senden unmittelbar und sofort ab und im Puffer stehende Zeichen 
werden nicht mehr gesendet.  
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